

    
      
          
            
  
Mahara 1.4 user manual

This is the user manual for Mahara 1.4, released on 13 June 2011.


Warnung

Mahara 1.4 is not supported anymore. Please install or upgrade to a supported version [https://wiki.mahara.org/index.php/SupportedVersions].



Lizenz

Das Mahara Nutzerhandbuch ist lizensiert unter der  Creative Commons Attribution-ShareAlike 3.0 unported [http://creativecommons.org/licenses/by-sa/3.0/] oder GNU General Public License version 3 or later.

Mitarbeitende

Das Mahara Nutzerhandbuch wird von einer Gruppe erstellt. Verschiedene Personen haben die Originalversion erstellt und an den Übersetzungen gearbeitet.

Sie finden die Liste der Mitarbeitenden am Handbuch und den Grafiken unter Ohloh [https://www.ohloh.net/p/mahara-manual/contributors/summary] für die englische Version. Auf Launchpad [https://translations.launchpad.net/mahara-manual] befinden sich die Übersetzungen und Informationen zu den daran arbeitenden Personen.
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1. Einführung

Willkommen zur Mahara-Nutzereinführung. Diese Einführung ist eine Dokumentation für Menschen, die Mahara Tag-für-Tag nutzen wollen. Diese Inhalte sind für jede/n Nutzer/in hilfreich. System- und Institutionsadministrator/innen finden in einem eigenen Abschnitt dieser Dokumentation hilfreiche Informationen.

Lassen Sie uns einfach starten.


1.1. Was ist Mahara?

Vielleicht fragen Sie sich noch, was Sie mit Mahara tun können und wie ein ePortfolio für Sie nützlich sein kann, dann sind Sie hier genau richtig.

Mahara verbindet zwei Dinge: ein ePortfolio [http://en.wikipedia.org/wiki/Eportfolio] und ein Soziales Netzwerk [http://en.wikipedia.org/wiki/Social_network] System. In einem ePortfolio können Menschen aller Altersgruppen die Erkenntnisse des lebenslangen Lernprozesses ablegen, z.B.: Texte, künstlerische Arbeiten oder alles weiter, was digital gespeichert werden kann. Mahara bezeichnet diese als Artefakte. Soziale Netzwerksysteme finden Sie heute viele: z.B. Bebo [http://bebo.com/], Facebook [http://facebook.com/] oder MySpace [http://www.myspace.com/]. Sie ermöglichen Menschen, miteinander zu kommunizieren, Kontakte herzustellen und eigene Communities zu bilden.

But Mahara is much more than just a place to store files. Mahara also includes blogging, a resumé builder, and Moodle [http://moodle.org/] integration.




1.2. Das Mahara-Konzept

In Mahara kontrollieren Sie selber welche Informationen Sie in Ihr Portfolio einstellen und anderen Personen zugänglich machen.  Diese Informationen oder Materialien werden als Artefakte bezeichnet.  Um den Zugang zu diesen Artefakten festzulegen, werden die Artefakte in Bereichen von Ihnen angeordnet. Diese bezeichnet Mahara als Ansicht. Sie können beliebig viele Ansichten erstellen. Jede Ansicht kann von Ihnen frei gestaltet werden und einzelne oder viele Artefakte enthalten. Wie Sie Ihre Ansichten gestalten, hängt von Ihren Absichten und den Zielgruppen ab. Sie können einzelnen Personen, einer Gruppe oder der Öffentlichkeit Zugriff auf Ihre Ansichten geben.

Einige Beispiele, was Sie in Mahara erstellen können:


	eine Seite für Ihre Freunde oder Familie mit Urlaubsbildern und einem persönlichen privaten Blog


	eine Seite für Ihre/n Tutor/in mit Aufgaben und einer Lernprozessreflexion


	a page to showcase your best pieces of work and your resumé for potential employers


	…




Ihr Portfolio kann aus einer einzelnen Ansicht oder einer Sammlung von Ansichten bestehen. Artefakte, die in einer Ansicht platziert werden, sind zunächst nur für Sie selber sichtbar. Jedes Artefakt wird nur einmal von Ihnen angelegt. Danach kann es in beliebig vielen Ansichten von Ihnen verwendet werden.

Imagine you collected all your artefacts in a shoe box. Whenever you have a new artefact, you add it to the shoe box. When you are ready to create your portfolio, you take a look at the artefacts in your shoe box and choose those that you want ot make available on a portfolio page. You can arrange the artefacts on that page to your liking.


[image: artefact box]
Portfolioarbeit mit Mahara



Das Diagramm unten mit Beispielartefakten, Ansichten und Gruppen  zeigt wie Inhalte mit anderen geteilt, in verschiedenen Kontexten wiederholt genutzt und für unterschiedliche Zielgruppen eingesetzt werden können.


[image: Mahara framework]
Das Mahara-Konzept






1.3. Wie passt Mahara in die Landschaft des eLearnings?

Wenn Sie sich eine Lernplattform (LMS) [http://en.wikipedia.org/wiki/Learning_Management_System] wie Moodle, Sakai und Blackboard als Teil des formalen eLearnings vorstellen, dann ist Mahara die soziale, reflektive Seite des Lernens.  Ein LMS und ein ePortfolio unterstützen komplementäre Bereiche des Lernprozesses.

Die API’s von Mahara sind offen. Besonders eng ist Mahara mit Moodle verknüpft. Nutzer/innen können nahtlos von einem in das ander System wechseln. Seit Moodle 2 ist nicht nur das Login über SSO über MNet möglich. Nutzer/innen können Aufgaben, Forenbeiträge und andere Materialien aus Moodle in den persönlichen Bereich in Mahara übertragen und dort zu Ansichten arrangieren.




1.4. Und wenn ich eine Funktion benötige, die in Mahara nicht existiert?

Mahara wurde von Anfang an  als offenes und modulares System entwickelt. Neue Typen von Artefakten, Authentifizierungssysteme und vieles mehr können durch das Erstellen eines Plugins und den Zugriff auf die Core API entwickelt werden. Mahara ist frei, es ist einfach anzupassen und Sie können es so weiterentwickeln und gestalten, wie es Ihren Bedürfnissen und Anforderungen entspricht – und  falls Sie einen Bezahl-Support benötigen, ist dieser erhältlich über ein Netzwerk von`Mahara Partnern <http://www.mahara.org/partners>`_.




1.5. Und wie geht es weiter?

Sie haben nun eine grundlegende Vorstellung darüber, was Mahara ist. Sie können nun:


	Eine Liste der Features von Mahara lesen.


	Explore the demo [http://demo.mahara.org/] or download mahara for yourself to play with.


	In der Mahara.org Community [http://mahara.org/registration.php] Mitglied werden, Fragen stellen und sich mit anderen in den Foren [http://mahara.org/interaction/forum/index.php?group=1] austauschen.


	Continue reading this user guide!







1.6. Wo erhalte ich Ideen, wie ich Mahara nutzen kann?

Das Mahara 1.4 Cookbook [http://www.packtpub.com/mahara-1-4-cookbook-for-training-education/book] von Ellen Marie Murphy wurde im September 2011 veröffentlicht. Es enthält über 50 Ideen wie Mahara in verschiedenen Bereichen zum Einsatz kommen kann. Das Buch liegt in englischer Sprache gedruckt und steht zusätzlich als  PDF-Datei und als eBook zur Verfügung.




1.7. Wo Sie Hilfe bekommen


	An vielen Stellen in Mahara finden Sie kontextspezifische Hilfe. Beachten Sie das Hilfe-Icon [image: help]. Klicken Sie darauf, um mehr zu der einzelnen Funktion herauszufinden.


	Stellen Sie Fragen in den Foren [http://mahara.org/interaction/forum/index.php?group=1].










          

      

      

    

  

    
      
          
            
  
2. Dashboard

After you successfully logged in to Mahara, you see your dashboard. This is your homepage where you can see the latest activity of you and other users on Mahara. You can customise the dashboard so that you always see the items that are most important to you.

Nur Sie selber haben Zugriff auf Ihr persönliches Dashboard. Niemand anders kann es sehen.


2.1. Übersicht

Bestimmte Elemente können Sie auf dem Dashboard anpassen.  Das gilt für die nutzerspezifischen Informationen. Einige Elemente sind jedoch auch statisch. Damit verhindert Mahara, dass grundlegende Funktionen ausgeblendet werden und später nicht wiedergefunden werden.


[image: the full dashboard]
Your homepage is your dashbaord from which you can access a number of areas in Mahara conveniently.




	General navigation bar: Move from one area of Mahara to the next.


	Einstellungen Der Link gibt Ihnen Zugriff auf Ihre Accounteinstellungen und Benachrichtigungen.


	Eingangsbox: In der Mahara-Eingangsbox finden Sie alle Benachrichtigungen, die für Sie erstellt wurden. Die Zahl ungelesener Benachrichtigungen wird Ihnen angezeigt.


	Abmelden: Link zum Beenden der aktuellen Sitzung.


	User search: Search for users who have an account to view their portfolio pages / collections.


	Persönliche Informationen.  Dieser Bereich zeigt Ihnen einige vordefinierte Informationen sowie andere, die sich dynamisch anpassen.


	Ihr Name ist mit Ihrer Profilseite verlinkt.


	Ihr Profilbild ist mit Ihrer Profilseite verlinkt.


	Wenn Sie Mitglied einer Gruppe sind, wird dies hier angezeigt.


	Pending friend requests are displayed.


	Wenn Sie Artefakte oder Ansichten mit dem Schlagwort ‚portfolio‘ versehen haben, werden sie hier verlinkt.






	Online users: If this sidebar block is enabled, you see all users who have been logged in during the last 10 minutes.


	Quick links: These quick links take you to certain areas of Mahara fast.


	Nutzerspezifische Informationen. Diesen Bereich können Sie über Ihr Dashboard anpassen und festlegen welche Blöcke Sie nach dem Login sehen wollen.







2.2. Schnelle Links

Wenn Sie sich zum ersten Mal in Mahara einloggen, finden Sie drei Bereiche mit Links:


	Erstellen und sammeln: Erstellen Sie Ihr eigenes Portfolio


	Organisieren:  Präsentieren Sie Ihr eigenes Portfolio


	Teilen und Vernetzen: Nehmen Sie Kontakt mit Anderen auf und arbeiten Sie in Gruppen zusammen.





[image: Dashboard boxes]
Mahara information



Mit diesen ‚schnellen Links‘ erreichen Sie spezielle Bereiche Ihres Portfolios direkt von Ihrem Dashboard.


Bemerkung

If you removed these boxes from your dashbaord but want to get them back at a later point, you can re-active them under Settings -> Show information about Mahara on the home page.






2.3. Nutzerspezifische Informationen

Das bereits vorbereitete Dashboard enthält folgende Blöcke:


	Latest Pages


	My Pages


	Recent Activity


	Topics I’m Following




These areas are filled with content once you start using Mahara and create pages, receive messages from other users, have access to others‘ portfolio pages and use the forums for discussions. You can customize this area to your liking by editing your dashboard in Portfolio -> click the Edit button [image: edit] next to the dashboard page -> change the blocks like you would change them on any page in Mahara.


Siehe auch

Verweis auf den Ansichtseditor für weitere Informationen zum Hinzufügen und Bearbeiten von Blöcken in Ansichten.









          

      

      

    

  

    
      
          
            
  
3. Inhalt



	3.1. Profil
	3.1.1. Über mich

	3.1.2. Contact information, Messaging, General





	3.2. Profile Pictures
	3.2.1. Bilder, die in Mahara hochgeladen wurden

	3.2.2. Externe Avatare





	3.3. Dateien
	3.3.1. Datei hochladen

	3.3.2. Hochladen mehrerer Dateien

	3.3.3. Ein Verzeichnis erstellen

	3.3.4. Eine Datei oder einen Ordner löschen

	3.3.5. Dateiablagegröße





	3.4. Blog
	3.4.1. Ändern Sie Ihre Blogeinstellungen

	3.4.2. Einen Blogeintrag einfügen

	3.4.3. Fügen Sie eine Datei als Anhang an den Blogeintrag.

	3.4.4. Fügen Sie ein Bild zu Ihrem Blogeintrag hinzu.
	3.4.4.1. Link auf ein Bild online

	3.4.4.2. Ein Bild aus Mahara einfügen









	3.5. Biografie
	3.5.1. Einführung
	3.5.1.1. Erstellen Sie Ihr Begleitschreiben

	3.5.1.2. Tragen Sie Ihre persönlichen Informationen ein.





	3.5.2. Education & Employment

	3.5.3. Erfolge

	3.5.4. Ziele

	3.5.5. Kompetenzen

	3.5.6. Interessen





	3.6. Pläne
	3.6.1. Einen neuen Plan erstellen

	3.6.2. Aufgaben zum Plan hinzufügen

	3.6.3. Aufgaben in einem Plan bearbeiten









Der Inhalt-Tab enthält alle Artefakte, die Sie  für den Einsatz in einem Portfolio erstellen oder hochladen. Alle Informationen und Dateien, die Sie hier hochladen sind zunächst nur für Sie sichtbar. Ausnahmen sind:


	Ihr angezeigter Name oder falls dieses Feld nicht genutzt wird Ihr realer Name


	Ihr Profilbild




Both these are visible in the Online Users side bar if that is activated. Your display name, but not your profile picture, is also visible on your profile page per default.

Nur wenn Sie Artefakte in Ihre Portfolioansichten einfügen oder diese in einer Gruppe mit anderen teilen werden sie für andere sichtbar.





          

      

      

    

  

    
      
          
            
  
3.1. Profil

Your profile page is visible to other users on Mahara by default. If the site administrator allowed it, you can also make it visible to anybody on the Internet.

In der Grundeinstellung sind nur die folgenden Informationen auf Ihrer Profilseite eingestellt:


	Ihr Anzeigename (oder der reale Name wenn Sie keinen Anzeigenamen eingetragen haben)


	Ihre Ansicht(en), die für die jeweilige Person, die Ihr Profil betrachtet, sichtbar sind


	Ihre Gruppen


	Ihre Pinnwand


	Ihre Kontakte




Wir empfehlen Ihnen, Ihre Profilseite nicht als Portfolio zu verwenden, da Sie nicht kontrollieren können wer auf die Informationen zugreift. Dies sind zumindest alle Personen, die einen Account bei Mahara haben. Es können jedoch auch alle Personen über das Internet sein. Denken Sie immer sorgfältig darüber nach bevor Sie persönliche Informationen und Kontaktdaten ( z. B. Adresse, Telefonnummer) auf öffentlichen Seiten einstellen oder auch innerhalb von Mahara.  Mahara erlaubt Ihnen, gezielt darüber zu entscheiden, welche Informationen Sie wem zur Verfügung stellen.

Use regular pages to create your portfolio and your profile to make these pages accessible to other people and to establish your digital identity.

Your Profile area (Content -> Profile) stores your contact and personal information. Each of the profile fields can be considered separate artefacts which may be added independently to your profile page or any portfolio page. Thus, you can reveal as little or as much information about yourself to others as you wish.


Siehe auch

You can edit your profile page like any other page in Mahara. You can find more information about editing a page in the page editor.




3.1.1. Über mich

You must provide a first and last name. All other information is optional. You name is visible to other Mahara users. You may choose to have a Display Name. You can change the information here at any time unless an administrator locked certain fields.


	First Name: Your real given name


	Last Name: You real last name


	Benutzer-ID: Eintragen wenn erforderlich oder gewünscht.


	Display Name: The name by which you want to be known around Mahara. If you have a display name, your real name will not be visible to regular Mahara users. Only administrators can see your real name and your username at all times.


	Vorstellung: Schreiben Sie etwas über sich selber. Der Text wird in Verbindung mit Ihrem Profil automatisch angezeigt, bis Sie ihn ändern oder wieder entfernen.







3.1.2. Contact information, Messaging, General

Vielleicht wollen Sie einige Ihrer Kontaktinformationen für eine spätere Nutzung in einer Ansicht hinterlegen. Alle Informationen, die Sie hier ausfüllen, werden erst sichtbar wenn Sie sie in eine Ansicht einbinden. Bis dahin haben Sie alleine darauf Zugriff.

Die E-Mailadresse mit der Sie sich für Mahara registriert haben, wird angezeigt. Sie können weitere E-Mailadressen zu Ihrem Profil hinzufügen, um sie später zu verwenden. (z.B. eine berufliche und eine private E-Mailadresse)


Bemerkung

Wenn Sie  einen neue E-Mailadresse hinzufügen, stellen Sie sicher, dass Sie nicht nur den Hinzufügen-Button neben dem Feld zum Eingeben der E-Mailadresse, sondern auch  den Profil speichern-Button am Fuß der Seite anklicken. Nachdem Sie eine E-Mailadresse eingegeben haben, muß diese noch bestätigt werden. Sie erhalten umgehend eine E-Mail an diese Adresse. Darin ist einen Anleitung zur endgültigen Bestätigung enthalten.



If you use instant messaging services, you may wish to provide the details on those so that you can use them in your portfolio later easily.







          

      

      

    

  

    
      
          
            
  
3.2. Profile Pictures

Ihr Profilbild kann ein Bild von Ihnen selbst oder ein Avatar Ihrer Wahl sein.


3.2.1. Bilder, die in Mahara hochgeladen wurden

You can upload up to 5 profile pictures into Content -> Profile Pictures. Alternatively, you can use a Gravatar [http://gravatar.com] if you have one and if the site administrator allows its use.

The pictures you wish to use must be between 16x16 and 1024x1024 pixels in size. Ideally, your profile pictures are square. Please use an image editing software before you upload your pictures to Mahara to reduce a photo’s dimensions to the required ones.


Bemerkung

The recommended size of your profile pictures is 100x100 pixels. Then the picture looks good on your profile when you want to include it there and also in the smaller sizes around Mahara.



Das Profilbild, welches Sie in Mahara verwenden wollen, muss auf Ihrem Computer hinterlegt sein. Wählen Sie ein einzelnes Bild zum Upload. Sie können dem Bild auch einen Titel geben.


	Klicken Sie auf den Durchsuchen-Button, zur Suche nach dem gewünschten Bild auf Ihrem Computer.


	Klicken Sie auf Öffnen.


	Optional:   Geben Sie einen Titel für Ihr Bild ein.


	Klicken Sie auf Hochladen.


	Your picture appears in the list of profile pictures and you can now choose it as default picture.





[image: Profile pictures]
Ihre Profilbilder auflisten




Bemerkung

Profile pictures can be used in an portfolio page, but they are not listed in the Files area.



Wenn Sie mehr als ein Profilbild hochgeladen haben, können Sie festlegen welches als Standardbild in der Nutzersuche oder im Bereich Online-Nutzer gezeigt wird.

You can delete any of your profile pitures at any time. If you have 5 pictures uploaded and want to upload another one, you have to remove one of the first 5.


Bemerkung

Stellen Sie sicher, dass Sie die hochgeladenen Bilder verwenden dürfen.






3.2.2. Externe Avatare

Wenn die Site-Administration es zulässt externe Avatare zu verwenden wie z.B. Gravatar [http://gravatar.com] und Sie sind bei diesem Dienst registriert, so wird als Standardbild dieser externe Avatar eingesetzt bis Sie eines Ihrer selbst hochgeladenen Bilder zum Standard setzen.







          

      

      

    

  

    
      
          
            
  
3.3. Dateien

The Files area is a repository, i.e. a document storage for folders and files that you can  use within your portfolio. Both folders and files are considered artefacts and as such can be added to a page. You may create any number of folders or sub folders. To view which sub folders and files sit within a folder, click on the folder name. Use the Home link to return to the top level folder directory.

You can arrange files and folders by dragging and dropping the icon in front of the file / folder name onto another folder icon. A suitably named and organised filing structure will help you with the long term organisation and retrieval of your artefacts. If you want to move a file or folder out of a sub folder, move it onto the icon of parent folder.

Einige Ordner werden automatisch vom System angelegt wie z.B: Dateien sehen. Der Ordner enthält Dateien aus importierten Ansichten. Sie können diese Dateien wie alle anderen in andere Ordner verschieben.


Bemerkung

Sie können Dateien und Ordner verschieben, ohne dass bestehende Verlinkungen auf diese Artefakte unterbrochen werden. Sie können diese Artefakte auch umbenennen. Die Verlinkungen bleiben erhalten.




3.3.1. Datei hochladen

Bevor Sie eine Datei hochladen, prüfen Sie, ob Sie dazu berechtigt sind. Für jedes Artefakt, das Sie in Ihrem Portfolio veröffentlichen wollen, benötigen Sie die entsprechenden Nutzungsrechte. Das meint:


	das Artefakt ist Ihr eigenes oder


	you are allowed to reproduce and distribute it -> it does not violate any copyright legislation and


	das Artefakt verstösst nicht gegen die Nutzungsbedingungen der Mahara-Site, die Sie verwenden




It can be that you have to agree to an upload agreement before you can upload any files to your files area. The site administrator decides about that Site Administration -> Extensions -> Plugin Administration -> Plugin type: artefact: file.

Sie können eine Datei auf Ihrem Computer auswählen durch Anklicken des Durchsuchen-Buttons. Achten Sie darauf, dass die Datei nicht größer ist als die zulässige Dateiobergrenze. Es gibt zwei Begrenzungen: die Größe einer einzelnen Datei beim Upload ist begrenzt und der Ihnen persönlich verfügbare Dateiablageplatz ist begrenzt.

Nachdem die Datei erfolgreich hochgeladen wurde, erscheint sie in Ihrer Dateiliste. Sie können Sie durch Anklicken des Bearbeiten-Buttons editieren.


	den Dateinamen ändern (aber die Dateierweiterung beibehalten)


	eine Beschreibung hinzufügen, die Ihnen hilft, die Datei später zu identifizieren


	Schlagworte hinzufügen, die helfen, Ihren Portfolioinhalt  zu durchsuchen


	Kommentare direkt zu einem Artefakt erlauben





[image: Upload and edit a file]



	Datei hochladen


	Ein Verzeichnis erstellen


	Edit a file (continue with Step 5)


	Delete the file


	Change the name of the file


	Give the file a description to find it again more easily


	Give the file one or more tags. You can choose from your existing tags if you wish. Separate your tags with commas.


	Decide if users should be allowed to comment directly on the file.


	Save the changes




You can also move your file to a folder by clicking on the icon before the file’s name and then dragging and dropping it onto a folder icon.




3.3.2. Hochladen mehrerer Dateien

You cannot upload multiple files by simply selecting them. That is a Mahara 1.5 functionality. However, you can place them all into a compressed file, a .zip file, and upload that to Mahara. Modern computers allow you to create a zip file from any number of files that you have selected in your document managemant program by making a right mouse click and selecting Compress… (or something similar).


[image: Zip files in MacOSX]
ZIP-Dateien im Finder unter MacOSX




[image: Zip files in Ubuntu]
ZIP-Dateien in Ubuntu’s Nautilus




[image: Zip files in Windows]
ZIP-Dateien im Windows Explorer



Nachdem Sie die Dateien nach Mahara hochgeladen haben, können Sie sie dort entpacken. Klicken Sie auf den Entpacken-Button [image: unzip] neben dem Bearbeiten-Button [image: edit]. Folgen Sie dann den Anleitungen am Bildschirm.




3.3.3. Ein Verzeichnis erstellen

Tragen Sie den Namen des Verzeichnisses in das Textfeld ein und klicken Sie auf den Verzeichnis erstellen-Button. Sie können die Eigenschaften durch Anklicken des Bearbeiten-Buttons [image: edit] anpassen.


	den Namen ändern


	eine Beschreibung hinzufügen. Die hilft Ihnen, den Ordner später zu identifizieren.


	Schlagworte hinzufügen, die helfen, Ihren Portfolioinhalt  zu durchsuchen


	Kommentare erlauben (diese Einstellung kann durch ein Artefakt in einer Ansicht aufgehoben werden)







3.3.4. Eine Datei oder einen Ordner löschen

Sie können eine Datei oder einen ganzen Ordner mit dem gesamten Inhalt löschen, wenn Sie auf den Löschen-Button [image: delete] am Ende der Zeile mit der Datei oder dem Ordner klicken.

Wenn Sie eine Datei in einem Blogeitrag und / oder einer Ansicht verwenden, werden Sie vor dem Löschen gewarnt, damit die Datei nicht versehentlich gelöscht wird.




3.3.5. Dateiablagegröße

Die Site-Administration legt fest wie viel Platz Sie für die Dateiablage nutzen können. Dies kann von Institution zu Institution unterschiedlich sein. Der verfügbaren Dateiplatz  wird in Ihrem Datei-Bereich angezeigt.


[image: file quota]
Dateiablagegröße









          

      

      

    

  

    
      
          
            
  
3.4. Blog

Der Blog ist ein Werkzeug mit dem Sie Ihre Gedanken und Erfahrungen aufzeichnen können. Durch das Einfügen Ihres Blogs oder einzelner Einträge in eine Ansicht können Sie anderen die Möglichkeit zu Feedback und Kommentaren geben. Daraus kann ein Dialog mit Ihren Leser/innen entstehen.

Zunächst hat jede/r Nutzer/in einen Blog verfügbar.


Tipp

If you wish to use more journals, e.g. to put your writing into categories so that you can make all posts from one category available in a page without having to select each journal entry, you can go to your Settings and select Enable multiple journals.




3.4.1. Ändern Sie Ihre Blogeinstellungen

Sie können den Titel Ihres Standardblogs (und aller anderen, wenn Sie diese Option aktiviert haben) ändern und eine Beschreibung sowie Schlagworte hinzufügen.


	Klicken Sie auf den Einstellungen-Button für Ihren Blog.


	Ändern Sie den Titel.


	Fügen Sie eine Beschreibung für Ihren Blog ein. Sie können diese formatieren.


	Add tags to your journal for easier searching later on. Tags that you have already used elsewhere are available to you under Show my tags.


	Klicken Sie auf Einstellungen speichern.







3.4.2. Einen Blogeintrag einfügen

Alle Blogeinträge, die Sie erstellen, sind solange privat bis Sie sie in einer Ansicht anzeigen lassen. Das Veröffentlichen eines Blogs oder Blogeintrags ist ein dreiteiliger Prozess:


	Schreiben Sie Ihren Eintrag und speichern Sie ihn ab.


	Wählen Sie in einer Ansicht entweder den Block, um den ganzen Blog sichtbar zu machen, oder einen Beitrag aus einem Blog, um nur diesen zu veröffentlichen.


	Geben Sie denjenigen Zugriff, die die Ansicht sehen sollen.




When you are ready to post your journal entry:


	In your journal, click on New Entry.


	Provide a title for your journal entry.


	You must also write something in the Body. The visual editor helps you format your journal entry.


	Add tags to your entry to find it more easily later on. You can choose from tags that you have already used and / or enter new ones. Separate each tag with a comma. You may also choose tags from the ones that you have created previously.


	Add an attachment or more to your journal entry, e.g. pdf files associated with it or images. You can add files either from your files area or upload new ones directly onto your journal entry.


	Mark your entry as draft if you have not yet finished it. This is especially helpful if you have published your journal in a page, but do not want anybody to read this particular entry (yet). It is always visible to you, but not others.


	Allow comments if you want to receive them on the journal entry.


	Save your entry.







3.4.3. Fügen Sie eine Datei als Anhang an den Blogeintrag.


	Klicken Sie auf den Durchsuchen-Button und Wählen Sie die Datei(en) aus Ihrem Datei-Bereich aus, die Sie einfügen möchten.


	Alternativ können Sie weitere Dateien hochladen.


	Wenn Sie eine Datei angehängt haben, die Sie nicht mehr hinzufügen möchten, können Sie sie entfernen.


	Nachdem Sie dies getan haben, klicken Sie auf den Schließen-Button.





[image: Options on the file attachment screen]
Anhänge für Blogeinträge






3.4.4. Fügen Sie ein Bild zu Ihrem Blogeintrag hinzu.

Sie können auf zwei Wegen Bilder zu Ihrem Blogeintrag hinzufügen:


	Link auf ein Bild, das irgendwoanders abgelegt ist.


	Ein Bild aus Mahara verwenden.





3.4.4.1. Link auf ein Bild online

Bilder, die frei verfügbar online abgelegt wurden, können leicht eingefügt werden. Stellen Sie zuvor sicher, dass Sie diese Bilder in Ihrem Portfolio verwenden dürfen.


	Klicken Sie im Editor auf den Bild-Button [image: tinymce_image].


	Paste or type the image URL into the Image URL field. It must start with http:// or https://.


	Provide a brief description for your image.


	Select the alignment to the text for your image.


	Change the dimensions of your image if they are too large. If the image is recognised correctly, you have the image’s dimensions displayed.


	Add a border to your image if you wish to do so.


	Add more space around the image by adding a number in Vertical space and / or Horizontal space.


	Click the Insert button.





[image: Insert an image into a journal post]
Link an external image in a journal post




Bemerkung

Die Werte werden in Pixeln angegeben. Der erste Wert ist für die Breite und der zweite bestimmt die Höhe. Tragen Sie nur einen der beiden Werte ein, damit das Seitenverhältnis gewahrt bleibt.



Wenn Sie mit dem Ergebnis ihrer Einstellungen noch nicht zufrieden sind, klicken Sie erneut auf das Bild (es erscheinen kleine Markierungen an den Ecken) und klicken Sie erneut auf den Bild-Button [image: tinymce_image], um die Einstellungen anzupassen.




3.4.4.2. Ein Bild aus Mahara einfügen


	Attach the image to your journal entry.


	Klicken Sie im Editor auf den Bild-Button [image: tinymce_image].


	Choose the image from the drop-down list Attached image.


	Provide a description for your image.


	Select the alignment to the text for your image.


	Change the dimensions of your image if they are too large. IF the image is recognised correctly, you have the image’s dimensions displayed.


	Add a border to your image if you wish to do so.


	Add more space around the image by adding a number in Vertical space and / or Horizontal space.


	Click on the Insert button.




Wenn Sie mit der Anordnung oder der Größe des Bildes in Ihrem Blogeintrag nicht zufrieden sind, wählen Sie es an und klicken Sie erneut auf den Bild-Button [image: tinymce_image] um es anzupassen.









          

      

      

    

  

    
      
          
            
  
3.5. Biografie

The résumé plugin allows you to create an online résumé / curriculum vitae. You can either publish the entire résumé or individual components of it in your portfolio.


3.5.1. Einführung

In the introduction you can write a Cover Letter and also provide some Personal Information.


3.5.1.1. Erstellen Sie Ihr Begleitschreiben

It is advisable that you write your cover letter in a word processor. That will allow you to spellcheck your writing. Alternatively, a site administrator could install the spellchecker for the editor.

Dennoch sollten Sie Ihre Formatierungen im Editor vornehmen. Die Formatierungen Ihrer Textverarbeitung werden meist bei der Darstellung im Internetbrowser zu unerwünschten Formatierungen führen.

Click the Save button right below the editor window when you are happy with your cover letter to save it to Mahara for future use.


Bemerkung

Wenn Sie das Begleitschreiben in einer Textverarbeitung wie Microsoft Word  erstellt haben, verwenden Sie den Aus Word einfügen-Button [image: tinymce_word], um die meisten Formatierungen umzuwandeln. Bei der Darstellung im Browser können diese sonst zu Problemen führen.






3.5.1.2. Tragen Sie Ihre persönlichen Informationen ein.

None of the fields under Personal Information are required. You can choose to include as much or as little information as you wish. Most fields are free form fields.


Bemerkung

Mahara wird weltweit genutzt. Daher sind manche Informationen jetzt oder später für Sie vielleicht nicht von Bedeutung. Wenn Sie von Ihnen nicht benötigt werden, lassen Sie sie einfach aus.




	Date of birth: Either choose your date of birth from the calendar or enter it in the format YYYY/MM/DD, e.g. 1978/01/30 when you want to say that you were born on 30 January 1978.


	Geburtsort: Tragen Sie Ihren Geburtsort ein. Sie können auch das Land eingeben, in dem Sie geboren wurden.


	Staatsbürgerschaft: Tragen Sie es - wie in Ihrem Pass eingetragen - hier ein.


	Aufenthaltsstatus: Die Arbeitsplatzregeln können sich von Land zu Land unterscheiden. Vielleicht ist es für Sie wichtig den Arbeits- oder Visastatus in Ihre Biografie einzufügen.


	Geschlecht: Tragen Sie Ihr Geschlecht ein.


	Familienstand: Eintragen, falls von Bedeutung.




Click on Save when you want to keep that information.






3.5.2. Education & Employment

Dieser Teil der Biografie ermöglicht Ihnen, die Stationen Ihrer schulischen, akademischen und beruflichen Qualifikationen, sowie Ihre Berufserfahrung aufzuzeichnen.

Der Prozess der Erstellung von Einträgen für den schulischen Werdegang, die Hochschulausbildung und die Berufserfahrung ist sehr ähnlich. Er wird daher nur einmalig erläutert.


	Klicken Sie auf den Hinzufügen-Button, um einen neuen Eintrag zu erstellen.


	Füllen Sie die rot und mit * markierten Felder aus. Diese Felder sind erforderlich und gewährleisten ein Minimum an Informationen.


	Füllen Sie die weiteren Felder aus, wenn sie für Sie relevant snd.


	Click the Save button right below the „Qualification Description“ to save your entry.


	Klicken Sie den Hinzufügen-Button für weitere Einträge.





Bemerkung

Sie können die Daten in jeder von Ihnen gewünschten Form eingeben. Das Feld erfordert keine formale Eingabe eines Kalenderdatums, da jede Biografie unterschiedlich strukturierte Datumsformate erfordert.




[image: Education History table]
Interpreting the Education History table




	Verwenden Sie die Aufwärts und Abwärts-Pfeile [image: move_up] [image: move_down] um die Reihenfolge der einzelnen Einträge anzupassen.


	Das Startdatum wird angezeigt, wie Sie es eingegeben haben.


	Das Enddatum wird angezeigt wie Sie es eingegeben haben.


	Your qualification along with the institution is shown.


	Verwenden Sie die Bearbeiten- [image: edit] und *Löschen-Buttons [image: delete], um individuelle Einträge zu ergänzen oder zu entfernen.





Bemerkung

Es ist wichtig, nach jedem Eintrag am Ende des Formulars, den Speichern-Button zu verwenden.



Einträge werden in tabellarischer Form angezeigt. Ändern Sie einen Eintrag durch Anklicken des Bearbeiten-Buttons [image: edit]. Wenn Sie fertig sind, speichern Sie Ihre Änderungen, um zu dieser Seite zurückzukehren. Klicken Sie auf den Löschen-Button, um Einträge zu entfernen.

Wenn Sie zu Ihrer Qualifikaton eine Beschreibung eingegeben haben, klicken Sie auf den Namen der Qualifikation, um diese Information anzuzeigen oder zu verbergen.




3.5.3. Erfolge

Unter Erfolge können Sie folgende Arten von Informationen sammeln:


	Abschlüsse, Zertifikate, Zulassungen, Auszeichnungen, z.B. vereidigte Buchprüferin, geprüfter Krankenpfleger, Auszeichnung als Schauspieler


	Bücher und Publikationen


	Mitgliedschaften in Berufsorganisationen, z.B. in Fachverbänden




The process of adding, editing and moving entries is similar to the process for Education & Employment.


	Klicken Sie auf den Hinzufügen-Button, um einen neuen Eintrag zu erstellen.


	Füllen Sie die rot und mit * markierten Felder aus. Diese Felder sind erforderlich und gewährleisten ein Minimum an Informationen.


	Füllen Sie die weiteren Felder aus, wenn sie für Sie relevant snd.


	Klicken Sie auf den Speichern-Button rechts unter der „Beschreibung“, um den Eintrag zu sichern.


	Klicken Sie den Hinzufügen-Button für weitere Einträge.


	Verwenden Sie die Aufwärts und Abwärts-Pfeile [image: move_up] [image: move_down] um die Reihenfolge der einzelnen Einträge anzupassen.


	Klicken Sie auf den Löschen-Button [image: delete], um einen Eintrag von der Liste zu entfernen.





[image: Achievements table]
Achievements provided in the Résumé




Bemerkung

Click the title of your certification, accredidation, award, book or professional membership to see its full description.






3.5.4. Ziele

Der Ziele-Bereich wird in drei Sektionen aufgeteilt:


	Persönliche Ziele


	Schulische/akademische Ziele


	Berufliche Ziele




Goals added here may be included in your portfolio pages.

Personal or career goals are often provided in résumés so that employers can understand how a particular role might suit your ambitions.

You can also use the academic goals section to describe achievements you are seeking in your programme of study.

Write your goal description into the appropriate box and click on the Save button once you are done editing. You can come back at any time and edit your goals.


[image: Goals section]
Ziele für die Nutzung in Portfolio-Ansichten aufschreiben






3.5.5. Kompetenzen

Der Kompetenzen-Bereich ist in drei Sektionen aufgeteilt:


	Persönliche Fähigkeiten und Kompetenzen


	Schulische und akademische Fähigkeiten und Kompetenzen


	Berufliche Fähigkeiten und Kompetenzen




Skills added here may be included in your portfolio pages.

Employers are always interested in what skills you can bring to a role. You can also use this section to display the attributes that you would bring to a collaborative community or working group.

Write your skills descriptions into the appropriate box and click on the Save button once you are done editing. You can come back at any time and edit your goals.


[image: Skills section]
Example of work skills






3.5.6. Interessen

The Interests section allows you to list your personal and / or professional interests. This might include your hobbies, sporting activities, volunteer work, areas of research and expertise etc. Listing your Interests will help employers form a better picture of who you are and what you would bring to their organisation.

Write your interests into the editor window and click on the Save button once you are done editing. You can come back at any time and edit your interests.


[image: Interests section]
Beispiel von Interessen für eine Biografie









          

      

      

    

  

    
      
          
            
  
3.6. Pläne

Pläne sind einfache Todo-Listen. Sie sind besonders hilfreich, um mittel- und langfristige Vorhaben zu planen. Ein Plan besteht aus mehreren individuellen Aktivitäten mit einem damit verbundenem Abschlußdatum.


3.6.1. Einen neuen Plan erstellen


	Go to Content -> Plans.


	Klicken Sie auf den Neuen Plan erstellen-Button.


	Give your plan a title.


	Give your plan a description. It is visible when you select a plan for inclusion into a portfolio page.


	Click Save plan.




Nun können Sie individuelle Aufgaben zum Plan hinzufügen




3.6.2. Aufgaben zum Plan hinzufügen

Es gibt verschiedene Wege, Aufgaben zu einem Plan hinzuzufügen:


	Klicken Sie auf Aufgabe hinzufügen rechts neben dem gespeicherten Plan.


	Click on Content -> Plans -> the title of the plan -> New task.


	Click on Content -> Plans -> the Manage tasks button [image: manage] -> New task.




Once you are in the New task screen, you can create your new task:


	Enter a title for your task.


	Provide a completion date. This is compulsory and allows for tasks to be marked overdue.


	You can provide more detailed information about the task in the Description field.


	If you have already completed the task, you can tick the checkbox.


	Click Save task.


	Add more tasks or come back to them later.





[image: A plan with several tasks]
Pläne unter Inhalt




[image: Plan on a portfolio page]
That’s what a plan looks like in a portfolio page. Clicking on the title of the task shows / hides the task description.






3.6.3. Aufgaben in einem Plan bearbeiten


	Click on Content -> Plans -> the Manage tasks button [image: manage] or the title of the plan.


	Klicken Sie auf den Bearbeiten-Button [image: edit] neben der Aufgabe, die Sie anpassen wollen.


	Nehmen Sie Ihre Änderungen vor oder markieren Sie die Aufgabe als abgeschlossen.


	Klicken Sie auf Aufgabe speichern und Ihre Änderungen werden gesichert.










          

      

      

    

  

    
      
          
            
  
4. Portfolio



	4.1. Ansichten
	4.1.1. Übersichtsseite

	4.1.2. Eine neue Ansicht erstellen

	4.1.3. Edit a page

	4.1.4. Eine Ansicht anzeigen

	4.1.5. Anderen Zugriff zur Ansicht geben.





	4.2. Ansicht bearbeiten
	4.2.1. Navigation des Editors
	4.2.1.1. Titel und Beschreibung bearbeiten

	4.2.1.2. Layout bearbeiten





	4.2.2. Artefaktauswahl

	4.2.3. Ansichtenlayout

	4.2.4. Themeauswahl (optional)





	4.3. Sammlungen
	4.3.1. Eine Sammlung hinzufügen

	4.3.2. Edit collection pages

	4.3.3. Sammlungsansichten verwalten

	4.3.4. Ihre Sammlungen verwalten

	4.3.5. Anderen Zugriff auf die Sammmung geben





	4.4. Teilen
	4.4.1. Zugriff für Nutzer/innen mit einem Account vergeben

	4.4.2. Zugriff zeitlich beschränken

	4.4.3. Erweiterte Optionen wählen

	4.4.4. Zugriff für Nutzer/innen ohne Account





	4.5. Export

	4.6. Feedback

	4.7. Feedback als Bewertung
	4.7.1. Eine Ansicht zur Bewertung einreichen

	4.7.2. Feedback von Bewertern (instructors)





	4.8. Schlagworte
	4.8.1. Schlagwort-Wolke

	4.8.2. Meine Schlagworte

	4.8.3. Schlagworte bearbeiten









Das Portfolio ist der Ort in Mahara an dem Sie die Artefakte, die Sie im Bereich Inhalte gesammelt haben, in Ansichten zusammenstellen. Diese Ansichten können Sie dann mit anderen teilen oder für sich behalten.

In diesem Abschnitt lernen Sie:


	Portfolioansichten zu erstellen


	mit Sammlungen, Portfolioansichten zu bündeln


	Ihre Ansichten und / oder Sammlungen mit anderen zu teilen


	Ihr Portfolio zu exportieren


	Feedback zu Artefakten und Ansichten zu geben


	Ihre Schlagwortwolke zu nutzen und Schlagworte zu verändern








          

      

      

    

  

    
      
          
            
  
4.1. Ansichten

Eine Ansicht enthält eine Auswahl von Artefakten, die Sie anordnen, um sie anderen zu präsentieren. Dies kann enthalten:


	Ausgewählte Dateien


	Details der Biografie


	Text (Ihre eingefügten Kommentare, Anleitungen oder Orientierungen)


	Blogeinträge


	Video- und Audiodateien


	RSS-Feeds zu einem externen Blog


	etc.




Artefakte, die Sie unter Inhalt angesammelt haben, können mehrfach in Ansichten verwandt werden.


[image: Content in multiple pages]
Artefakte können in mehreren Ansichten verwandt werden.




4.1.1. Übersichtsseite

On the landing page of the portfolio, you can do the following:


	Eine neue Ansicht erstellen.


	Eine Ansicht aus einem anderen Portfolio oder eines anderen Nutzers kopieren.


	Ihre Portfolioansichten durchsuchen.


	Ihre Dashboardseite bearbeiten.


	Ihre Profilseite bearbeiten.


	Ihre Portfolioansichten bearbeiten oder löschen.





[image: Overview pages of "Portfolio"]
Die Landingpage für Ihr Portfolio






4.1.2. Eine neue Ansicht erstellen

Sie erstellen eine neue Ansicht in Ihrem Portfolio, um verschiedene Ansichten zusammen anzuordnen, z.B. zur Präsentation für andere oder um den Fortschritt in einem Projekt zu dokumentieren.


	On the Pages page, click the Create Page button. You are taken to the page editor.


	Decide what type of artefact you wish to display in your page.


	Choose the desired artefact block and drag it into the content editor area.


	Follow the on-screen instructions for selecting the content you wish to display and click the Save button.


	Choose further artefact blocks and configure them.


	Cick on the tab Edit Title and Description to give your page a title, description, and tags.


	Click the Save button to return to the page editor.


	Click the tab Edit Layout to change the layout for your page from the standard 3 columns to 2 columns or another choice.


	Click the Save button to return to the editor.


	Click the Done button at the bottom of the page to finish editing this page. You are taken back to the overview page.





Siehe auch

See Ansicht bearbeiten for detailed information on the individual elements of the editor.




[image: A finished portfolio page]
An example portfolio page. When you are the author, you can click on the Edit button and make changes.



The individual elements in the screenshot are the following:


	Title of the portfolio.


	Autor/in der Portfolioansicht.


	Beschreibung der Portfolioansicht.


	Der Ansicht bearbeiten-Button ist nur für den/die Portfolioautor/in sichtbar.


	Die Artefakte, die in dieser Ansicht eingebunden wurden.


	Der Feedbackbereich am Fuß jeder Ansicht zeigt Kommentare von Nutzer/innen.


	Place feeback button can be used by yourself and others to leave comments on the page.


	If a page contains offensive artefacts, users can report that to the administrator.


	Druck-Button zum Ausdrucken der Ansicht.


	Die Ansicht zur Beobachtungsliste hinzufügen ermöglicht es Ihnen, Informationen über Änderungen an der Ansicht zu erhalten.







4.1.3. Edit a page

Sie können eine bestehende Ansicht auf zweierlei Wegen bearbeiten:


	Klicken Sie auf den Bearbeiten-Button [image: edit] in der Ansichten-Übersicht.


	Klicken Sie auf den Diese Ansicht bearbeiten-Button  in der aktuellen Ansicht.





Warnung

Text boxes and links to external content such as embedded external videos and RSS feeds to an external blog are completely deleted when you remove the respective blocks from your portfolio page. You cannot recover them. There is no revision history. All other artefacts are not deleted when you remove them from a page because they reside in your Content area.






4.1.4. Eine Ansicht anzeigen

Sie können sich die Ansicht anzeigen lassen wie jeder andere Nutzer sie auch sieht, um sie zu überprüfen. Gehen Sie zur Ansichten-Übersicht und klicken Sie auf den Titel der Ansicht.

At the bottom of any page (except the profile page) that you have access to you can perform a number of actions.


[image: Actions at the bottom of a page]
Actions at the bottom of a page




	Place feedback for the page or artefact author.


	Report objectionable content to the administrators, e.g. when content on the page does not comply with the terms and conditions of the page, is offensive etc.


	Print the page.


	Add the page to your watchlist and receive notifications when the content of the page changes.


	View the number of comments that have been left on the page.







4.1.5. Anderen Zugriff zur Ansicht geben.


Siehe auch

Please refer to the section on sharing your pages and collections for further information.









          

      

      

    

  

    
      
          
            
  
4.2. Ansicht bearbeiten

Die Ansichtenbearbeitung in Mahara ist wichtig, sie erlaubt Ihnen die Portfolioansicht zu gestalten. Sie besteht aus einer umfangreichen Reihe von Komponenten.


	Navigation des Editors


	Artefaktauswahl


	Ansichtenlayout





4.2.1. Navigation des Editors


[image: Page editor navigation]
Ansichtsseitenwechsler




	Edit Content: Place your content on a page. See Artefaktauswahl, Blöcke and Ansichtenlayout.


	Edit Title and Description: Add and modify your page title, description and tags.


	Edit Layout: Change the overall layout of your page.


	Ansicht anzeigen: Vorschau auf Ihre Ansicht, um zu sehen wie andere die Ansicht sehen werden.


	Share page: Decide who shall have access to your page. See Teilen for more details.





4.2.1.1. Titel und Beschreibung bearbeiten

Geben Sie Ihrer Portfolioansicht einen eindeutigen und aussagekräftigen Titel, damit Sie sie später leicht wiederfinden. Die Beschreibung hilft Ihnen auf einer Übersichtsseite schnell die Ansicht zu identifizieren. Die Schlagworte helfen Ihnen bei der Suche innerhalb des Portfolios, beim Finden des Inhalts und der Portfolioansichten.


[image: Title and description screen]
Hinterlegen Sie in Ihrem Portfolio so viele Informationen wie möglich, um es später durchsuchen zu können. Sie könne später jederzeit Änderungen vornehmen.




	Page Title: You must provide a title for your page. Automatically, every page is called „Untitled“.


	Page Description: You can write a brief description for your page, e.g. its purpose. this description is displayed on the overview page and on the portfolio page itself.


	Schlagworte: Falls Sie bereits Ihre Artfakte oder andere Portfolioansichten verschlagwortet haben, können Sie auf diese Schlagworte erneut zugreifen. Dadurch werden Tippfehler vermieden.


	If you either do not yet have tags or need to use a new ones, you can write them into the text box. Separate multiple tags by commas.


	Name display format: You must choose which name should be displayed when somebody else views your portfolio.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu speichern.







4.2.1.2. Layout bearbeiten

Sie haben zehn Optionen für das Spaltenlayout zwischen ein und fünf Spalten. Beim zwei-, drei- und vierspaltigen Layout können Sie bestimmte Spalten breiter definieren als andere. Die Icons unterstützen Sie bei der Entscheidung und geben Ihnen einen Eindruck, wie es später aussehen wird. Sie können jedoch nicht die Spaltenbreite frei definieren.


Bemerkung

Seien Sie bei der Auswahl von vier- oder mehrspaltigen Layouts vorsichtig. Ihr Portfolio mag damit eindrucksvoll auf einem sehr großen Bildschirm, mit hoher Auflösung aussehen. Beim Betrachten mit einem Notebook oder der Anzeige über einen Beamer werden drei Spalten jedoch sehr schmal oder man muß horizontal scrollen. In den meisten Fällen ist ein zwei- oder dreispaltiges Layout sehr empfehlenswert.



Click the radio button above the layout that you wish to apply to your page. You can change it at any time. When you reduce the number of columns, your blocks simply move to the first column. You can then move them around to their correct position (see Ansichtenlayout).


[image: Overall page layout editor]
Edit the overall layout of a page by choosing the number of columns




Bemerkung

Sie können Spalten direkt im Ansichtenlayout entfernen oder hinzufügen, wenn Sie die Option  Anzeige von Buttons im Bearbeitungsmodus zum Hinzufügen und Löschen der Spalten in den Einstellungen Ihrer Accountoptionen aktivieren.




[image: Add and remove buttons in the page layout area]
Sie können die Hinzufügen- und Entfernen-Buttons nutzen, um das Layout schnell anzupassen, sofern dies aktiv ist.








4.2.2. Artefaktauswahl

Die verschiedenen Artefakttypen, genauso wie die Blöcke, die externe Inhalte einbinden, werden über die Artefaktauswahl erreicht.


[image: Artefact chooser]
All artefacts are accessible via a number of tabs in the page editor




	Externe Inhalte: enthält Blöcke, um RSS-Feeds, externe Medien oder Google-Apps-Dokumente  in einer Ansicht anzuzeigen


	Files, images and video: holds blocks for Mahara files that can be displayed as links, in folders, or in the case of images and videos directly in the page


	Allgemein: Artefakte allgemeiner Art


	Blogs: verschiedene Artefaktblöcke mit denen Sie Ihre Blogs und/oder Blogeinträge in einer Ansicht anzeigen können.


	Profil: Wählen Sie die Profilinformationen, die in einem Block angezeigt werden sollen


	Résumé: display your entire résumé or only parts of it





Siehe auch

The functionality of each block that you can use in your portfolio pages and in group pages, is outlined in the section on the individual artefact blocks.






4.2.3. Ansichtenlayout

Der Ansichtenlayout-Bereich ist der Platz an dem Sie die Artefakte zur Ansicht auf einer Portfolioansicht arrangieren. Sie sollten hierüber folgendes wissen:


	Alle Artefakte werden durch Drag-and-drop (ziehen und loslassen) an ihren Platz geschoben.


	Die Artefakte werden als eine aufeinander folgende Reihe von Blöcken in den Spalten angelegt.


	Es gibt keine Zeilen, nur Spalten. Blöcke werden hintereinander in einer Spalte angelegt. Sie stehen nicht direkt neben dem Block einer anderen Spalte, es ei denn sie haben zufällig die gleiche Höhe.


	Klicken Sie die Blöcke in ihrer Kopfzeile an, um sie mit der Maus an eine andere Stelle zu ziehen und lassen Sie sie dort wieder los.


	Sie können die Einstellungen für einen Block durch Anklicken des Konfigurieren-Buttons [image: manage] ändern.





[image: Drag a block into the page layout area]
Drag and block into the page layout area and configure its settings




	Klicken Sie auf den Block für das Artefakt, welches Sie in Ihre Ansicht einbinden wollen und ziehen Sie es in den Layout-Bereich.


	Wenn Sie das gepunktete Rechteck sehen, lassen Sie den Block los, damit er an dieser Stelle in Ihre Ansicht eingefügt wird.


	Follow the on-screen instructions on choosing the specific artefact you wish to display. Please refer to the artefact block for more information on each block’s settings.





Siehe auch

Please refer to the section edit layout to learn how to change the number of columns on a page and make certain columns wider than others.






4.2.4. Themeauswahl (optional)

You may be able to choose a theme for your portfolio page. If that is the case, you see a Theme drop-down menu below the artefact chooser. That allows you to select a theme in which that page is displayed to others who view your portfolio page.


[image: Select a theme for your page]
Select a theme for your page




Siehe auch

The site administrator must allow page themes in the site’s user settings.









          

      

      

    

  

    
      
          
            
  
4.3. Sammlungen

A collection is a set of pages that are linked to one another and have the same access permissions. You can create as many collections as you like, but a page cannot appear in more than one collection.


4.3.1. Eine Sammlung hinzufügen

You add a collection under Portfolio -> Collections.


[image: Create a collection]
Erstellen Sie eine Sammlung




	Click the New Collection button.


	On the next screen, provide a title for your collection.


	Optionally, you can also write a short description about your collection. You do not have a visual editor, but just a plain text box.


	Choose whether you wish to display a tabbed navigation or not. If you choose not to, you will have to include the navigation block so that you can go from one page to the next.


	Click the Next: Edit Collection pages button.







4.3.2. Edit collection pages

Nachdem Sie eine Sammlung angelegt haben, legen Sie fest, welche Portfolioansichten in die Sammlung aufgenommen werden sollen. Sie finden hier alle Ansichten, die Sie verwenden können. Wenn Sie eine Ansicht bereits in eine andere Sammlung aufgenommen haben, wird sie nicht mehr angezeigt.


[image: Edit collection pages]
Fügen Sie Ansichten zu einer Sammlung hinzu




	Markieren Sie jede Ansicht, die in die Sammlung aufgenommen werden soll.


	Klicken Sie auf den Ansichten hinzufügen-Button in Ihrer Sammlung.


	Klicken Sie auf den Fertig-Button, um diesen Schritt abzuschließen.







4.3.3. Sammlungsansichten verwalten

Nachdem Sie Ihre Ansichten zu einer Sammlung hinzugefügt haben, können Sie die Ansichten darin hin-und herschieben.


[image: Manage collection pages]
Verwalten Sie die Ansichten, die in Ihrer Sammlung angezeigt werden




	Verwenden Sie die Nach oben [image: move_up] und Nach unten [image: move_down]-Buttons, um die Reihenfolge der Ansichten anzupassen.


	Klicken Sie den Entfernen-Button, um eine Ansicht aus einer Sammlung zu entfernen. Die Ansicht selbst wird nicht gelöscht.


	Klicken Sie auf den Speichern–Button.




Sie können weitere Ansichten zu einer Sammlung aus der Ansichten zu Sammlung hinzufügen-Box hinzufügen.


[image: The finished result]
Eine Sammlung mit gekennzeichneter Navigation






4.3.4. Ihre Sammlungen verwalten

On the overview page of the collections, you can:


	Create a new collection by clicking on the New Collection button.


	Click on the collection title to go to the first page of a collection.


	Klicken Sie auf den Titel einer Ansicht in einer Sammlung, um direkt dorthin zu springen.


	Klicken Sie auf den Verwalten-Button [image: manage], um Ansichten innerhalb einer Sammlung zu verschieben, hinzuzufügen oder zu löschen.


	Klicken Sie auf den Bearbeiten-Button [image: edit], um den Titel und die Beschreibung einer Sammlung zu ändern.


	click on the Delete button [image: delete] to delete the collection. The pages will still exist.





[image: Overview page for collections]
Übersicht über Sammlungen






4.3.5. Anderen Zugriff auf die Sammmung geben


Siehe auch

Please refer to the section on sharing your pages and collections for further information.









          

      

      

    

  

    
      
          
            
  
4.4. Teilen

When you have created portfolio pages (and collections), you may wish to share them with others, e.g. to receive feedback. You can set the access permissions on the Edit access page. It is accessible via Portfolio -> Share or directly from the page editor when you edit a portfolio page.

Die Teilen-Übersichtssseite zeigt Ihnen folgendes:


	Your collections and pages sorted alphabetically.


	Der Liste der Nutzer/innen und / oder Gruppen, die auf eine einzelne Sammlung oder Ansicht Zugriff haben.


	The Edit Access button [image: edit_access] which allows you to change the permission of who can view a page or collection.


	Der geheime URL Bearbeitungsbutton [image: edit] ermöglicht es Ihnen, eine oder mehrer geheime URLs für eine Ansicht oder Sammlung zu erstellen. Die Anzahl der bereits erstellten geheimen URLs wird neben dem Button angezeigt.





[image: Share overview page]
Übersichtseite teilen




4.4.1. Zugriff für Nutzer/innen mit einem Account vergeben

The Edit Access page allows you to set the permissions for a single user or multiple users for if and when they should be able to view your portfolio pages or collections.

You can assign access to a single page or collection at a time or to multiple pages and / or collection at once.


[image: Edit access permissions]
Nutzer und Gruppen, denen Sie Zugriff auf Ihre Ansichten und Sammlungen geben können



You have a number of choices of selecting who shall be able to see what:


	Choose the collection or collections for which you want to give access. If you made a mistake in your selection, either take the checkmark off or select All or None to check or clear all respectively.


	Choose the page or pages for which you want to give access. If you made a mistake in your selection, either take the checkmark off or select All or None to check or clear all respectively.


	Öffentlich: jede/r, der die URL(s) kennt, kann die von Ihnen ausgewählten Ansichten / Sammlungen sehen.


	Angemeldete Nutzer/innen: alle, die mit ihrem Account in der Mahara-Instanz eingeloggt sind, können die von Ihnen ausgewählten Ansichten / Sammlungen sehen.


	Kontakte: alle Ihre Kontakte in Mahara können die von Ihnen ausgewählten Ansichten / Sammlungen sehen.


	Alle meine Gruppen: jedes Mitglied in den Gruppen in denen Sie selber Mitglied sind, kann die von Ihnen ausgewählten Ansichten / Sammlungen sehen.


	Eine bestimmte Gruppe: Alle Mitglieder dieser Gruppe können die von Ihnen ausgewählten Ansichten / Sammlungen sehen.


	If none of the above choices are what you are looking for, you can search for specific users or groups. Make your selection.


	Geben Sie den Namen der Nutzer oder der Gruppe ein nach der Sie suchen wollen.  Eine Teil des Namens reicht häufig aus.


	Add the user or group. You can click on the name of the user or group to verify that it is the correct one.





Bemerkung

Your friends or individual users with whom you shared your pages / collections receive a notification. Group members also receive a notification that you shared a page with them if the group administrator allowed that. You do not receive a notification when a user shared his page with the public or al logged-in users.






4.4.2. Zugriff zeitlich beschränken

Zusätzlich zur Kontrolle wer auf welche Ihrer Ansichten / Sammlungen  zugreifen kann, können Sie den Zugriffszeitraum beschränken.


[image: Restrict access time]
Zugriff auf Ihre Ansichten und  Sammlungen weitereinschränken




	Each user or group of people can receive their own time restrictions that are independent of other access groups. You can specify a start date.


	You can also specify an end date.


	You can click the Remove button [image: remove] to completely take a user group off your access list.







4.4.3. Erweiterte Optionen wählen

Sie können verschiene erweiterte Einstellungen  direkt mehreren zuvor ausgewählten Ansichten und / oder Sammlungen zuweisen.


[image: Advanced access options]
Erweiterte Optionen zum Bearbeiten von Ansichten und Sammlungen




	Kommentare erlauben: Diese Funktion ist vorab bereits aktiviert und kann von Ihnen geändert werden.


	Kommentare moderieren: Wenn Sie Kommentare erst ansehen wollen, bevor sie anderen Nutzern angezeigt werden, klicken Sie hier.


	Kopieren erlauben: Aktivieren Sie die Funktion, damit andere Nutzer/innen, die auf Ihre Ansichten / Sammlungen zugreifen können, sich eine Kopie hiervon erstellen dürfen. Die Kopie enthält Ihre Textfelder, Dateien und Ordner. Diese werden als Kopie im Portfolio des anderen Anwenders hinterlegt. Für Blogs entscheiden Sie, ob diese mitkopiert werden. Profilinformationen, Pläne und Biografien werden nicht mitkopiert.


	Overriding Start / stop dates: Here you set the time frame for when all users who have access to your page / collection can view your page. The dates here override any individual dates you may have set.




Wenn Sie das Kopieren nicht generell erlaubt haben, können Sie dennoch das Kommentieren für bestimmte Personen oder Gruppen zulassen, die auf Ihrer Zugriffsliste stehen. Damit können Sie sehr flexibel regulieren wer berechtigt sein soll, Kommentare abzugeben oder den Inhalt nur zu lesen.


[image: Comments per user]
Kommentare auf Nutzerebene zulassen




Bemerkung

Wenn Sie eine Institutionansicht bearbeiten, finden Sie eine zusätzliche Option, falls das Kopieren zugelassen ist.  Damit können Sie eine Ansicht automatisch in das Portfolio eines jeden neuen Nutzers kopieren. Bestehende Nutzer/innen müssen die Ansicht weiterhin individuell kopieren.






4.4.4. Zugriff für Nutzer/innen ohne Account

Außer Nutzer/innen mit einem Account oder der gesamten Öffentlichkeit, können Sie auch bestimmten Personen  ohne Nutzeraccount auf Mahara gezielt Zugriff für Ihre Ansichten und / oder Sammlungen geben. Der Inhalt wird dadurch nicht allgemein öffentlich verfügbar und auch Suchmaschinen erhalten keinen Zugriff.  Dies kann in folgenden Situationen hilfreich sein


	wenn Sie ein Portfolio für eine Bewerbung erstellt haben und einem potenziellen Arbeitgeber ohne Login Zugriff geben wollen


	wenn Sie Ihr Portfolio mit Ihren Eltern teilen wollen, um von diesen Feedback zu erhalten


	wenn ein externer Assessor Ihre Arbeit bewerten soll.




Sie können eine geheime URL auf der Übersichtsseite zum Teilen erstellen und dann auf den Bearbeiten-Button [image: edit] klicken.


	Click the Add button to generate a new secret URL.


	You can now copy this URL and put it into an email to send to somebody.


	You can click on the Edit button [image: edit] to add a time restriction for access to your page / portfolio via this URL and then click the Save button.


	Click on the Delete button [image: remove] if you do not want to use this secret URL anymore.


	Click on the Add button to generate another secret URL for this page to which you can assign different time restrictions.





[image: Add a secret URL]
Eine oder mehrere Geheime URLS für eine Ansicht oder Sammlung hinzufügen




Bemerkung

Logged-out users or those who do not have an account can only leave comments on public pages or pages which they can access via a secret URL if the site administrator turned on the Anonymous Comments function under Site Administration -> Configure Site -> User Settings.









          

      

      

    

  

    
      
          
            
  
4.5. Export

You can export your portfolio to keep your files and Mahara-created content offline. You have two options for the export. Both are downloaded as zip file which you can then uncompress in the case of the HTML web site:


	HTML web site: A self-contained web site with your portfolio data is created. You cannot import this into Mahara or another portfolio system again, but it is readable in a standard web browser and you do not need a Mahara in order to view it.


	Leap2A: Eine Zip-Datei mit einem Ordner im Leap2A Standardformat [http://wiki.leapspecs.org/2A/specification] wird erstellt. Sie können diese Datei Leap2A kompatiblen System [https://wiki.mahara.org/index.php/Developer_Area/Import//Export/Interoperability] oder lassen die Administration es in Ihr derzeitiges oder ein anderes Mahara importieren. Beim Importprozess wird ein neuer Nutzer für das Portfolio erstellt.





Bemerkung

Wir empfehlen, dass Sie Ihr Portfolio in beiden Formaten (HTML und Leap2A) exportieren, da Sie nie wissen, ob Sie es später zurück nach Mahara oder in ein anderes ePortfoliosystem importieren wollen.



To export your portfolio:


	Go to Portfolio -> Export.


	Choose either Standalone HTML Website or Leap2A. You can run through the export twice in order to get both formats.


	Wählen Sie, was Sie exportieren wollen:


	All my data: Everything that is stored in your account in Content and Portfolio. Excluded are any group contributions.


	Just some of my pages: You can then choose which pages and the artefacts that go with it you want to export.


	Just some of my collections: You can select which collections and their artefacts you want to export.






	If you have chosen to just export some pages or collections, you can select them here. You may also preview a page first.


	Klicken Sie auf den Export erzeugen-Button, um den Exportprozess zu starten.





[image: ../_images/export_options.png]


Abhängig von der Größe Ihres Portfolios kann der Export einige Zeit in Anspruch nehmen. Nachdem alles verarbeitet ist, wird eine Datei automatisch heruntergeladen oder Ihnen zum Abspeichern angeboten. Dies ist von Ihrem Browsereinstellungen abhängig.


Bemerkung

If your export gets stuck in the process and the progress bar does not move along at all, your server settings may prevent long operations to avoid slowing down. You will need to contact your site administrator, e.g. via the „Contact Us“ form in the footer of your Mahara instance.







          

      

      

    

  

    
      
          
            
  
4.6. Feedback

Feedback geben ist ein zentraler Teil der Portfolioarbeit. Sie können zu einzelnen Artefakten und zu ganzen Portfolios Feedback geben.

Autor/innen einer Datei oder einer Portfolioansicht legen fest, ob Kommentare hinterlegt werden können oder nicht. Die Kommentaroption für Dateien findet man beim Upload oder Bearbeiten einer Datei und für Ansichten in den Erweiterten Optionen.

Wenn die/der Autor/in einer Ansicht erlaubt, können Sie Feedback zu den Ansichten oder Artefakten hinterlegen zu denen Sie Zugang haben.


[image: Provide feedback]
Feedback zur Verfügung stellen




	Klicken Sie auf den Feedback hinterlegen-Link am Fuß der Portfolioansicht oder den Details einer Ansicht oder eines Artefakts zu dem Sie ein Feedback abgeben möchten.


	Tragen Sie Ihr Feedback im Editorfenster ein.


	Wenn die Site-Administration die Kommentarbewertung aktiviert hat, können Sie auf einer 5-Sterne-Skala zusätzlich Feedback zu Ihrem geschriebenen Kommentar und / oder Dateiupload vergeben.


	Aktivieren Sie die Öffentlich machen-Checkbox, damit jeder, der Zugriff auf Ihre Ansicht hat, die abgegebenen Kommentare sehen kann. Wenn Sie Ihren Kommentar nicht öffentlich machen, können nur Sie selber und die Autoren der Ansicht Ihren Kommentar sehen.


	Click the Browse button to attach a feedback file from your computer. This file is place into the files area of the author of the page.


	Klicken Sie auf den Feedback abgeben-Button, um Ihr Feedback zur Ansicht abzuspeichern.


	Klicken Sie auf den Abbrechen-Button, um Ihre Änderungen abzubrechen.


	Wenn Sie ein Feedback zu einer Ansicht abgegeben haben, erhält der Autor darüber einen Benachrichtigung.





Bemerkung

Feedbackschreiber erhalten keine Benachrichtigungen wenn andere Kommentare abgegeben werden.






4.7. Feedback als Bewertung


4.7.1. Eine Ansicht zur Bewertung einreichen

Als Mitglied einer kontrollierten Kursgruppe können Sie Portfolioansichten für ein Feedback /eine Bewertung einreichen. Der Inhalt wird dann zunächst gesperrt.


[image: Submit a page to a course controlled group]
Submit a page to a course controlled group




	Gehen Sie zur Gruppenstartseite in der Sie eine Ansicht einreichen wollen und wählen Sie diese mit dem Drop-down-Menü unter Eine Ansicht in dieser Gruppe einreichen.


	Klicken Sie auf den Einreichen-Button, um den Inhalt zu sperren.




Es ist nicht notwendig, den Gruppenmitgliedern Zugriff auf Ihre Ansicht zu geben. Wenn Sie Ihre Ansicht einreichen, können Gruppenadministrator/innen und Tutor/innen Ihre Ansicht sehen und Ihnen Feedback geben. Andere Gruppenmitglieder sehen Ihre Ansicht nicht.

Während der Feedbackphase können Sie keinen Änderungen vornehmen an


	Dateien


	Blogeinträge


	Textfeldern


	Links auf externen Inhalt




Sie können weiterhin bearbeiten


	Pläne


	Profilinformationen


	Biografieinformationen







4.7.2. Feedback von Bewertern (instructors)

Wenn eine Ansicht in einer kontrollierten Kursgruppe zum Feedback eingereicht ist, kann ein Feedback erstellt werden, ohne dass der Einreicher in der Zwischenzeit wesentliche Teile der Ansicht verändern kann. Alle eingereichten Ansichten werden über die Gruppenstartseite angezeigt und mit einem Zeitstempel versehen.


[image: Submitted page with time stamp]
Submitted page with time stamp



Sie können nun zu dieser Ansicht Feedback geben und dann auf den Ansicht freigeben-Button klicken, so dass der Verfasser weiter an dieser Ansicht arbeiten kann.







          

      

      

    

  

    
      
          
            
  
4.8. Schlagworte

Schlagworte sind Schlüsselbegriffe, die Sie für Artefakte und Ansichten vergeben können, um diese einfacher wieder auffinden zu können.


Bemerkung

Die Site-Administration muss die Schlagwortwolke für Sie aktiviert haben.




4.8.1. Schlagwort-Wolke

Sie können Ihre Schlagwort-Wolke an der Seite in den Bereichen Inhalt und Portfolio sehen. Legen Sie fest wie viele Schlagworte in Ihrer Schlagwort-Wolke angezeigt werden sollen unter Accounteinstellungen.


[image: Tag cloud]
Schlagwort-Wolke




	Klicken Sie auf die Schlagwort-Überschrift um auf Alle meine Schlagworte zuzugreifen.


	Klicken Sie auf ein Schlagwort, um alle Artefakte und Ansichten in Ihrem Portfolio zu sehen, die mit diesem Schlagwort verknüpft sind.





Bemerkung

Je häufiger ein Schlagwort für Ihre Dateien, Blogeinträge und Ansichten verwandt wurde, desto größer wird der Begriff in der Schlagwortwolke angezeigt.






4.8.2. Meine Schlagworte

Auf der Meine Schlagworte-Seite  sehen Sie alle Ihre Schlagworte mit den verknüpften Artefakten und Ansichten. Sie haben verschiedene Filteroptionen, um nur die gesuchten Objekte zu sehen.


[image: My tags overview page]
Übersicht über meine Tags




	The default view is to sort your tags alphabetically. Capitalised tags are treated before non-capitalised tags.


	Sie können die Liste auch nach Häufigkeit der Nutzung sorteren.


	Sie können auf jedes Schlagwort klicken und sich nur die Artefakte und Ansichten anzeigen lassen, die zugeordnet sind. Die Zahl in Klammern zeigt Ihnen wie häufig das Schlagwort für Ihre Objekte genutzt wurde.


	Der gesuchte Begriff wird nochmals angezeigt.


	Sie können die Ergebnisse der Suche nach Titel oder Datum sortieren.


	Sie können die Suche nach spezifischen Artefakttypen oder Portfolioansichten filtern.


	Der Titel des Objekts, die Beschreibung und weitere eingetragene Schlagworte werden angezeigt.


	Das Erstelldatum und -zeit, sowie der Objekttyp werden angezeigt.


	Klicken Sie auf den Schlagworte bearbeiten-Button, um Änderungen an Ihren Schlagworten vorzunehmen.







4.8.3. Schlagworte bearbeiten

Sie können in Ihren Schlagworten Tippfehler korrigieren oder ein Schlagwort löschen.


[image: Edit your tags]
Bearbeiten Sie Ihre Tags




	Wählen Sie das Schlagwort, das Sie bearbeiten wollen.


	Nachdem Sie das Schlagwort ausgewählt haben, wird es in der Liste fett hervorgehoben und zwei weitere Felder erscheinen. Sie können unter Name eine Änderung des Begriffs vornehmen.


	Klicken Sie auf den Absenden-Button, um die Änderungen zu speichern


	Alternativ klicken Sie auf den Löschen-Button, um das Schlagwort zu löschen.


	Sie können auch auf den Meine Schlagworte-Button  klicken, um zur Übersichtsseite mit allen Schlagworten und zugeordneten Objekten zurückzukehren.










          

      

      

    

  

    
      
          
            
  
5. Gruppen



	5.1. Meine Gruppen

	5.2. Gruppen finden

	5.3. Eine Gruppe anlegen
	5.3.1. Create a group as a user, staff or institution admin

	5.3.2. Als Site-Administrator/in eine Gruppe anlegen

	5.3.3. Generelle Gruppeneinstellungen bearbeiten





	5.4. Innerhalb einer Gruppe
	5.4.1. Gruppenstartseite

	5.4.2. Mitglieder

	5.4.3. Foren
	5.4.3.1. Ein neues Forum anlegen

	5.4.3.2. Ein Forenthema hinzufügen

	5.4.3.3. Antwort auf ein Thema oder einen Beitrag darin

	5.4.3.4. Einen Beitrag, ein Thema oder ein Forum löschen

	5.4.3.5. Mehrfachaktionen (bulk) im Forum





	5.4.4. Ansichten
	5.4.4.1. Gruppenstartseite

	5.4.4.2. Reguläre Gruppenansichten





	5.4.5. Dateien
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Groups in Mahara can be used for collaboration among users as they offer the possibilities to


	Themen in Foren diskutieren


	Ansichten gemeinsam erstellen und bearbeiten


	Dateien austauschen


	Ansichten miteinander teilen


	submit pages for assessment





Bemerkung

Groups can be created by every user, staff or administrators only. The site administrator decides that in Site Administration -> Configure Site -> Group Settings.



Das Gruppen-Menü hat folgende Untermenüs.


	My Groups: Displays the groups that you administer or in which you are a member. You can create new groups from here if you have the appropriate rights.


	Find Groups: Lists all groups in the system and allows you to join or request membership in them if groups allow that.


	My Friends: Displays your friends and gives you easy access to their profile pages.


	Find Friends: Search for users in Mahara that you may wish to add to your friends list.


	Shared Pages: Lists the pages that were shared with you directly, with you as a friend or member of a group.


	Themen: Zeigt die letzten Diskussionsthemen in Ihren Gruppen.








          

      

      

    

  

    
      
          
            
  
5.1. Meine Gruppen

Die Seite zeigt Ihnen die Gruppen mit denen Sie in irgendeiner Beziehung stehen. Sie sehen Gruppen in denen Sie Mitglied sind, zu denen Sie eingeladen wurden oder bei denen Sie eine Mitgliedsanfrage gestellt haben.

If your site administrator allowed you to create groups yourself, you see the Create Group button.


[image: My Groups overview page]
The My Groups page lists all your groups




	Choose the filter you wish to apply to view only a subset of your groups and then click the Filter button. You can filter for:


	Alle Ihre Gruppen


	Gruppen mit denen Sie in Verbindung stehen


	Gruppen in denen Sie Mitglied sind


	Gruppen zu denen Sie eingeladen wurden


	Gruppen bei denen Sie die Mitgliedschaft beantragt haben






	Click the Create Group button when you want to set up a new group.


	If you are a member of a controlled membership group, you cannot leave the group. You can leave other groups that are not controlled at any time.


	Click the Accept or Decline button to join an invite group or to decline membership in that group.


	Click the Edit button when you want to update the details for your group. Click the Delete button only when you want to delete your group permanently.




In addition to the filter options above, you can filter for group categories if the site administrator allowed them and had them set up.


[image: Filter according to a group category]
Filter your search results according to a group category




Warnung

When you delete a group, all its content and contributions from users are gone and cannot be retrieved again.







          

      

      

    

  

    
      
          
            
  
5.2. Gruppen finden

You see all groups that exist on Mahara and get basic information about the groups.


[image: List of all groups on Mahara]
A list of all groups on Mahara and certain actions you can perform




	Search for a certain group using a word from the title or description. You can search either all groups, groups you are a member of or groups you are not in.


	If you want to become a member of an open group, click the Join this group button and you will be a member immediately.


	Wenn Sie zu einer Gruppe eingeladen wurden, klicken Sie auf Bestätigen oder Ablehnen.


	If you want to join a group that needs the approval of the group administrator first, click the Request to join this group button next to the group.


	You can also find out more about a group by


	clicking on the group name to see the group homepage


	clicking on the name of the group administrator to get to his profile page


	clicking on the member link to see who is already a member of this group








In addition to the filter options above, you can filter for group categories if the site administrator allowed them and had them set up.


[image: Filter according to a group category]
Filter your search results according to a group category




Bemerkung

Meistens sehen Sie Foren, Gruppenansichten und Gruppendateien nur wenn Sie Mitglied einer Gruppe geworden sind. Falls eine Gruppe öffentlich ist, sehen Sie auch die Forendiskussionen.







          

      

      

    

  

    
      
          
            
  
5.3. Eine Gruppe anlegen

You can create a number of different groups depending on your role on Mahara.


	All user roles



	Offene Mitgliedschaft: Jede/r Nutzer/in der Site kann durch Aufruf der Gruppenseite und Anklicken des Beitreten-Buttons Mitglied werden.


	Mitgliedschaft beantragen: Jede/r Nutzer/in kann die Mitgliedschaft in Ihrer Gruppe beantragen. Als Gruppeneigner können Sie diese akzeptieren oder zurückweisen. Die beantragende Person wird über Ihre Entscheidung automatisch informiert.


	Invite only: Only users that you explicitely invite may join your group. They can accept or decline your invitation.









	Staff and administrators



	Standard controlled membership



	Sie können Nutzer/innen direkt zu Ihrer Gruppe hinzufügen.


	Die Mitglieder können sich nicht aus der Gruppe austragen.









	Course controlled membership



	Sie können Nutzer/innen direkt zu Ihrer Gruppe hinzufügen.


	Die Mitglieder können sich nicht aus der Gruppe austragen.


	You can assign tutors to the group. They can only add new members.


	Group members can submit portfolio pages for feedback / assessment. These pages are locked until released by an admin or tutor.









	Course request membership



	Any user can request to join your group. However, as owner you can choose to accept or decline this request.


	The members can leave this group.


	You can assign tutors to the group. They can only add new members.


	Group members can submit portfolio pages for feedback / assessment. These pages are locked until released by an admin or tutor.


	This group is designed to be used for a course-based group where the membership is defined by an external system (such as an institution’s enrolment system) and you wish to replicate that membership in the group. However, you can also set up this group manually.



















Bemerkung

Site-Administrator/innen können das Erstellen von Gruppen auf Nutzer/innen mit Mitarbeiter- und oder Administrationsrechten beschränken. Falls Sie keine Gruppe anlegen können, haben Sie nicht die erforderlichen Berechtigungen und sollten Kontakt mit der Site-Administration über das Kontaktformular aufnehmen, um abzustimmen wie Sie Gruppen anlegen können.




5.3.1. Create a group as a user, staff or institution admin

If you are allowed to create a group, you see the Create Group button on the My Groups overview page.


[image: Create a group as a regular user]
Eine Gruppe als Nutzer/in anlegen




	Click the Create Group button on Groups -> My Groups.


	Group name: Provide a name for your group. You must fill in this field.


	Gruppenbeschreibung: Kurzbeschreibung wozu die Gruppe angelegt wird.


	Group type: Choose a type for your group. For descriptions of the types and what user role can create which group type, see above.


	Group category: Choose a category if you want to associate your group to one, allowing you to filter groups on the My Groups and Find Groups page. This setting is only available if the site administrator turned it on.


	Publicly viewable group? Choose this option if anybody shall have access to this group. You only see this setting if the site administrator allowed you to have it. Anybody can see the group homepage, the members and the discussion forum. Only members of the groups can see the group’s pages, unless they have been made public, and the files area.


	Shared page notification: This check box has a check mark per default. Whenever somebody shares a page with the group, all group members get an email. You may want to uncheck this setting in very large groups where lots of pages get shared but members do not have to be notified.


	Click the Save Group button to finish creating your group, or click the Cancel button to abort the group creation process.





Bemerkung

Der Name der Gruppe muß nicht einmalig sein. Andere Gruppen können den gleichen Namen haben. Um die Gruppe eindeutig zu unterscheiden ist die Beschreibung sehr hilfreich.






5.3.2. Als Site-Administrator/in eine Gruppe anlegen

When you have site admin rights, you have an additional setting when you create a group: You can choose to add new users to a group automatically. That way, any new user who creates an account after the group is created becomes a member of this group.


[image: Users auto-add option for site admins]
Add users to a group automatically.




Bemerkung

Damit können Sie eine Community-Gruppe, in der alle Nutzer/innen eingebunden sind, aufbauen. Auf mahara.org [http://mahara.org] wird dies genutzt, um jeden in die „Community“-Gruppe zu integrieren, wo Diskussionen rund um Mahara stattfinden.

All other group settings still apply.






5.3.3. Generelle Gruppeneinstellungen bearbeiten

Sie können die Einstellungen für Ihre Gruppe von drei Stellen aus beginnen indem Sie den Bearbeiten-Button verwenden:


	My Groups overview page


	Find Groups page


	Die Gruppen-Startseite




Von allen drei Orten kommen Sie zum gleichen Bildschirm wie beim Anlegen einer Gruppe und können hier alle vorgesehenen Änderungen vornehmen.


Warnung

You can change the group type to a different one. Please be careful if you do so especially from a controlled course group. If users have submitted portfolio pages to that group, they remain locked eve when you change the group type.









          

      

      

    

  

    
      
          
            
  
5.4. Innerhalb einer Gruppe


Bemerkung

Der Zugriff und die Möglichkeit, Einstellungen zu ändern, die Sie in dem Screenshot sehen, sind von Ihrer Rolle in der Gruppe abhängig.




5.4.1. Gruppenstartseite

The group homepage is the central space for a group. There you can get a quick overview of the group and reach all the places that you wish to take a look at in a group. You see a few things per default on the group homepage.


[image: Group homepage]
Group homepage for an „Invite only“ group




	Gruppenname


	If you are a member in the group, you see your status and whether you can leave the group or not. If you are an admin of the group, you see the Edit and Delete buttons.


	Group navigation


	Grundinformationen über diese Gruppe


	Group administrators so that you can contact them easily


	Gruppentyp


	Datum der Gruppenerstellung


	statistics on the number of group members, pages, files and folders






	Letzte Forenbeiträge und Link zum Forum


	Group members and a link to the full list




Wenn Sie ein/e Gruppenadministrator/in sind, können Sie weitere Blöcke zur Gruppenstartseite hinzufügen. Rufen Sie Blöcke im Ansichten-Kontext für eine Liste auf.




5.4.2. Mitglieder

Auf der Gruppenmitgliederseite kann ein/e Gruppenadministrator/in


	invite multiple users to the group at once or add multiple users in bulk if it is a invite or controlled membership group.


	search for group members


	view basic information about group members like



	ihren Namen


	ihre Rolle


	their profile introduction


	den Eintrittstermin in die Gruppe









	change the role of a user


	remove a user from the group





[image: Group members page]
Gruppenmitgliederseite ansehen, wie sie von einem Gruppenadministrator gesehen wird.



If you are not a group admin, you are not able to invite or add people from the members page and you cannot change the role or remove a user from a group.




5.4.3. Foren

The forums are visible to all group members. If you created a public group, anybody online would be able to see the forum discussions. However, they would need to log in to participate. Forums in public groups receive an RSS feed so that users can subscribe to them, e.g. the mahara.org community forums [http://mahara.org/interaction/forum/index.php?group=1].


[image: Group forum]
Übersicht der Gruppenforen




	Mit den entsprechenden Rechten können Sie ein neues Forum durch einen Klick auf den Neues Forum-Button erstellen.


	Name und Kurzbeschreibung des Forums


	Forenadministrator/innen und Moderator/innen (wenn gewünscht)


	Anzahl der Forenthemen


	Eintragen / Abbestellen-Button, falls der Forenadministrator/in dies vorsieht. Die eingetragenen Nutzer/innen erhalten dann Mail-Benachrichtigungen aus den Foren.


	Edit button [image: edit] for making changes to the forum settings for group admins and moderators
Delete button [image: delete] for making changes to the forum settings for group admins and moderators





5.4.3.1. Ein neues Forum anlegen

Gruppenadministrator/innen können Foren in Gruppen anlegen.


[image: Add a forum to a group]
Basic set up of a forum




	Klicken Sie auf den Neues Forum-Button, um ein neues Forum anzulegen.


	Titel: Geben Sie dem Forum einen Titel.


	Beschreibung: Schreiben Sie eine kurze Beschreibung zu dem Forum. Diese erscheint unter dem Forums-Tab und macht es den Nutzern einfacher, zu entscheiden, ob das Forum für sie interessant ist oder nicht.


	Forenmodus: Legen Sie fest wie die Themen in dem Forum dargestellt (eingerückt) werden sollen.


	Ganz aufklappen: Antworten werden leicht eingerückt. Damit wird schnell klar wer wem geantwortet hat. Die Zahl der Einrückungsebenen ist nicht begrenzt.


	Expand to max: Indentation to indicate the replies to individual post specifying the maximum level of indentation (pops up once this option is chosen). All replies beyond the chosen level are not indented further.


	Keine Einrückungen: Die Antworten werden nicht eingerückt. Die Forenstruktur bleibt ‚flach‘.






	Klicken Sie auf den Speichern-Button, um diese Änderungen zu übernehmen oder nehmen Sie weitere Einstellungen vor.




Über die Basiseinstellungen hinaus kann ein/e Administrator/in weitere Entscheidungen treffen.


[image: Choose further settings in the forum]
Wählen Sie weitere Einstellungen im Forum




	Automatically subscribe users? Choose whether group users will be subscribed to this forum automatically. When subscribed, users will receive notifications when new posts and replies are made in the forum. Users will have the option to unsubscribe if they do not want to be notified.


	Reihenfolge: Foren werden zunächst in der Reihenfolge ihrer Erstellung dargestellt. Hier können Sie die Reihenfolge individuell anpassen. Klicken Sie den Radiobutton über oder unter einem Forum, um das Forum dort zu platzieren.


	Moderator/innen: Wählen Sie einen oder mehrere Moderator/innen für das Forum. Sie können Themen bearbeiten oder löschen, öffnen und schließen oder Themen markieren (festkleben). Damit haben Sie eng begrenzte Administrationsfunktionen.


	Wählen Sie einen oder mehrere Nutzer/innen aus der Liste potenzielle Moderator/innen links oder suchen Sie eine Person.


	Klicken Sie auf den Pfeil nach rechts-Button [image: right-arrow], um den/die Nutzer(innen) zur Liste derzeitiger Moderator/innen hinzuzufügen.


	Um Moderator/innen zu entfernen wählen Sie diese in der Liste derzeitiger Moderator/innen rechts und klicken Sie auf den Pfeil nach links-Button  [image: left-arrow] .






	Who can create topics: Decide who in your group is allowed to create topics within a forum. If set to „All group members“, any group member can create new topics and reply to existing topics. If set to „Moderators and group admins“, only moderators and group administrators can start new topics, but once topics exist, all users can post replies to them.


	Neue Themen schließen: Diese Option führt dazu, dass neue Themen im Forum automatisch geschlossen werden. Mitglieder können auf geschlossene Themen nicht antworten. Nur Moderator/innen und Gruppenadministrator/innen können darin noch Antworten verfassen. Diese Option kann genutzt werden, um in einem Forum nur Ankündigungen vorzunehmen auf die nicht geantwortet werden soll.


	Klicken Sie auf den Speichern-Button wenn Sie alle Einstellungen vorgenommen haben oder auf Abbrechen.







5.4.3.2. Ein Forenthema hinzufügen

Wenn Sie die Berechtigung zum Anlegen neuer Forenthemen besitzen, sehen Sie den Button Neues Thema.


[image: Admin screen when in the forum topic list]
Add a new topic to a forum.




Bemerkung

Administrator/innen können jederzeit Änderungen an den Foreneinstellungen vornehmen. Dazu stehen die Buttons Forum bearbeiten und Forum löschen zur Verfügung.




	Subject: Type the concise description of what you wish to discuss in this forum thread.


	Body: Elaborate on the topic.


	‚Angeklebte‘ Themen: Einstellung für Administrator/innen, um ein Thema immer oben in der Forendarstellung festzuhalten.  Forenbeiträge werden sonst chronologisch angeordnet.


	Geschlossene Themen: Einstellung für Administrator/innen, um andere daran zu hindern, auf diesen Beitrag zu antworten. Moderator/innen und Administrator/innen können danach noch Antworten verfassen.


	Klicken Sie auf den Beitrag absenden-Button, um den Diskussionsbeitrag zu veröffentlichen oder wählen Sie Abbrechen.





Bemerkung

Wenn Sie Ihren Foreneintrag erstellen oder an irgendeiner anderen Stelle einen Beitrag einstellen, so können Sie mit Hilfe des Editors den Text formatieren (wenn der Editor aktiviert ist). Sie können zusätzlich Bilder in den Beitrag einfügen. Vermeiden Sie es, die URLs von Bildern aus Ihrem Dateibereich einzukopieren. Die Anzeige von Bildern im Dateiablagebereich ist geschützt. Wenn Sie einen Link auf diese Bilder setzen, wird Ihnen das Bild angezeigt. Andere Nutzer/innen werden es nicht sehen, da sie keine Zugriffsberechtigung auf Ihre Dateiablage haben. Wenn das Bild in Ansichten verwendet wird und Sie diese Ansicht für andere freigegeben haben, werden diese Personen das Bild auch im Forum sehen können, da sie über die Ansicht eine Zugriffsberechtigung erhalten haben.

In einigen Gruppen kann es erlaubt sein, Dateien in der Gruppe hochzuladen, damit jedes Mitglied sie sehen kann. Sie können dieses Bild verlinken. Es kann jedoch auch von jedem Gruppenmitglied gelöscht werden und wird im Forum nicht mehr angezeigt.



Once you have finished writing your forum topic, it is displayed in the list of forum topics. Others can see it immediately. The administrator and moderator of the forum can edit or delete a topic. Regular members cannot do so.


[image: First post in a forum topic]
First post in a forum topic




	Der Titel des Forums


	Der Titel eines Forenthemas


	Das Profilbild und der Name der Person, die einen Beitrag verfasst hat. Der Name ist mit dem Profil der Person verlinkt.


	Anzahl der Beiträge dieser Person in allen Gruppen


	Datum und Zeitpunkt der Erstellung des Beitrags


	Der Beitrag selber


	Der Antworten-Button, um auf den Beitrag zu antworten







5.4.3.3. Antwort auf ein Thema oder einen Beitrag darin

Everybody can reply to a forum topic or other posts therein unless the moderator or administrator had closed the topic. The replies are intended to make it easier to see to which comment you replies except in forum topics that do not use indentation.


[image: reply to a forum post]
Auf einen Forumseintrag antworten




	Klicken Sie auf den Antworten-Button unter dem Forenbeitragstext auf den Sie antworten wollen. Der Beitrag auf den Sie antworten wollen wird beim Antwortfenster angezeigt, damit Sie sich leichter auf ihn beziehen könnne.


	Set a different subject if you want to by clicking on Click to set a subject. This is most often not necessary and usually only used if the topic evolves into a different discussion. However, in such cases, a new forum topic should be opened.


	Write your comment.


	Klicken Sie auf den Veröffentlichen-Button, um Ihre Antworten zu speichern oder wählen Sie Abbrechen





Bemerkung

Nachdem Sie Ihren Beitrag gespeichert haben, können Sie für einige Zeit noch Veränderungen vornehmen. Danach wird der Beitrag an die anderen Leser des Forums versandt. Die Dauer, in der Sie noch Veränderungen vornehmen können, wird in den Foreneinstellungen Forenbeitrag Versandverzögerung festgelegt.  So lange Sie den Beitrag noch bearbeiten können, sehen Sie den Bearbeiten-Button. Im Bearbeiten-Fenster wird angezeigt wieviel Zeit bis zum Versand verbleibt.

[image: edit-post]

Wenn Sie, aber auch Moderator/innen und Administrator/innen Beiträge nach dieser Zeit verändern, wird unter „Bearbeitungen des Beitrags“ angezeigt wer wann eine Änderung vorgenommen hat.






5.4.3.4. Einen Beitrag, ein Thema oder ein Forum löschen

Administrator/innen und Moderator/innen haben jederzeit die Möglichkeit, einzelne Forenbeiträge, ein Forenthema oder ein Forum  zu bearbeiten oder zu löschen.


Warnung

Wenn ein Forenbeitrag, ein Forenthema oder ein Forum gelöscht wurde, kann dieser Vorgang nicht rückgängig gemacht werden. Der Inhalt ist verloren.






5.4.3.5. Mehrfachaktionen (bulk) im Forum

Gruppen- und Forenadministrator/innen können mehrere Aktionen auf einmal für Foren einer Gruppe ausführen.


[image: Forum bulk actions]
Mehrfachaktionen (bulk) im Forum




	Wählen Sie Themen mit denen Sie die gleiche Aktion ausführen wollen.


	Im Drop-down-Menu finden Sie die ausführbaren Aktionen.


	Angeklebte Themen: Die Themen bleiben in der Themenliste immer oben


	Normale Themen: Die Themen werden wieder in die chronologische Reihenfolge eingefügt.


	Geschlossene Themen: Nur Gruppenadministrator/innen und Forenmoderator/innen können künftig zu diesen Themen Beiträge verfassen.


	GeöffneteThemen: Jeder kann wieder zu diesen Themen Beiträge verfassen.






	Klicken Sie auf den Status ausgewählter Diskussionsthemen ändern-Button, um die Änderungen zu speichern.









5.4.4. Ansichten

Mitglieder einer Gruppe haben Zugriff auf geteilte Ansichten. Das können sein:


	Ansichten, die in der Gruppe erstellt wurden.


	Anischten, die mit der Gruppe geteilt wurden




Letzteres sind Ansichten, den ein/e Nutzer/in von den persönlichen Ansichten der Gruppe mittels Mit der Gruppe teilen verfügbar gemacht hat. Gruppenmitglieder können diese Ansichten nicht bearbeiten.

Depending on the group type, either only administrators or also regular group members can create and edit group pages.


Warnung

Jede/r, der eine Gruppenansicht bearbeiten kann, kann Blöcke zur Ansicht hinzufügen oder löschen. Die Veränderungen werden nicht dokumentiert. Das gemeinsame Erstellen von Gruppenansichten erfordert das Vertrauen der Gruppenmitglieder untereinander. Als Alternative steht das Teilen von zuvor individuell erstellten Ansichten zur Verfügung.




5.4.4.1. Gruppenstartseite

The group homepage can only be edited by the group administrator. It contains a number of default blocks. You can add more blocks to it to customize the page for the group. Please refer to the overview of blocks for a list of all the blocks that you can use in the group homepage.




5.4.4.2. Reguläre Gruppenansichten

Erstellen, bearbeiten und teilen einer Gruppenansicht ist dem Erstellen, Bearbeiten und Portfolioseite teilen sehr ähnlich. In verschiedenen Kontexten stehen unterschiedliche Blöcke zur Verfügung.  Daher sind nicht alle Blöcke bei der Bearbeitung einer Gruppenansicht im Ansichteneditor verfügbar. Der Überblick über Blöcke zeigt Ihnen alle Blöcke, die Sie für eine Gruppenansicht verwenden können.


Siehe auch

For submitting a page to a group to receive instructor feedback, please refer to the feedback section.








5.4.5. Dateien

The files area in a group holds all files that are uploaded by group members who have the permission to do so. The uploading process works as the one in the personal files.

Im Unterschied zur persönlichen Dateiablage gibt es zusätzliche Berechtigungseinstellungen:


[image: group file permissions]
Berechtigungen für eine Gruppendatei einrichten



When you have the permission to upload a file, you can also determine additional permissions of who can view the file and edit its metadata. An administrator has all rights, but you can restrict them to regular group members or tutors in a course group.


	Anzeigen: die Datei im Gruppendateibereich sehen und in Ansichten integrieren.


	Bearbeiten: Sie können Dateinamen, Beschreibung, Schlagwörter und Berechtigungen bearbeiten.


	Veröffentlichen: Gruppendateien in persönliche Portfolioansichten integrieren.










          

      

      

    

  

    
      
          
            
  
5.5. Meine Kontakte

Your friends are special group on Mahara. You can share your portfolio pages easily with them and get in touch with them quickly by going to this page. They differ from a regular group in that they do not have discussion forums, pages or share files. If you do wish to do that with your friends, you have to create a regular group for them.

Sie können auf verschiedenen Wegen Kontakte zu anderen Nutzer/innen knüpfen:


	Gehen Sie zur Profilseite und klicken Sie auf den Kontaktanfrage senden-Link.


	Gehen Sie zur Kontakte finden-Seite und Suchen Sie potenzielle Kontakte hier.





[image: My Friends page]
„My friends“ page




	Wenn Sie bereits eine Reihe Kontakte und offene Kontaktanfrage haben, können Sie diese nach den Kriterien derzeitige und angefragte Kontakte filtern.


	Klicken Sie auf den Namen des Kontakts, um die Profilseite aufzurufen.


	If a friend is in the pending state, approve or deny the request.


	Send a message to the friend if you wish to do so.


	Wenn Sie einen Kontakt nicht mehr auf Ihrer Kontaktliste führen wollen, so können Sie diesen mit dem von Kontaktliste entfernen-Link entfernen.


	If you are a group administrator in a group that one of your friends belongs to, you can edit his group membership here as well.








          

      

      

    

  

    
      
          
            
  
5.6. Kontakte finden

If you want to establish your social network on Mahara, you can use the Find friends page to find people to connect to. An alphabetical list of all users on the system is provided.


[image: Find friends page]
„Find friends“ page




	Use the search box to search for a name.


	All results are listed. You can click on the name to view that user’s profile page.


	You find more information about this user and can take more actions:


	The name of the institution of which he is a member


	Send this user a message without requesting friendship


	Send this user a friend request









Bemerkung

You can prevent others from sending you messages or friend requests if you disabled these in your account settings.




5.6.1. Kontaktanfrage senden

You send a friend request from the Find friends page by clicking on the Send Friend Request! link next to the user you want to be friends with.


[image: Send friend request]
Kontaktanfrage absenden




	Give a reason why want to request friendship of this user. This reason can be important if the other person does not know you well, and thus may likely reject your request.


	Klicken Sie nun auf den Kontaktanfrage versenden-Button, um die Anfrage zu versenden, oder auf den Abbrechen-Button, um den Vorgang abzubrechen.







5.6.2. Kontaktanfrage annehmen

Wenn ein/e andere/r Nutzer/in Ihnen eine Kontaktanfrage zugesandt hat, erhalten Sie eine Benachrichtigung in die Eingangsbox.


[image: Pending friend request]
Ausstehende Freundschaftsanfrage



Mit dem Anklicken der Kontaktanfrage gelangen Sie auf die Seite Meine Kontakte. Hier werden Ihnen alle offenen Kontaktanfragen angezeigt.


[image: Page with all pending friend requests]
Alle ausstehenden Freundschaftsanfragen anzeigen




	View the name of the person requesting friendship and a short desciption if one had been written. You can click on the name and see the profile page.


	Read the reason why this user requests friendship.


	Click the Approve Request! link to approve the friend request. Once you approved a friend request, you appear immediately on that user’s My friends page and the user on yours.


	Click the Deny Request link to deny friendship.


	Click the Send message button to communicate with the user before making your decision about the friend request.







5.6.3. Kontaktanfrage ablehnen

Wenn Ihnen jemand eine Kontaktanfrage gesendet hat, gehen Sie zur Meine Kontakte-Seite und schauen Sie auf die unbestätigten Kontaktanfragen.


	Next to the person whose request you wish to deny, click the Deny Request link.


	Wenn Sie dies begründen wollen, geben Sie einen Grund für die Ablehnung an.


	Click the Deny friend request button to send you message off or click the Cancel button to abort your action.


	The user receives a notification that includes your reason for denial.










          

      

      

    

  

    
      
          
            
  
5.7. Freigegebene Ansichten

This page lists the most recently modified or commented on pages that have been shared with:


	Ihnen direkt


	Ihnen als Kontakt


	Ihnen als Gruppenmitglied




Not displayed are pages that have only been shared with:


	the public


	alle eingeloggten Nutzer




That means, if a page has been shared with all logged-in users and in addition with you, you see the page on your shared pages. Otherwise, it does not appear here.

The shared pages are a quick way to find the pages that you may be most interested in looked at.

Sie können in dieser Ansicht nichts hinzufügen oder löschen.  Sie haben nur Lesezugriff.


[image: Shared pages list]
„Shared pages“ list




	You can filter the pages that have been shared with you by title, desctiption and tags or by tags only.


	The title and author of the page are linked so that you can jump to them quickly.


	The description of the page as well as the tags are displayed.


	Sie sehen die Anzahl der Kommentare zu jeder Ansicht


	Den Anfang des letzten Kommentars, seinen Autor und das Datum der Erstellung.


	By clicking on the View comment button you can read the entire comment.








          

      

      

    

  

    
      
          
            
  
5.8. Diskussionsthemen

(Diskussions-)Themen ist eine Liste der Diskussionsthemen aller Gruppen in denen Sie Mitglied sind. Die Themen sind umgedreht chronologisch sortiert beginnend mit dem aktuellsten Thema.


[image: Latest posts in discussion forums]
Die neuesten Einträge in den Diskussionsforen




	Es werden der Titel des Forenthemas, die Gruppe in der das Forum steht und der Name des Forums angezeigt. Alle sind direkt verlinkt, um sie gleich aufrufen zu können.


	Die Anzahl der Beiträge in diesem Diskussionsthema wird angezeigt.


	Der Beginn des letzten Kommentars, der Name des Autors mit Link zu seiner Profilseite  sowie das Datum und die Uhrzeit der Veröffentlichung wird angezeigt


	Die Gesamtzahl der Forenthemen wird angezeigt. Wenn die Zahl der Forenthemen sehr hoch ist, werden die ersten zehn Einträge angezeigt. Weitere können über die Navigation aufgerufen werden.








          

      

      

    

  

    
      
          
            
  
6. Blöcke

Blöcke für interne und externe Artefakte werden zur Zusammenstellung von Portfolio- und Gruppenansichten  genutzt. In Mahara ist eine große Anzahl von Blöcken bereits vorinstalliert. Weitere Plugins [http://wiki.mahara.org/Plugins] können zusätzlich installiert werden.



	6.1. Externe Inhalte
	6.1.1. Externer Feed

	6.1.2. External video

	6.1.3. Google Apps





	6.2. Dateien, Bilder und Video
	6.2.1. File(s) to Download

	6.2.2. A Folder

	6.2.3. Image Gallery

	6.2.4. Text-Block (HTML)

	6.2.5. An Image

	6.2.6. Embedded Media





	6.3. Allgemein
	6.3.1. Creative Commons License

	6.3.2. Navigation
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	6.3.6. My Inbox

	6.3.7. Latest Pages

	6.3.8. Group Info
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	6.3.10. Group Pages





	6.4. Blogs
	6.4.1. Einen gesamten Blog anzeigen

	6.4.2. Anzeige eines einzelnen Blogeintrags

	6.4.3. Frühere Beiträge anzeigen





	6.5. Profil
	6.5.1. Kontaktinformationen

	6.5.2. My Friends

	6.5.3. My Groups

	6.5.4. My Pages

	6.5.5. Profilinformation

	6.5.6. Pinnwand





	6.6. Biografie
	6.6.1. Den gesamten Lebenslauf anzeigen

	6.6.2. Ein einzelnes Feld des Lebenslaufs anzeigen





	6.7. Blöcke auf verschiedenen Seiten









          

      

      

    

  

    
      
          
            
  
6.1. Externe Inhalte

Mit Hilfe des Blocks für externen Inhalt, können Sie RSS-Feeds, externe Medien oder Google-App-Dokumente in eine Ansicht einfügen.


6.1.1. Externer Feed

[image: External feed]
Betten Sie einen RSS- oder ATOM-Feed zur Darstellung dessen Inhalts in einen externen Block ein.


[image: Configure external feed]
Konfigurieren Sie den Block für externe Feeds




	Block Title: If you leave the title blank, the title of the feed will be taken.


	Adresse der Nachrichtenquelle: Tragen Sie die gesamte URL des Feeds als gültigen RSS- oder ATOM-Feed hier ein. Wenn der Feed nicht angezeigt wird, versuchen Sie es in einem normalen Feed-Reader, um die Richtigkeit der URL zu kontrollieren.


	Zahl der angezeigten Beiträge: Legen Sie fest wie viele der letzten Beiträge angezeigt werden sollen. Sie können bis zu 20 wählen.


	Show feed items in full?: If you do not select this option, only a heading will be shown for each feed item, e.g. the blog heading of a post. If you select this option, the entire content of the feed item will be shown, e.g. the entire blog post or in case of a flickr RSS feed, the photo and its description.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu speichern, oder auf den Entfernen-Button, um den Block zu entfernen.





Bemerkung

Wenn Ihr Feed nicht automatisch aktualisiert wird, bitten Sie die Site-Administration, die Cron-Einstellungen zu prüfen. Hinweis: wenn in der externen Quelle (z.B. externer Blog) ein neuer Beitrag verfasst wird, ändert sich die RSS-Feed-Anzeige im Mahara-Block nicht sofort mit. Die Aktualisierung erfolgt von Zeit zu Zeit.






6.1.2. External video

[image: External video]
Embed an external video from:


	YouTube [http://youtube.com]


	Google Videos [http://video.google.com/]


	TeacherTube [http://www.teachertube.com]


	Scivee.tv [http://www.scivee.tv/]





[image: Configure external video]
Configure the external video block




	Block Title: Choose a title for your video.


	Video URL: Paste the video embed code or the URL of page where the video is located.


	Width and Height: Choose the width and the height for the video.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu speichern, oder auf den Entfernen-Button, um den Block zu entfernen.





Bemerkung

If you use the embed code for a video, you still have to provide the correct width and height for the video although they are already exist in the embed code. Mahara ignores these variables from the embed code.






6.1.3. Google Apps

[image: Google Apps]
Sie können die folgenden Inhaltsarten von Google (Apps) einbetten:


	Bücher


	Kalender


	Dokumente, Kalkulationen, Präsentationen


	Karten




Sie können den Inhalt nur anzeigen, nicht aber zugleich Dokumente, Kalkulationen oder Präsentationen aus dem Block heraus bearbeiten. Dazu müssen Sie in Google (Apps) eingeloggt sein. Sie können diesen Block mit Ihrem persönlichen Google Account oder dem Ihrer Institution verwenden.


Bemerkung

Wenn der Zugriff auf bestimmte Dokumente eingeschränkt ist auf eine bestimmte Personengruppe, wird eine Login-Maske angezeigt.




[image: Configure external feed]
Konfigurieren Sie den Google-Apps-Block




	Block Title: Choose a title for your embedded content.


	HTML Code oder URL: Je nachdem welche Art von Inhalt Sie anzeigen wollen, geben Sie den Embed code oder die URL ein. Klicken Sie auf den [image: help] Button für weitere Informationen wie welche Google-Komponente eingebettet werden kann.


	Höhe: Wählen Sie die Höhe des einzubettenden Inhalts. Die Breite ergibt sich automatisch aus der Breite des Blocks in den der Inhalt eingebettet wird.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu speichern, oder auf den Entfernen-Button, um den Block zu entfernen.




Google-Dokument


	Open the Google Docs document.


	Click Share and then Publish to the Web (upper right-hand corner) OR if you use the new interface: Click File -> Publish to the web. You do not have to set any sharing options via the Share button in the upper right-hand corner.


	Klicken Sie den Veröffentlichen starten-Button


	Kopieren Sie den Dokumentenlink oder den Embed Code.


	Paste the link / embed code into the Embed code or URL box in the Google Apps block.




Google-Tabellen


	Open the Google Docs spreadsheet.


	Click Share and then Publish to the Web (upper right-hand corner) OR if you use the new interface: Click File -> Publish to the web. You do not have to set any sharing options via the Share button in the upper right-hand corner.


	Klicken Sie den Veröffentlichen starten-Button


	Kopieren Sie den Link.


	Fügen Sie den Link in die HTML Code oder URL-Box im Google-Apps-Block ein.




Google-Präsentation


	Open the Google Docs document.


	Click Share and then Publish to the Web (upper right-hand corner) OR if you use the new interface: Click File -> Publish to the web. You do not have to set any sharing options via the Share button in the upper right-hand corner.


	Klicken Sie den Veröffentlichen starten-Button


	Copy the document link or embed code and adjust any of the other settings if you wish.


	Paste the link / embed code into the Embed code or URL box in the Google Apps block.




Google-Collections


	In Google Docs click My collections or Collections shared with me (list on left side)


	Click and select the collection that you wish to embed -> click Sharing -> Settings OR if you use the new interface: Click on the arrow to the right of the collection name and then on Share -> Share. Alternatively, put a checkmark in front of the collection that you wish to share and go to the More menu item -> Share -> Share.


	Change the permissions to Public and save your changes.


	Kopieren Sie den Link.


	Paste the linke into the Embed code or URL box in the Google Apps block.




Google Dokumenten-Ansicht

This functionality works like the preview functionality in Gmail. You can embed the file, which is directly accessible over the Internet. You just have to paste the complete URL (including the filename) on which the file is accessible to the Google Apps block.

If you use the new interface, you must publish the document first:
Click File -> Publish to the web. You do not have to set any sharing options via the Share button in the upper right-hand corner.

Google Docs Viewer currently supports embedding of the following file types: PDF, TIFF, PPT, DOC, DOCX.


Bemerkung

The files you uploaded to Mahara are not directly accessible, so you can’t embed those files.



Google Kalender


	Öffnen Sie den Google Kalender.


	Klicken Sie auf das kleine Dreieck neben dem Kalender, den Sie einbetten wollen.


	Click on the calendar settings.


	On the Calendar details tab scroll down to Embed This Calendar.


	Passen Sie die Darstellung des Kalenders Ihren Wünschen entsprechend an und kopieren Sie dann den HTML Code.


	Fügen Sie den HTML Code dann in die Box HTML Code oder URL  des Google Apps Block ein.




Google Maps


	Öffnen Sie die Google Karte.


	Click My Maps (My Places in the new interface) link on the upper left side.


	Klicken Sie auf den Namen der Karte, die Sie einbetten wollen.


	Click Link (the link icon in the new interface) link on the upper right side.


	Passen Sie die Darstellung der Karte nach Ihren Wünschen an und kopieren Sie den HTML Code.


	Fügen Sie den HTML Code dann in die Box HTML Code oder URL  des Google Apps Block ein.





Bemerkung

Use steps 2 and 3 only if you wish to embed your Google map. If you wish to embed any Google map, you can skip steps 2 and 3.



Google Bücher (books)


	Öffnen Sie Google Books.


	Suchen Sie das Buch, das Sie einbetten wollen.


	Klicken Sie auf den Titel des Buches.


	Click on Link on the upper right side.


	Kopieren Sie den HTML Code des Buches.


	Fügen Sie den HTML Code dann in die Box HTML Code oder URL  des Google Apps Block ein.





Bemerkung

Das Link-Icon erscheint nur wenn Sie berechtigt sind, das Buch einzubetten









          

      

      

    

  

    
      
          
            
  
6.2. Dateien, Bilder und Video

These artefacts are internal Mahara ones to display links to files that you have uploaded, folders that contain files, show images, embed audio and video files.


6.2.1. File(s) to Download

[image: Files to download]
Dateien auswählen, die Betrachter Ihres Portfolios herunterladen dürfen.


[image: Configure the block Files to download]
Configure the file(s) to download block




	Block Title: Choose a title for your document block.


	Files area: Choose from which area of Mahara you would like to select a file. If you are not a member of a group and not an admin, you may only see My Files. If you have access to files elsewhere, these contexts are shown as well, e.g. the Site Files.


	Datei uploaden: Sie können hier direkt Dateien hochladen und müssen nicht erst zurück zum Bereich Dateien unter Inhalte.


	Ordnerpfad: Die sog. Brotkrumen-Navigation zeigt Ihnen in welchem Ordner Sie sich gerade befinden.


	Sie können nun auch noch die Daten zu Ihren Dateien (Dateiname, Beschreibung, Schlagworte) bearbeiten. Nutzen Sie den Bearbeiten-Button.


	Wählen Sie die Datei oder Dateien durch Anklicken des Auswählen-Buttons, die Sie anzeigen möchten.


	Klicken Sie auf den Entfernen-Button, um einen spezifische Datei im Block nicht mehr anzuzeigen.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.





Bemerkung

You cannot re-order files once you have them selected. You would need to remove them and select them again in the correct order.



Wenn der Block in einer Portfolioansicht angeordnet ist, sind folgende Informationen sichtbar:


	Dateiname


	Dateibeschreibung


	Größe


	Datum des Uploads


	ein Link zu weiteren Details





[image: File download details]
Details zu Dateien, die heruntergeladen werden können.



Wenn ein Nutzer auf den Details-Link klickt, wird ihm die Datailseite für diese Datei mit den Metadaten angezeigt. Er/sie kann die Datei melden (unangemessener Inhalt), drucken oder der eigenen Beobachtungsliste hinzufügen.


[image: Metadata for a file]
Weitere Details zu einer Datei, die heruntergeladen werden kann.




Bemerkung

Wenn Sie beim Bearbeiten der Datei Kommentare zugelassen haben, können die Nutzer/innen nun auch Kommentare direkt zu einer Datei und nicht nur zur ganzen Ansicht hinterlassen.






6.2.2. A Folder

[image: Display an entire folder]
Dateien auswählen, die Betrachter Ihres Portfolios herunterladen dürfen.


[image: Configure the block Folder]
Configure the folder block




	Block Title: If you leave the title blank, the title of the folder that you choose to display will be taken.


	Files area: Choose from which area of Mahara you would like to select a file. If you are not a member of a group and not an admin, you may only see My Files. If you have access to files elsewhere, these contexts are shown as well, e.g. the Site Files.


	Ordnerpfad: Die sog. Brotkrumen-Navigation zeigt Ihnen in welchem Ordner Sie sich gerade befinden.


	Sie können jede Komponente des Ordners bearbeiten (z.B. Namen, Beschreibung, Schlagwörter) indem Sie den Bearbeiten-Button anklicken.


	Choose the folder you wish to display by clicking on the Select button. If you want to revert your selection, click the Remove button.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.







6.2.3. Image Gallery

[image: Display an image gallery]
Select a folder with images or individual images to show in a gallery.


[image: Configure the block Image Gallery]
Configure the image gallery block




	Block Title: Choose a title for your image gallery block.


	Image Selection: You can choose to display all images from a specific folder or you can select the images individually.


	Files area: Choose from which area of Mahara you would like to select a file. If you are not a member of a group and not an admin, you may only see My Files. If you have access to files elsewhere, these contexts are shown as well, e.g. the Site Files.


	Ordnerpfad: Die sog. Brotkrumen-Navigation zeigt Ihnen in welchem Ordner Sie sich gerade befinden.


	Sie können jede Komponente des Ordners bearbeiten (z.B. Namen, Beschreibung, Schlagwörter) indem Sie den Bearbeiten-Button anklicken.


	Wählen Sie mit dem Auswählen-Button den Ordner, den Sie anzeigen wollen.


	Wenn Sie Ihre Auswahl rückgängig machen wollen, klicken Sie den Entfernen-Button.


	Style: Decide to show all selected images as thumbnails or as slideshow where you only see one image at a time.


	Breite: Definieren Sie die Breite der Bilder (in Pixeln). Die Bilder werden auf die entsprechende Größe angepasst.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.





Bemerkung

Wenn Sie einen kompletten Ordner für Ihre Bildgalerie ausgewählt haben, werden neue Bilder, die später in diesen Ordner eingefügt werden, ebenfalls in der Bildgalerie angezeigt werden.






6.2.4. Text-Block (HTML)

[image: Include HTML code]
Den Inhalt einer HTML-Datei in einer Ansicht anzeigen.


[image: Configure the block Some HTML]
Configure the html block




	Block Title: Choose a title for your block.


	Files area: Choose from which area of Mahara you would like to select a file. If you are not a member of a group and not an admin, you may only see My Files. If you have access to files elsewhere, these contexts are shown as well, e.g. the Site Files.


	Datei uploaden: Sie können hier direkt Dateien hochladen und müssen nicht erst zurück zum Bereich Dateien unter Inhalte.


	Ordnerpfad: Die sog. Brotkrumen-Navigation zeigt Ihnen in welchem Ordner Sie sich gerade befinden.


	Sie können nun auch noch die Daten zu Ihren Dateien (Dateiname, Beschreibung, Schlagworte) bearbeiten. Nutzen Sie den Bearbeiten-Button.


	Wählen Sie über den Auswählen-Button eine Datei, die Sie anzeigen wollen.


	Klicken Sie auf den Entfernen-Button, um die Datei im Block nicht weiter anzuzeigen.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.





Bemerkung

You can only display a self-contained HTML file in a Mahara page, but not an entire site because the links to the files are not retained correctly when you upload files to Mahara.






6.2.5. An Image

[image: Display an image in a block]
Anzeige eines einzelnen Bilds in einem Block


[image: Configure the block Some HTML]
Configure the image block




	Block Title: Choose a title for your block.


	Files area: Choose from which area of Mahara you would like to select a file. If you are not a member of a group and not an admin, you may only see My Files. If you have access to files elsewhere, these contexts are shown as well, e.g. the Site Files.


	Datei uploaden: Sie können hier direkt Dateien hochladen und müssen nicht erst zurück zum Bereich Dateien unter Inhalte.


	Ordnerpfad: Die sog. Brotkrumen-Navigation zeigt Ihnen in welchem Ordner Sie sich gerade befinden.


	Sie können nun auch noch die Daten zu Ihren Dateien (Dateiname, Beschreibung, Schlagworte) bearbeiten. Nutzen Sie den Bearbeiten-Button.


	Wählen Sie über den Auswählen-Button eine Datei, die Sie anzeigen wollen.


	Klicken Sie auf den Entfernen-Button, um die Datei im Block nicht weiter anzuzeigen.


	If your file has a description you can choose to display it. The description could contain the source of the photo for example.


	Definieren Sie die Breite (in Pixeln) für Ihr Bild. Wenn Sie keinen Wert eintragen, wird Ihr Bild an die Breite des Blocks in der Ansicht angepasst.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.







6.2.6. Embedded Media

[image: Embed a video or audio file]
Display an embedded video or audio file from your uploaded files. You can display mp3, mp4 and flv files.


[image: Configure the block Some HTML]
Configure the media block




	Block Title: Choose a title for your block.


	Files area: Choose from which area of Mahara you would like to select a file. If you are not a member of a group and not an admin, you may only see My Files. If you have access to files elsewhere, these contexts are shown as well, e.g. the Site Files.


	Datei uploaden: Sie können hier direkt Dateien hochladen und müssen nicht erst zurück zum Bereich Dateien unter Inhalte.


	Ordnerpfad: Die sog. Brotkrumen-Navigation zeigt Ihnen in welchem Ordner Sie sich gerade befinden.


	Sie können nun auch noch die Daten zu Ihren Dateien (Dateiname, Beschreibung, Schlagworte) bearbeiten. Nutzen Sie den Bearbeiten-Button.


	Wählen Sie über den Auswählen-Button eine Datei, die Sie anzeigen wollen.


	Klicken Sie auf den Entfernen-Button, um die Datei im Block nicht weiter anzuzeigen.


	If your file has a description you can choose to display it.


	Choose the width and height (in pixels) for your video.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.





Bemerkung

Nur Dateien, deren Typ zugelassen ist, können angezeigt werden. Bei mp4-Dateien wird der H.264mp4-Typ unterstützt. Sollten mp4-Videos nicht angezeigt werden, prüfen Sie den Codec Ihres Video.









          

      

      

    

  

    
      
          
            
  
6.3. Allgemein

The artefacts in this tab are of a general nature or did not fit into any other category and can be used around the site.

Wenn Sie eine Ansicht in einer  Gruppe erstellen, stehen Ihnen der Navigationsblock und der Pläne-Block nicht zur Verfügung, da Sie in Gruppen keine Sammlungen oder Pläne anlegen können.  Bei der Bearbeitung der Gruppenstartseite können Sie folgende Blöcke zusätzlich verwenden:


	Group Info


	Group Members


	Group Pages





6.3.1. Creative Commons License

[image: Add a Creative Commons license]
Add a block to your page which lets users know under which Creative Commons license your page is published.


[image: Configure the block Files to download]
Configure the Creative Commons block




	Block Title: Choose a title for your document block.


	Kommerzielle Nutzung Ihres Werks zulassen? Entscheiden Sie, ob Nutzer/innen Ihre Arbeit auch für kommerzielle Zwecke weiter nutzen dürfen.  Kommerzielle Zwecke sind auch Veröffentlichungen auf Blogseiten, die auch Werbung beinhalten. Es kommt nicht auf die Gewinnerzielungsabsicht an.


	Veränderungen an Ihrem Werk zulassen?: Entscheiden Sie, ob andere Nutzer Ihre Ansicht verwenden dürfen, um mit weiteren Inhalten daraus etwas Neues zu erstellen und wenn ja unter welchen Konditionen.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.





Siehe auch

For more information about the licenses and their terms, visit the Creative Commons web site [http://creativecommons.org/licenses/].






6.3.2. Navigation

[image: Add a navigation block for a collection]
Einen Navigationsblock zur Anzeige von Links auf Ansichten in einer Sammlung hinzufügen.


Bemerkung

You must create at least one collection first in order to use this block.




[image: Configure the navigation block]
Configure the navigation block




	Block Title: The title of the collection is chosen automatically unless you provide a different one.


	Sammlung: Wählen Sie die Sammlung aus dem Drop-down-Menu in dem Links im Block angezeigt werden sollen.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.







6.3.3. Your Plans

[image: Add a plan to your page]
Zeigen Sie einen Ihrer Pläne in einem Block.


Bemerkung

You must create at least one plan first in order to use this block.




[image: Configure the navigation block]
Configure the plans block




	Block Title: The title of the plan is chosen automatically unless you provide a different one.


	Pläne anzeigen: Wählen Sie den Plan, den Sie in Ihrer Ansicht anzeigen wollen.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.





[image: Embedded plan]
Ergebnis eines eingebetteten Plans in eine Portfolio-Ansicht. Indem Sie auf die verlinkten Titel klicken, können Sie die Beschreibungen der einzelnen Aufgaben aufrufen.






6.3.4. Recent Forum Posts

[image: Add recent forum posts]
Anzeige der zuvor festgelegten Anzahl aktuellster Forenbeiträge einer Gruppe.


Bemerkung

Sie müssen Mitglied mindestens einer Gruppe sein, um diesen Block verwenden zu können.




[image: Configure the recent forum posts block]
Configure the recent forum posts block




	Block Title: The title of the block is generated automatically unless you provide a different one. The default title is „Recent Forum Posts“.


	Group: Choose the group whose forum posts shall be displayed.


	Maximum number of posts to show: Decide how many of the latest forum posts you wish to show. The default value is 5.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.







6.3.5. Text Box

[image: Add text]
Fügen Sie Text direkt ein. Diese Funktion ist dafür gedacht, Texte anzulegen, die Sie nicht in einem Blog erstellen, z.B. kurze Textschnippsel.


Warnung

If you remove a text box from a page, its content is deleted forever and cannot be retrieved anymore. Only in the upcoming Mahara 1.5 version will text boxes be artefacts that can be stored and re-used.




[image: Configure the recent forum posts block]
Configure the text box block




	Block Title: Provide a title for your text.


	Block Content: Write your text. You can include formatting, external images etc.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.





Bemerkung

Wir empfehlen nicht, Bilder in einem Textfeld einzubinden, die Sie in Mahara hochgeladen haben. Es ist dann nicht sichergestellt, dass alle Betrachter Zugriff erhalten. Sie werden das Bild dann nicht sehen wenn das Bild nicht auch in einer anderen Portfolioansicht verwendet wird auf die sie Zugriff haben. Der Zugriff für Inhalte in Mahara basiert  auf Ansichten und Artefakt-Blöcken. Ein Bild in einem Textfeld wird nicht als Artefakt erkannt und kann daher keine zusätzlichen Sichtbarkeitsberechtigungen erhalten.






6.3.6. My Inbox

[image: My Inbox block]
The My Inbox block displays the latest messages that you have received in Mahara.


Bemerkung

Dieser Block kann nur im Dashboard genutzt werden.




[image: Configure the inbox block]
Configure the inbox block




	Block Title: The automatic title for this block is „Recent Activity“. You can set another one if you wish.


	Mitteilungstypen zur Anzeige: Markieren Sie jeden Mitteilungstyp, den Sie in diesem Block anzeigen wollen.


	Maximum number of items to display: Decide how many pages shall be shown on your dashboard. You can choose between 5 and 100.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.







6.3.7. Latest Pages

[image: Latest pages block]
The Latest Pages block displays the latest pages to which you have access across Mahara.


Bemerkung

Dieser Block kann nur im Dashboard genutzt werden.




[image: Configure the latest pages block]
Configure the latest pages block




	Block Title: The automatic title for this block is „Latest pages“. You can set another one if you wish.


	Höchstzahl der Ansichten zum Anzeigen: Legen Sie fest wie viele Ansichten im Dashboard angezeigt werden sollen. Sie können zwischen 5 und 100 wählen.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.







6.3.8. Group Info

[image: Add the group info block]
Der Block ist ein Standardblock auf der Gruppenstartseite. Eine Konfiguration ist nicht möglich.  Der Block enthält Informationen über:


	Gruppenadministrator/innen


	Gruppentyp


	Datum der Erstellung der Gruppe


	Anzahl der Gruppenmitglieder


	Anzahl der in der Gruppe erstellten Ansichten


	Anzahl der in der Gruppe hochgeladenen Dateien


	Anzahl der in der Gruppe erstellten Ordner







6.3.9. Group Members

[image: Add the group members block]
Dieser Block ist ein Standardblock auf der Gruppenstartseite. Sie können Profilbilder der Mitglieder und ihre Namen anzeigen.


[image: Configure the group pages block]
Configure the group members block




	Block Title: The automatic title for this block is „Members“. You can set another one if you wish.


	Shown Members: Choose how many members (between 1 and 20) are shown on the group homepage. All others are accessible via the Members tab in the group.


	Order: Choose the order in which members are displayed. Options are:


	letzte: zeigt die zuletzt zur Gruppe hinzugekommenen Mitglieder zuerst.


	zufällig: lassen Sie Mahara entscheiden welche Mitglieder angezeigt werden






	Klicken Sie auf den Speichern-Button, um die Änderungen zu speichern oder auf Abbrechen, um den Block so zu lassen wie er war.







6.3.10. Group Pages

[image: Add the group pages block]
Dieser Block ist ein Standardblock auf der Gruppenstartseite. Sie können darin in der Gruppe erstellte oder für die Gruppe freigegebene Ansichten anzeigen.


[image: Configure the group pages block]
Configure the group pages block




	Block Title: The automatic title for this block is „Group pages“. You can set another one if you wish.


	Display Group pages? Decide whether to display pages that were created in the group. „Yes“ is the default option.


	Display Shared pages? Decide whether to display pages that users shared with the group. „No“ is the default option.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu speichern oder auf Abbrechen, um den Block so zu lassen wie er war.










          

      

      

    

  

    
      
          
            
  
6.4. Blogs

Sie können Inhalte aus Ihren Blogs in verschiedener Art in Ihre Ansichten einbinden:


	den gesamten Blog anzeigen


	nur einen Blogeintrag anzeigen


	die letzten Blogeinträge anzeigen





Bemerkung

Sie müssen zumindest einen Blog erstellt haben, um diesen Block zu sehen.




Warnung

Sie können das Kopieren Ihrer Blogs und Blogeinträge erlauben. Seien Sie mit dieser Option sehr vorsichtig. Wer im Besitz einer Kopie Ihrer Einträge ist, kann sich als deren Autor/in ausgeben.  Die Funktion erlaubt es andererseits, Vorlagen oder Gerüste für weitere Beiträge zu erstellen.




6.4.1. Einen gesamten Blog anzeigen

[image: Display an entire journal]
Den gesamten Blog in Ihrer Portfolioansicht anzeigen.


[image: Configure the journal block]
Configure the journal block




	Block Title: The title of the journal is chosen automatically unless you provide a different one.


	Blog: Wählen Sie den Blog, den Sie anzeigen wollen. Wenn Sie mehrere Blogs haben, können Sie den auswählen, den Sie verwenden wollen.


	Einträge pro Seite: Legen Sie fest wie viele Einträge auf einer Seite angezeigt werden sollen. Wenn mehr Seiten existieren, wird eine Navigation angezeigt.


	Block-Kopiererlaubnis: Legen Sie fest was mit dem Block passieren soll, wenn Sie anderen erlauben ihn für eine andere Ansicht zu kopieren. Optionen sind:


	Diesen Blog beim Kopieren der Ansichten überspringen


	Andere dürfen meinen Blog in ihrer Ansicht anzeigen


	Andere erhalten eine Kopie meines Blogs






	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.





Bemerkung

Wenn Sie die Ansichten teilen und damit einen Blog öffentlich machen, so erhält Ihr Blog einen RSS-Feed. Leser/innen können darüber den Blog in Ihrem bevorzugten RSS-Reader verfolgen.






6.4.2. Anzeige eines einzelnen Blogeintrags

[image: Display one journal entry]
Den gesamten Blog in Ihrer Portfolioansicht anzeigen.


[image: Configure the journal entry block]
Configure the journal entry block




	Block Title: The title of the journal post is chosen automatically unless you provide a different one.


	Journal Entry: Select the journal entry you wish to display. If you have many posts, you can also search for the one you want to use.


	Block-Kopiererlaubnis: Legen Sie fest was mit dem Block passieren soll, wenn Sie anderen erlauben ihn für eine andere Ansicht zu kopieren. Optionen sind:


	Diesen Blog beim Kopieren der Ansichten überspringen


	Andere dürfen Ihren Blogeintrag in ihrer Ansicht verwenden.


	Andere erhalten eine eigene Kopie meines Blogeintrags






	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.







6.4.3. Frühere Beiträge anzeigen

[image: Display recent journal posts]
Den gesamten Blog in Ihrer Portfolioansicht anzeigen.


[image: Configure the recent journal entries block]
Configure the recent journal entries block




	Block Title: Choose a title for your block.


	Journal: Select the journal(s) from which you wish to display the latest posts. If you have many journals, you can also search for the one you want to use.


	Items to show: Decide how many posts you want to display.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.





Bemerkung

If you have multiple journals, you can display recent posts from all of them.









          

      

      

    

  

    
      
          
            
  
6.5. Profil

The artefact blocks in this tab allow you to include information that you provided in the Profil into your portfolio. If you want to make changes to the text or the images, you will have to go to Content -> Profile.

Furthermore, you can also put certain blocks onto your Mahara profile page that only exist for that particular page:


	My Friends


	My Groups


	My Pages


	Pinnwand





6.5.1. Kontaktinformationen

[image: Add contact information]
Fügen Sie einen Block mit den Kontaktinformationen in Ihre Ansicht ein.


Bemerkung

Only display as much information as you wish anybody to see. Especially when you make your pages available to the public, i.e. everybody on the internet, or all logged-in users, decide carefully whether you want to display your street address and / or phone number.




[image: Configure the block Contact Information]
Configure the contact information block




	Block Title: Choose a title for your block.


	Email Address Decide whether to display one of your email addresses that Mahara knows.


	Fields to show: Decide which fields shall appear on the page. Put a checkmark in front of each one that you want to show. Displayed are only the ones for which you provided content.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.







6.5.2. My Friends

[image: Add the friends block]
Fügen Sie einen Block mit Ihren Kontakten ein. Gezeigt werden deren Profilbilder und Namen. Dies ist ein Standardblock der Profilseite.

Sie brauchen den Block nur in die Profilseite einzufügen. Weitere Einstellungen sind nicht vorgesehen.




6.5.3. My Groups

[image: Add the groups block]
Fügen Sie einen Block mit Ihren Gruppen in Ihre Profilseite. Dies ist ein Standardblock auf der Profilseite.

Sie brauchen den Block nur in die Profilseite einzufügen. Weitere Einstellungen sind nicht vorgesehen.




6.5.4. My Pages

[image: Add the pages block]
Fügen Sie einen Block ein, der Ihre Ansichten auf der Profilseite zeigt. Dies ist ein Standardblock auf der Profilseite. Dieser Block sollte auf Ihrer Profilseite verbleiben. Er erlaubt anderen Nutzer/innen auf Ihre Ansichten zuzugreifen.

Sie brauchen den Block nur in die Profilseite einzufügen. Weitere Einstellungen sind nicht vorgesehen.


Bemerkung

When a user views your profile page, he only sees the pages to which he has access. That also means that you see all your pages while others may see none or just a few.






6.5.5. Profilinformation

[image: Add profile fields]
Fügen Sie einen Block mit Ihren Profilfeldern in Ihre Ansicht


Bemerkung

Only display as much information as you wish anybody to see. Especially when you make your pages available to the public, i.e. everybody on the internet, or all logged-in users, decide carefully whether you want to display your street address and / or phone number.




[image: Configure the block Profile information]
Configure the profile information block




	Block Title: Choose a title for your block.


	Fields to show: Decide which fields shall appear on the page. Put a checkmark in front of each one that you want to show. Displayed are only the ones for which you provided content.


	Profile Picture: Choose to display one of your profile pictures or none.


	Email Address Decide whether to display one of your email addresses that Mahara knows.


	Introduction Text: If you do not want to display the introduction text from your profile, you can write another one just for this page here. However, it will be lost when you delete this block.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.







6.5.6. Pinnwand

[image: Add the wall block]
Fügen Sie einen Block ein, der Ihre Pinnwand auf Ihrer Profilseite anzeigt. Es ist ein Standardblock auf der Profilseite.

Sie brauchen den Block nur in die Profilseite einzufügen. Weitere Einstellungen sind nicht vorgesehen.







          

      

      

    

  

    
      
          
            
  
6.6. Biografie

Sie können den gesamten Lebenslauf oder Teile in Ihrer Portfolioansicht anzeigen. Wenn Sie nur Teile anzeigen, haben Sie mehr Einfluß auf die Anordnung der Elemente.


6.6.1. Den gesamten Lebenslauf anzeigen

[image: Add your entire résumé to your page]
Einen Block mit Ihrem gesamten Lebenslauf in der Ansicht einfügen


[image: Configure the block Your Entire Résumé]
Configure the full résumé block




	Block Title: Choose a title for your block.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.







6.6.2. Ein einzelnes Feld des Lebenslaufs anzeigen

[image: Add one résumé field to your page]
Einen Block mit einem einzelnen Feld des Lebenslaufs in die Ansicht einfügen.


[image: Configure the block Your Entire Résumé]
Configure the One Résumé Field block




	Block Title: The title of the résumé field you want to display is chosen automatically unless you provide a different one.


	Feld auswählen: Wählen Sie die Biografieinformation, die Sie anzeigen wollen. Sie können einen Bereich auswählen.


	Sie können direkt von diesem Pop-up-Fenster zu dem Bereich der Biografie gehen, um dort weitere Informationen zu hinterlegen.


	Klicken Sie auf den Speichern-Button, um die Änderungen zu sichern, oder auf Abbrechen, um den Inhalt unverändert zu lassen. Der Entfernen-Button wird nur angezeigt wenn der Block in eine Ansicht eingefügt wird und noch ohne Inhalt ist.





Bemerkung

Normalerweise werden nur Biografiefelder angezeigt in denen Sie auch Inhalt hinterlegt haben. Im Bereich Fähigkeiten und Ziele werden alle Überschriften angezeigt auch wenn Sie dort noch keinen Inhalt hinterlegt haben.









          

      

      

    

  

    
      
          
            
  
6.7. Blöcke auf verschiedenen Seiten

Einige Blöcke können nur in speziell dafür vorgesehenen Kontexten eingesetzt werden. Eine Pinnwand kann z.B. nur in Profilseiten eingesetzt werden. Eine Textbox kann auf jeder Seite verwandt werden. Folgende Kontexte werden unterschieden:


	Portfolioansicht


	Gruppenansicht


	Institutionsansicht


	Startseite


	Profilseite


	Dashboard-Seite




The following list shows in which contexts a specific block and therefore a specific artefact can be used. It also shows which blocks can be copied. The original idea came from Synergy Learning for Mahara 1.3.

External content













	Block

	Benutzer

	Gruppe

	Institution

	Site

	Dashboard

	Profil

	Gruppenstartseite





	
[image: externalfeed]

Externer Feed




	[image: check]

	[image: check]

	[image: check]

	[image: check]

	[image: check]

	[image: check]

	[image: check]



	
[image: externalvideo]

External video




	[image: check]

	[image: check]
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[image: googleapps]

Google Apps




	[image: check]
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Files, images and video













	Block

	Benutzer

	Gruppe

	Institution

	Site

	Dashboard

	Profil

	Gruppenstartseite





	
[image: filedownload]

File(s) to Download




	[image: check]
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[image: folder]

A Folder
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[image: html]

Text-Block (HTML)
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[image: image]

An Image
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[image: imagegallery]

Image Gallery




	[image: check]

	[image: check]

	[image: check]

	[image: check]

	[image: check]

	[image: check]

	[image: check]



	
[image: internalmedia]

Embedded Media
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General













	Block

	Benutzer

	Gruppe

	Institution

	Site

	Dashboard

	Profil

	Gruppenstartseite





	
[image: creativecommons]

Creative Commons License




	[image: check]
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[image: navigation]

Navigation




	[image: check]
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[image: textbox]

Text Box
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[image: plans]

Your Plans
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[image: recentforumposts]

Recent Forum Posts
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[image: groupinfo]

Group Info
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[image: groupmembers]

Group Members
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Group Pages
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My Inbox
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[image: newviews]

Latest Pages




	
	
	
	
	[image: check]

	
	





Journals













	Block

	Benutzer

	Gruppe

	Institution

	Site

	Dashboard

	Profil

	Gruppenstartseite





	
[image: journal]

Einen gesamten Blog anzeigen
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[image: journalpost]

Anzeige eines einzelnen Blogeintrags
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[image: recentjournalpost]

Frühere Beiträge anzeigen
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Profile













	Block

	Benutzer

	Gruppe

	Institution

	Site

	Dashboard

	Profil

	Gruppenstartseite





	
[image: contactinfo]

Kontaktinformationen




	[image: check]
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Profilinformation
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[image: myfriends]

My Friends
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[image: mygroups]

My Groups
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My Pages
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Pinnwand
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Résumé













	Block

	Benutzer

	Gruppe

	Institution

	Site

	Dashboard

	Profil

	Gruppenstartseite





	
[image: resumefull]

Den gesamten Lebenslauf anzeigen




	[image: check]
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[image: resumefield]

Ein einzelnes Feld des Lebenslaufs anzeigen




	[image: check]

	
	
	
	[image: check]
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7.1. Accounteinstellungen

Die Nutzeraccounteinstellungen befinden sich in der Ansicht Einstellungen. In  der rechten oberen Ecke neben der Anzeige der Benachrichtigungen und der Logout-Option befindet sich der Zugriffslink.


7.1.1. Neues Passwort

You can change your Mahara password on the Settings page:


	Bitte geben Sie Ihr aktuelles Passwort hier ein.


	Enter your preferred new password in the New Password and Confirm password box.


	Machen Sie weitere Anpassungen wenn Sie dies wünschen.


	Klicken Sie auf den Speichern-Button am Fuß der Seite.




Your password must have a minimum of six characters. It must contain at least one number, and at least two letters. Passwords are case sensitive and must be different from your username.


[image: Change password]
Ändern Sie Ihr Passwort




Bemerkung

If you do not see the New password box, you cannot change your password in Mahara. Your login and password are managed elsewhere. This is the case if your institution has set up single sign-on to other applications for example. If you want to change your password, please contact your institution administrator. He will be able to tell you where you can change your password.






7.1.2. Benutzername ändern

Sie benötigen einen Nutzernamen, um sich in Mahara einzuloggen. Den Nutzernamen können Sie jederzeit ändern.  Ist dies nicht der Fall, wird Ihr Nutzerzugang andernorts verwaltet, z.B. wenn Single Sign On von anderen Anwendungen genutzt wird.  Wenn Sie in dem Fall Ihr Passwort ändern wollen gehen Sie zu der Ausgangsanwendung, ändern Sie dort Ihr Passwort oder nehmen Sie Kontakt mit dem/der Administrator/in auf.


Bemerkung

Nutzernamen sind 3-30 Zeichen lang und können Buchstaben, Zahlen und einige Sonderzeichen enthalten. Leerzeichen sind nicht möglich.




[image: Change username]
Ändern Sie Ihren Benutzernamen






7.1.3. Allgemeine Accounteinstellungen

The general account options are visible to all users no matter whether they can change their usernames and passwords or not.


[image: General account options]
Prüfen und ändern Sie Ihre allgemeinen Accountoptionen




	Friends control: Choose whether other users may add you to their friends list. If you are added to a friends list, the owner of that list is added to your list. When you remove someone from your friends list you are also removed from their list.


	HTML editor: An HTML editor is available for use on some sections of the site. This is known as a ‚What you see is what you get‘ (WYSIWYG) editor. This allows you to apply formatting to your text like in a word processor. If the editor is turned off you can only enter plain text. If you do not have this option, the site admin may have disabled it.


	Email: Use this setting to stop Mahara from sending you emails. It is advised that you generally regulate what is sent via email and what is not in the notifications.


	Message from other users: Use this setting to choose who you wish to receive messages from. Use the notifications area to decide how you will receive these messages. Note: These restrictions will not apply to users with the ‚administrator‘ or ‚staff‘.


	Language: If your Mahara instance is offered in multiple languages, you can choose in which one you want to navigate the site. The menu items and the contextual help appear in the language you have chosen. However, the content does not.


	Einstelloptionen zum Hinzufügen und Entfernen von Spalten beim Bearbeiten einer Seite. Sie können die Hinzufügen und Entfernen Buttons in der Seitenbearbeitung hinzufügen, um die Zahl der Spalten auf einer Portfolioseite zu bearbeiten.  Dazu mehr Layout bearbeiten.


	Enable multiple journals: By default, you have one journal. If you would like to keep more than one journal, choose this option.


	Maximum tags in cloud: Decide how many tags you wish to display in your personal tag cloud.


	Show information about Mahara on the homepage: You choose this option if you want to display the quick links on your dashboard.


	Mobile upload token: Enter a token, e.g. a word, her and on your Android phone or iPhone to enable uploads. Your token changes automatically after each upload. See Mahara auf mobilen Endgeräten for more information on using Mahara with a mobile device.


	Click the Save button whe you have finished making your changes.





Warnung

If you disable your email address, you cannot reset your password as that requires a sending of an email to your address.






7.1.4. Zugang löschen

If your Mahara site allows self-registration, you can delete your own account by clicking on the Delete account link on the top of the settings page.


Warnung

Wenn Sie Ihren Nutzeraccount löschen, werden alle von Ihnen angelegten Artefakte und Ansichten gelöscht. Die Dateien und Informationen können nicht wieder hergestellt werden. Machen Sie also unbedingt vor dem Löschen des Accounts ein Backup aller Inhalte über Portfolio exportieren. Der Export enthält Ihre eigenen Inhalte, nicht jedoch Inhalte von Gruppenseiten. Das Löschen eines Nutzeraccounts sollte nur dann vorgenommen werden, wennn Sie sich absolut sicher sind.









          

      

      

    

  

    
      
          
            
  
7.2. Benachrichtigungen

Mahara versendet bei verschiedenen Aktivitäten Benachrichtigungen:


	Systemmeldungen: werden automatisch erzeugt oder durch eine/n Administrator/in  direkt an Sie gesandt. Das ist z.B. die Bestätigung über das Anlegen eines neuen Nutzerzugangs.


	Meldungen anderer Nutzer/innen: die direkt an Sie gesandt werden.


	Beobachtungsliste: Benachrichtigungen über Aktivitäten in einem Artefakt, einer Ansicht oder einen Block, den Sie beobachten.


	Neuer Ansichtenzugriff: Information, dass Ihnen oder einer Ihrer Gruppen Zugriff auf eine neue oder bestehende nicht-öffentliche Ansicht gegeben wurde. Es werden keine Benachrichtigungen versandt über Ansichten , die für alle Nutzer/innen zugänglich sind oder die generell öffentlich sind.


	Meldungen einer Institutionen: Auch hier werden bestimmte Benachrichtigungen automatisch erstellt, z. B. Bestätigung über Aufnahme in Institution, Austragungsinformation oder beim Zeitablauf der Zugehörigkeit.


	Gruppennachricht: z.B. die Anfrage einer/s Nutzer/in zur Aufnahme in die Gruppe.


	Feedback: notification of any feedback or comments received on any pages, artefacts or journal posts.


	Neuer Foreneintrag: Nachricht über neue Einträge in Foren, die Sie abonniert haben.


	Contact us: messages to administrators that are sent via the Contactu us form.


	Anstößiger Inhalt: Benachrichtigungen von Nutzer/innen an Administor/innen über Inhalte, die eventuell problematisch sind und geprüft werden sollten.


	Repeat virus upload: messages to adminsitrators about users who repeatedly upload virus-infected files. Virus checking must be turned on.


	Virenmeldung: Nachricht an Administrator/innen über Dateien, die vom Virenprüfprogramm erkannt wurden.




You may select how you receive notifications for each activity type. To do so, go to Settings -> Notifications.


[image: Notifications]
Benachrichtigungen




	Wählen Sie den Benachrichtigungstyp für jede Art von Aktivität aus. Es gibt vier Benachrichtigungstypen:


	Email: your primary email address will receive an email each time the activity occurs.


	Email digest: your primary email address will receive an email each day with a list of the activities of the last 24 hours. Typically, this email is sent at around 6 p.m., but this can be changed.


	Inbox: your notifications area will display a list of activity notifications received.


	None: This is only available to administrators for notifications that are only intended for administrators. They can opt to not receive any notifications for certain types.









Bemerkung

Nur Administrator/innen mit Zugang zum Server können den Zeitpunkt des Versendens der Tageszusammenfassung ändern. Dazu ist die Variable $emaildigest in der Datei `htdocs/notification/emaildigest/lib.php`anzupassen.




Bemerkung

Wenn Sie E-Mail oder die E-Mail-Tageszusammenfassung aktiviert haben, werden alle Aktivitäten in der Eingangsbox hinterlegt. Sie werden zudem als bereits gelesen markiert. Diese Benachrichtigungen werden für 60 Tage gespeichert und danach automatisch gelöscht.






7.3. Eingangsbox

Sie können die Benachrichtigungen Ihres Nutzeraccounts in Ihrer Eingangsbox sehen. Den Link auf diesen Bereich finden Sie rechts oben neben dem Link zu den Einstellungen und dem Logout.


[image: You inbox]
Ihr Posteingang




	Nachrichtententyp: Sie können die Benachrichtigungen nach Aktivitätentypen filtern, um einen schnelleren Überblick zu erhalten.


	Betreff: Das Thema der Benachrichtigung ist verlinkt. So können Sie mit einem Klick schnell den Inhalt aufrufen.


	Datum: Hier sehen Sie, wann die Benachrichtigung versandt wurde


	Gelesen: Sie können hier einzelne oder auch alle Nachrichten als ‚gelesen‘ markieren.


	Klicken Sie auf als Gelesen markieren, um zuvor ausgewählte Benachrichtigungen als bereits gelesen zu kennzeichnen. Benachrichtigungen, die Sie bereits per E-Mail erhalten haben, sind automatisch als gelesen markiert.


	Alle Nachrichten löschen. Wählen Sie eine oder mehrere Benachrichtigungen auf der Seite aus, um sie danach zu löschen.


	Klicken Sie auf den Löschen-Button, um die markierten Benachrichtigungen endgültig zu löschen.


	Bewegen Sie sich durch alle Benachrichtigungen mit Hilfe der Seitennavigation.


	You can delete all notifications at once. That will delete every notification no matter whether you see them on the screen or not. They cannot be retrieved again. Only when you had sent messages to your email will you still be able to view them if you have not deleted them there as well.








          

      

      

    

  

    
      
          
            
  
7.4. Institution membership

You can see in which institution(s) you are a member when you go to Settings -> Institution membership. You may be able to leave your current institution and join other institutions if they allow self-registration. If you cannot leave your institution, you must ask your institution administrator to remove you.


Bemerkung

Leaving an institution does not mean that your account will be deleted. You keep your content and portfolio pages.




[image: Check on your institution membership]
Check on your institution membership




	Click on Settings -> Institution Membership to view your institution membership.


	Memberships: Here you see to which institution(s) you belong. Click on the Leave institution button to remove yourself from the institution. If you do not see this button next to an institution, you cannot remove yourself but must ask an institution administrator to do so.


	Requests: If you have already requested membership in an institution, it will be listed here. You must wait for an institution administrator to approve your request. If you wish to cancel a request, click the Cancel request button.


	Request membership of an institution: Choose the institution from the drop-down menu that you wish to join.


	You can provide an ID if you have one for this institution, but that is optional.


	Click the Send request button, and the institution administrator is notified of your request and will dea with it.








          

      

      

    

  

    
      
          
            
  
8. Site-Administration

Der Bereich Site-Administration ist den Site-Administrator/innen mit vollen Berechtigungen vorbehalten. Institutionsadministrator/innen haben weniger Berechtigungen und werden separat dargestellt.
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8.1. Überblick


8.1.1. Navigation

As site administrator you have an additional navigation item, Site Administration. When you click on it, your navigation changes completely to give you quick acess to all the areas for the administration of Mahara.


[image: Top level navigation for site admin]
Top level navigation for a site admin once inside „Site Administration“



When you click on one of the items, a second-level navigation opens up with the sub items. You also see the sub items on the main page of the site administration.


[image: Site admin overview page]
Site admin overview page






8.1.2. Registrierung der Mahara Plattform

You can choose to register your Mahara site with mahara.org [http://mahara.org], and help us to build up a picture of the Mahara installations around the world and to get a picture by how many users Mahara is used.


[image: Register your Mahara site]
Registrierung der Mahara Plattform



Sie können sich einen Überblick darüber verschaffen, welche Daten übermittelt werden. Wöchentliche Aktualisierungen sind zu empfehlen, damit wir aktuelle Informationen haben. Alle Informationen werden anonym übermittelt. Wir sind nur daran interessiert wie viele Nutzer auf Ihrem System sind, welche Mahara-Version verwandt wird, wie oft Blöcke oder Artefakte genutzt werden.




8.1.3. Site-Informationen

Die Site-Informationen geben Ihnen einen schnellen Überblick darüber:


	Wie die Site genutzt wird.


	Wann die Site installiert wurde.


	Wie groß die Datenbank ist.


	How much sitea data has been accumulated.


	Welche Version von Mahara genutzt wird.


	Ob der Cron-Job läuft oder nicht.





[image: Site information]
Site-Informationen



Wenn mit Ihrer Mahara-Installation Probleme auftreten und Sie eine Anfrage an die Community im Forum [http://mahara.org/group/view.php?id=1] stellen, sind die Informationen zur Mahara-Version und zum Cron-Job oft sehr nützlich. Die Versionsinformation gibt Ihnen zudem Auskunft, ob Sie die aktuellsten Sicherheitsupdates für Mahara installiert haben.


Bemerkung

Der Cron-Job ist für verschiedene Mahara-Funktionen sehr wichtig. Informationen zum Aufsetzen des Cron-Jobs finden Sie hier: <https://wiki.mahara.org/index.php/System_Administrator%27s_Guide/Cron_Job>`_.






8.1.4. Sitestatistiken

Einige Statistiken über die Nutzung von Mahara sind für Sie sehr nützlich.


8.1.4.1. Komplette Siteinformationen

Die kompletten Siteinformationen geben Ihnen Auskunft über:


	Installationsdatum der Site


	Number of registerered users („Users“), i.e. everybody who has an account


	Anzahl aktiver Nutzer/innen: Nutzer/innen, die sich kürzlich eingeloggt und aktiv etwas getan haben.


	Anzahl der Gruppen und durchschnittliche Zahl der Gruppenmitgliedschaften pro Nutzer/in


	Anzahl der Ansichten und durchschnittliche Zahl der Ansichten pro Nutzer/in


	Datenbankgröße


	Festplattenbelegung


	Mahara-Version


	Informationen zum Cron-Job





[image: Overview of the site]
Overview of the site






8.1.4.2. Benutzer

Im Benutzer-Tab der Site-Statistiken finden Sie Informationen über:


	die durchschnittlichen Benutzer



	durchschnittliche Anzahl von Kontakten und den Namen der Person mit den meisten Kontakten


	durchschnittliche Anzahl von Ansichten und Person mit den meisten Ansichten


	durchschnittliche Größe der Dateiablage und Nutzer mit dem größten Volumen









	tägliche Nutzerstatistik mit Informationen wie viele Nutzer/innen eingeloggt waren, angelegt wurden und an einem spezifischen Tag registriert waren.


	Mitgliedszahlen der Institutionen in absteigenden Reihenfolge





[image: Statistics about users]
Statistics about users






8.1.4.3. Gruppen

Im Gruppen-Tab der Statistikseite finden Sie Informationen über


	Anzahl der Gruppen nach Gruppenart



	Kursgruppen


	Standardgruppen









	Anzahl der Gruppen nach Zugriffstyp



	controlled membership group


	invite group


	open membership group


	request membership group









	Die Größe der Gruppen in absteigender Reihenfolge nach Zahl der Mitglieder einschließlich



	Anzahl der Mitglieder


	Anzahl der Ansichten


	Anzahl der Foren


	Anzahl der Forenbeiträge












[image: Statistics about groups]
Statistics about groups






8.1.4.4. Ansichten

Der Ansichten-Tab in den Sitestatistiken enthält



	die meistgenutzten Blöcke auf Portfolioansichten


	einen grafische Übersicht über Profile, Gruppen und Portfolioansichten


	die populärsten Ansichten in absteigender Reihenfolge mit Links zur Ansicht und zum Verfasser.








[image: Statistics about pages]
Statistics about pages








8.1.5. Plattform sperren

Sie können die Site für alle Nutzer/innen ausser Administrator/innen sperren. Dies ist während der Vorbereitung und Durchführung eines Datenbankupdates sinnvoll. Nur Administrator/innen haben Zugriff bis die Seite wieder freigegeben wird und das Update erfolgt ist.







          

      

      

    

  

    
      
          
            
  
8.2. System konfigurieren

In der Systemkonfiguration können Sie:


	allgemein gültige Parameter für Ihr Mahara-System setzen


	Ansichten der Site bearbeiten


	die Darstellung bestimmter Menüwerte festlegen


	Mahara mit Moodle verbinden


	Ansichten erstellen und mit anderen teilen


	Dateien hochladen





8.2.1. Website-Optionen

Unter Site-Optionen können Sie globale Einstellungen vornehmen, die systemweit gelten.


Bemerkung

One or more fields in may be disabled if overridden by a setting in your config.php file.



Wenn Sie Ihre Einstellungen auf einer Seite vorgenommen haben, klicken Sie zum Speichern auf den Aktualisieren/speichern-Button unten auf der Seite.


8.2.1.1. Siteeinstellungen


[image: Site settings]
Siteeinstellungen




	Sitename: Wählen Sie einen Namen für Ihre Mahara-Instanz. Der Name wird an verschiedenen Stellen angezeigt, wie z.B. in der Kopfzeile des Browsers und auf E-Mails, die vom System versandt werden. Der Name sollte daher nicht allzu lang sein.


	Sprache: Legen Sie die primäre Sprache für Ihr System fest. Wenn Sie mehrere Sprachpakete installiert haben, finden Sie hier ein Auswahlmenü. Andernfalls wird als Standard-Sprache English genutzt.


	Land: Die Vorauswahl wird für jeden Nutzeraccount als voreingestellter Wert genutzt, z.B. in den Kontaktinformationen.


	Theme: Mahara comes with a number of themes that you can use. Choose one from the drop-down menu to make it the default theme for your site. If you have institutions set up, they can choose their own theme.


	Show homepage information: If enabled, information about Mahara and how it is used is displayed on the Mahara homepage for logged-out and the dashboard for logged-in users. Logged-in users can disable this. See also Quick links.


	Send weekly updates?: If checked, your site send weekly updates to mahara.org [http://mahara.org] with some statistics about your site. See also Register your Mahara site.





Bemerkung

Sie können weitere Sprachpakete installieren. Eine vollständige Liste finden Sie unter [http://langpacks.mahara.org/] und weitere Informationen zu den Sprachpaketen [https://wiki.mahara.org/index.php/Language_Packs] befinden sich im Wiki.






8.2.1.2. Nutzereinstellungen


[image: User settings]
Nutzereinstellungen




	Users can choose page themes: If this setting is enabled, users can select a theme for their portfolio page. The page is displayed with this theme to other users. Thus, an institution or site theme can be overwritten.


	Nazeige der Remote Avatarbilder anzeigen: Mit dieser Einstellungen wird als Standard-Profilbild das bei Gravatar [http://gravatar.com] hinterlegte Bild (Externes Avatarbild), angezeigt, sofern vorhanden. Gravatar ist ein Dienst, um Nutzerprofilbilder zentral in einer Plattform anzulegen, aber an verschiedenen Stellen nutzen zu können. Nutzer/innen benötigen hierfür einen Nutzeraccount bei Gravatar.


	Users can hide real names: If checked, users who have set a display name may choose to be searchable only by their display name, and will not be found in searches for their real name. In the site administration section of the site, users are always searchable by their real names. An administrator (site and institution) always sees the display name, first and last name and username.


	Search usernames: If checked, usernames can be searched on as part of „Search Users“ on the dashboard and via Find friends.


	Anonymous comments: If checked, logged-out users / users without a login can leave comments on public pages or pages they can access via secret URL.







8.2.1.3. Sucheinstellungen

Mahara verfügt über eine Suchfunktion für Nutzer/innen und Ansichten. Falls Sie eine andere Suchfunktion installieren, können Sie wählen, welche verwendet werden soll.


[image: Search settings]
Sucheinstellungen




Bemerkung

Die interne Suchfunktion wird in der Plugin-Verwaltung konfiguriert.






8.2.1.4. Gruppeneinstellungen

Mahara kann nicht nur für individuelle Portfolioarbeit genutzt werden. Es ist zusätzlich möglich, in Gruppen zu arbeiten. Einige dafür wichtige Einstellungen finden Sie in diesem Abschnitt.


[image: Group settings]
Gruppeneinstellungen




	Who can create groups: You decide whether administrators, administrators and staff or everyone can create groups. The default setting is the most permissive „everyone“ because Mahara is user-centered and gives the individual users a great deal of control over what they want to do. If you choose to limit the group creation to administrators (and staff), these need to be contacted to set up groups. There is no internal group request system.


	Who can create public groups: Choose whether everyone or only administrators can create public groups. These are groups for which you do not need to be a member of the group or even have a login to Mahara to view the group homepage, member listing and discussion forums.


	Allow group categories: If checked, administrators can create categories for users to assign to their groups. These categories can be used to filter groups in My groups and Find groups.







8.2.1.5. Einstellungen für Institutionen

Mahara kann mehrere getrennte Institutionen (Mandanten) verwalten. Dies ermöglicht es Nutzer/innen und Berechtigungen, aber auch Themes, getrennt zu verwalten.


[image: Institution settings]
Einstellungen für Institutionen




	Mehrfache Mitgliedschaft: Mit dieser Option können Nutzer/innen in mehrere Institutionen als Mitglied eingetragen werden.


	Vorteil: Nutzer/innen, die zwei oder mehr Institutionen zugeordnet werden, benötigen dafür nur einen Nutzeraccount.


	Nachteil: Wenn eine oder mehrere Institutionen individuell angepasste Themes verwenden, können Nutzer/innen nicht mehr auswählen, welche sie verwenden wollen.






	Hinweis zum Ablauf einer Institution: Institutionen können zeitlich begrenzt werden. Diese Einstellung stellt sicher, dass bevor die Institution abläuft eine Information an System- und Institutionsadministrator/innen zur Erinnerung versandt wird. Festgelegt wird wie lange vor diesem Termin die Benachrichtigung versandt wird.  Die Ablaufzeit für eine Institution kann in Tagen, Wochen, Monaten oder Jahren definiert werden. Ist ‚Kein Enddatum‘ gewählt bleibt die Institution zeitlich unbegrenzt bestehen.


	Automatische Sperrung abgelaufener Institutionen: Die Einstellung stellt sicher, dass Nutzer/innen von Institutionen, die abgelaufen sind, sich nicht mehr einloggen können, bis die Institutionen wieder aktiviert wird. Dieser Sperrrvorgang wird automatisch ausgelöst und erfordert keinen Eingriff.







8.2.1.6. Accounteinstellungen
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Accounteinstellungen




	Zeitüberschreitung: Aus Sicherheitsgründen werden Nutzer/innen nach einer festgelegten Zeit der Inaktivität automatisch ausgeloggt. Dieses Feld legt den Standardwert in Minuten fest. Die Grundeinstellung ist 1440 Minuten (24 Stunden).


	Standard-Accountgültigkeitsdauer:  Mit dieser Einstellung können Sie festlegen, dass Nutzeraccounts automatisch nach der angegebenen Zeitdauer auslaufen und inaktiv gesetzt werden. Die Nutzer/innen können sich nach diesem Zeitraum nicht mehr einloggen. Die Dauer kann in Tagen, Wochen, Monaten oder Jahren eingegeben werden. Ist ‚Kein Enddatum‘ definiert, ist der Zugriff zeitlich nicht beschränkt.


	Standard Nutzer/innen Inaktivitätszeit:  Mit dieser Einstellung können Sie festlegen, dass die Accounts von Nutzer/innen, die sich für den definierten Zeitraum nicht eingeloggt haben, automatisch ‚inaktiv‘ gesetzt werden und sich nicht einloggen können. Die Dauer kann in Tagen, Wochen, Monaten oder Jahren eingegeben werden. Ist ‚Kein Enddatum‘ definiert, ist der Zugriff zeitlich nicht beschränkt.


	Warnhinweis bei Inaktivität oder Ablauf des Accounts: Nutzer/innen erhalten über diese Funktion vor der Sperre ihres Accounts eine Benachrichtigung. Dies erlaubt Ihnen, sich erneut einzuloggen und/oder Daten zu sichern.  Die Dauer kann in Tagen, Wochen, Monaten oder Jahren eingegeben werden. Ist ‚Kein Enddatum‘ definiert, ist der Zugriff zeitlich nicht beschränkt und eine Benachrichtigung ist nicht erforderlich.







8.2.1.7. Sicherheitseinstellungen
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Sicherheitseinstellungen




	Virus checking: If you want all files uploaded by users to be run through a ClamAV virus scan, you should select the virus checking option. You have to have ClamAV [http://www.clamav.net/] installed on your server.


	Path to clam: The filesystem path to clamscan or clamdscan for virus checking. It is assumed that a failure of ClamAV to run will mean that a file should be treated as a virus, and a quarantine directory will be automatically set up by your Mahara installation.


	Anti-Spam: Es gibt drei Level des Spam-Schutzes für öffentlich verfügbare Eingabeformulare (z.B. Kontaktseite oder Registrierung). Einträge werden grundsätzlich nicht stillschweigend zurückgewiesen. Statt dessen wird bei Spamverdacht dem Nutzer eine Fehlermeldung mit Hinweisen angezeigt. Drei Optionen stehen zur Verfügung:


	Keine: Für das Formular werden keine Anti-Spam-Warnungen ausgegeben.


	Einfach: Es erfolgt eine einfache Prüfung, ob die E-Mailadresse richtig strukturiert ist oder sehr viele URL Adressen im Text auftauchen.


	Advanced: Performs additional checks to determine whether email addresses are real or contain URLs that are blacklisted. This requires an internet connection.






	Spamhaus URL Blacklist aktivieren: Nach der Aktivierung werden URLs bei Spamhaus DNSBL geprüft. Das Spamhaus Project [http://www.spamhaus.org] betreibt eine URL Blacklist, die kostenfrei bei geringfügigem Traffic nicht kommerziell genutzt werden kann. Der professionelle Service wird derzeit von Mahara nicht unterstützt. Lesen Sie bitte die  Spamhaus DNSBL usage terms [http://www.spamhaus.org/organization/dnsblusage.html] bevor die Option aktiviert wird.


	SURBL URL Blacklist aktivieren: Nach der Aktivierung werden URLs bei SURBL DNSBL. SURBL [http://www.surbl.org] geprüft. Dieser Service ist bei weniger als 1.000 Nutzern kostenfrei. Der professionelle Service wird derzeit von Mahara nicht unterstützt. Lesen Sie bitte die SURBL usage terms [http://www.surbl.org/usage-policy.html] bevor die Option aktiviert wird.


	Externe Ressourcen in Nutzer-HTML-Eingaben unterbinden:  Diese Option verhindert, dass Nutzer/innen in Forenbeiträgen oder an anderen Stellen durch HTML-Code-Eingaben Inhalt von externen Webseiten wie z.B. Bilder einbinden. Aus Sicherheitsüberlegungen heraus ist diese Option sinnvoll, um gefährliche Phishing Attacken zu verhindern. Mehr Informationen in der HTML Purifier Dokumentation [http://htmlpurifier.org/live/configdoc/plain.html#URI.DisableExternalResources].







8.2.1.8. Proxy-Einstellungen


[image: Proxy settings]
Proxy-Einstellungen




	Proxy address: If your site uses a proxy server to access the internet, specify the proxies in hostname:portnumber notation.


	Proxy-Authentifizierung: Wählen Sie bei Bedarf Ihr Proxy-Authentifizierungsmodell (keins oder Basis [NCSA]) ein.


	Proxy-Bestätigungen: Geben Sie hier die Zugangsdaten im Format ‚‘username:password‘‘ für die Authentifizierung des Webservers beim Proxy ein.







8.2.1.9. E-Mail-Einstellungen


[image: Email settings]
E-Mail-Einstellungen




	SMTP-Host: Wenn Sie statt des Mahara internen SMTP Servers einen anderen verwenden wollen, so tragen Sie den Host-Namen hier ein, z.B. ‚smtp.example.com‘. Es ist möglich mehrere Einträge vorzunehmen und mit Kommas zu trennen (‚smtp1.example.com,smtp2.example.com‘) . Alle weiteren Einträge müssen dann jedoch für alle Hosts gelten und können nicht ‚aufgesplittet‘ werden. Es können also nicht verschiedene Zugangsdaten und Ports für mehrere Hosts eingetragen werden. Die Funktion kann sinnvoll genutzt werden, wenn eine SMTP Host Authentifizierung nicht erforderlich ist oder verschiedene Frontends für den gleichen Server hinterlegt werden.


	SMTP-Port: Falls Ihr SMTP-Server einen anderen Port als 25 verwendet, können Sie diesen hier eintragen. Bei Verschlüsselung lauten die Standardports 465 für SSL und 587 für TLS. Portnummern müssen nur eingetragen werden, falls sie von diesen Standardwerten abweichen. Überprüfen Sie ggfs. die richtigen Einträge mit Ihrem Mail-Server-Provider.


	Beutzer: Geben Sie hier den Nutzernamen ein falls eine Authentifizierung für den SMTP-Server erforderlich ist.


	Passwort: Geben Sie hier das Passwort ein falls eine Authentifizierung für den SMTP-Server erforderlich ist.


	SMTP-Verschlüsselung: Falls Ihr SMTP-Server Verschlüsselung unterstützt, aktivieren Sie die Option.


	System mail address: This email address is the address that emails are sent from when using Mahara.







8.2.1.10. Allgemeine Einstellungen


[image: General settings]
Allgemeine Einstellungen




	Öffentliche Ansichten erlauben: Nach der Aktivierung können Nutzer/innen öffentliche Portfolio-Ansichten erstellen und nicht nur solche, die ein Login erfordern.


	Allow public profiles: If checked, users can set their profile pages to be accessible to the public rather than only to logged-in users. However, only logged-in users can use interactive features such as the wall.


	Enable portfolio search: If checked, the „Search My Portfolio“ side block is displayed in the Content and Portfolio sections of the site.


	Enable tag cloud: If checked, users see a side block in the Content and Portfolio sections of the site with a list of their most frequently used tags.


	Höchstzahl der Schlagworte: Geben Sie den Standardwert an, den Nutzer/innen individuell in den Accounteinstellungen setzen können.


	Small page headers: If checked, a small header and site navigation block are displayed when viewing or editing portfolio page instead of the standard header. This option gives more space for the portfolio content itself.


	Anzeige des Online Blocks:  nach der Aktivierung werden in einem Block die Nutzer/innen angezeigt, die in den letzten zehn Minuten online waren (siehe auch: Dashboard)


	Nutzerbestimmungen:  nach der Aktivierung müssen Nutzer/innen bei der Registrierung die „Zustimmungserklärung/Nutzungsbedingungen“ anerkennen. Bevor Sie die Funktion aktivieren, sollten Sie die Seite „Nutzungsbedingungen“ bearbeiten und inhaltlich anpassen. Dies erfolgt unter Siteansichten bearbeiten.


	Upload via Handy erlauben: Mit dieser Funktion können Nutzer/innen einen Authentifizierungs-Token in ihren Accounteinstellungen hinterlegen. Dadurch wird der Upload von ihrem mobilen Endgerät (z.B. Smartphone) möglich.









8.2.2. Bearbeitung der Site-Ansichten

Bearbeiten Sie den Inhalt einiger allgemeiner Seiten und der Inhalte, die in der Fußzeile durch Links aufgerufen werden.


	Über


	Startseite


	Startseite vor Login


	Datenschutzerklärung


	Nutzungsordnung





Bemerkung

Due to a quirk in the system, you do not see the text on the first page that is displayed in the editor - generally „Home (Dashboard)“. In order to edit it, you need to click on a different page in the dro-down menu first and then select it again to see its text.



Alle Seiten verfügen bereits über einen Standardtext, den Sie auf Ihre Bedürfnisse anpassen oder gegen einen eigenen Text austauschen können. Die Seiten sind fest verlinkt und sollten daher mit den für Sie sinnvollen Inhalten gefüllt werden. Zur Gestaltung steht Ihnen der Editor zur Verfügung.


[image: Edit site pages]
Bearbeitung der Site-Ansichten




	Choose the page you want to edit from the drop-down menu.


	Change the text in the editor window. Some text is obligatory.


	Klicken Sie auf den Änderungen speichern-Button.







8.2.3. Menüs

Sie finden hier zwei Menüs in Mahara:


	Links und Ressourcen


	Fußzeile





8.2.3.1. Links und Ressourcen

The Links and resources menu appears to all users on most pages. You can decide which links or files are available to everybody - also those without a login - and which ones only logged-in users shall see.


[image: Add external links to the menu]
Add external links to the Links and resources menu




	Wählen Sie welches Links-  und Ressourcen-Menü Sie bearbeiten wollen: den öffentlichen Bereich oder den für eingeloggte Nutzer/innen.


	Den Typ externer Link auswählen.


	Geben Sie dem Link eine Bezeichnung, die im Menü angezeigt wird.


	Geben Sie die vollständige URL einschließlich ‚http://‘ oder ‚https://‘ ein.


	Klicken Sie auf den Hinzufügen-Button.




Sie können auch auf  Dateien verlinken, die Sie im Dateibereich hinterlegt haben.


[image: Add site file to menu]
Add a site file to the Links and resources menu




	Wählen Sie welches Links-  und Ressourcen-Menü Sie bearbeiten wollen: den öffentlichen Bereich oder den für eingeloggte Nutzer/innen.


	Wählen Sie den Typ Site-Dateien.


	Geben Sie der Datei einen Namen, der im Menü angezeigt werden soll.


	Choose the file you want to display.


	Klicken Sie auf den Hinzufügen-Button.




Nachdem Sie in den Menüs Links und Dateien hinzugefügt haben, können Sie sie später erneut bearbeiten oder löschen.


Bemerkung

Wenn Sie die Links und Ressourcen in einer speziellen Reihenfolge anzeigen wollen, legen Sie diese  von Beginn an fest, da die Reihenfolge später nicht mehr geändert werden kann.




[image: Links and Resources menu]
Links and resources menu result






8.2.3.2. Fußzeilenmenü

Sie legen fest, welche Links in der Fußzeile jeder Seite angezeigt werden.


[image: Footer menu]
Fußzeilenmenü




	Select which pages shall appear in the footer on each page. You can change the text of „Terms and Conditions“, „Privacy Statement“ and „About“ in Edit site pages.


	Click the Save changes button to save your selection.









8.2.4. Netzwerk

Die Mahara-Netzwerkfunktionen ermöglichen die Verknüpfung von Mahara mit anderen Mahara- oder Moodle- [http://moodle.org] Seiten. Nach der Aktivierung können Sie die Single-Sign-On-Funktion für Nutzer/innen konfigurieren. Damit ermöglichen Sie es den Nutzern, sich auf einer anderen Seite einzuloggen und ohne erneutes Login zu Mahara zu wechseln.

Seit Moodle 2.0 können Sie Mahara und Moodle miteinander verbinden und zusätzlich Inhalte aus Moodle in Mahara speichern (Portfolio-Funktion in Moodle [http://docs.moodle.org/22/de/Portfolios]).


[image: Networking]
Networking overview



Um die Netzwerkfunktion für alle Institutionen zu nutzen, müssen Sie:


	Choose „Yes“ from the drop-down menu at Enable networking.


	Decide whether you wish to auto-register all hosts or not. If you choose „Yes“, an institution is created for any host that connects allowing these users to log in to your Mahara site. We recommend you leave the default „No“ because that gives you more control over which Moodle or Mahara instances can connect.


	Klicken Sie auf den Änderungen speichern-Button.




Je nachdem mit welcher Seite Sie eine Verbindung herstellen wollen, müssen Sie einige der Informationen dieser Seite eintragen, insbesondere WWW root und den öffentlichen Schlüssel (public key).


Siehe auch

The comprehensive guide for setting up a Mahoodle [https://wiki.mahara.org/index.php?title=System_Administrator%27s_Guide/Moodle%2F%2FMahara_Integration] can be consulted when connecting Mahara and Moodle.






8.2.5. Ansichten

Sie erstellen und kopieren systemweite Seiten wie Portfolioseiten. Dabei stehen nicht alle Blöcke zur Verfügung. Prüfen Sie Blöcke in verschiedenen Kontexten für Blöcke, die auf systemweiten Seiten angezeigt werden.


[image: Site pages]
Site pages



Wenn Sie systemweite Seiten erzeugt haben, können Sie diese mit allen Nutzer/innen teilen.




8.2.6. Teilen

Systemweite Seiten/Ansichten können wie alle anderen mit anderen Nutzer/innen geteilt werden.


Siehe auch

Refer to the share options for regular portfolio pages for further information.




[image: Share site pages]
Share site pages






8.2.7. Dateien

Sie können hier Dateien hochladen, die danach im Links- und Ressourcen-Menü oder unter systemweite Seiten/Ansichten eingebunden werden. Dateien, die Sie in öffentlichen Verzeichnissen/Ordnern ablegen, können für nicht eingeloggte Besucher zur Verfügung gestellt werden.


Siehe auch

The process of uploading and managing files is very similar to files in your personal files area.




[image: Site files]
Site files









          

      

      

    

  

    
      
          
            
  
8.3. Benutzer

Im Nutzer/innenmenü der Site-Administration können Sie:


	nach Nutzer/innen suchen


	Einstellungen für einzelne Nutzer/innen ändern


	Nutzer/innen zurückweisen und löschen


	Nutzer/innen zu Site-Mitarbeiter/innen oder Administrator/innen ernennen


	die Einstellungen zur Benachrichtigung von Administrator/innen prüfen


	add users manually or by CSV





8.3.1. Benutzersuche

Site-Administrator/innen können nach jedem Nutzer der gesamten Site suchen. Sie können aber auch gezielt suchen nach


	Vorname


	Nachname


	Anzeigename


	Benutzername


	E-Mail-Adresse





Bemerkung

The display name is not shown in the user list. That will be a feature of Mahara 1.5.




[image: User search]
Benutzersuche



Sie können jede Suche kombinieren und Filter-Optionen verwenden. Wenn Sie zu viele Kriterien verwenden, kann es sein, dass Sie kein Ergebnis erzielen.


	Filtern Sie die angezeigten Nutzer/innen durch Eingabe der Initialen, des Vor- oder Nachnamens.


	Type the name, display name, username or email address or any partial thereof you wish to search for in the search field.


	Wählen Sie die Institution aus dem Drop-down-Menü in der Sie nach Nutzer/inen suchen wollen.


	Click the Search button [image: search] to start searching.


	Anzeige der Suchergebnisse. Die Ansicht erfolgt zunächst alphabetisch nach Vornamen sortiert. Durch einen Klick im Spaltenkopfbereich können Sie eine andere Sortierung und eine auf- oder absteigende Reihenfolge der Ergebnisse festlegen.


	Klicken Sie auf den Nutzernamen des Nutzers mit dem Sie weitere Aktionen ausführen wollen.







8.3.2. Nutzeraccounteinstellungen

On the Account settings page of a user in the administration area, you can perform a number of actions to manage the user’s account. However, you cannot change personal information about this user, e.g. name, email, from this page. This can only be done in the Content area of the user’s account.


[image: User account settings]
Overview of the user account settings page




	Login als dieser Nutzer


	System-Accounteinstellungen ändern


	Institutionseinstellungen ändern


	Suspend and / or delete this user





8.3.2.1. Einloggen als

As administrator you have the power to log in as any user that you manage ans masquerade as them. If you are a site administrator, you can log in as any user while institution administrators can only perform this action for any user who is in their user management.

It is a great function for troubleshooting a user account because you see everything as the user would without having to know his password.


Warnung

This function can easily be misused by an administrator because he can make changes to the user’s portfolio and artefacts as well as participate in groups while logged in as that user. Users should be aware of this function and that an administrator can enter their account.

Sie sollten klare Festlegungen darüber treffen wann diese Funktion und in welcher Weise sie von Administrator/innen genutzt werden darf. Zudem sollte die Zahl der Administrator/innen eng begrenzt sein.




[image: Login as another user]
Login as another user




	Click on the user’s name to go to his profile page.


	Klicken Sie auf den Login als …-Button, um als dieser Nutzer zu agieren. Sie sehen einen rot markierten Hinweis oben auf der Seite, der Sie darauf hinweist, dass Sie in Names dieses Nutzers agieren.





[image: Stop masquerading as another user]
Stop masquerading as another user



When you want to return to your own account again, click the Become [your user name] again link at the top of the browser window.




8.3.2.2. System-Accounteinstellungen ändern

Sie können die Einstellungen  für einen Nutzeraccount einsehen und verschiedene Änderungen vornehmen.


Bemerkung

Je nach Authentifizierungsmethode können Sie verschiedene Einstellungen nicht anpassen, da sie in einem externen System bearbeitet werden müssen.




[image: Site account settings of a user]
Site account settings of a user




	Nutzernamen ändern: Geben Sie den Nutzer einen anderen Nutzernamen. Diese Option ist nicht verfügbar wenn der Account durch eine externe Authentifizierung verwaltet wird.


	Passwort zurücksetzen: Ändern Sie das Passwort für diesen Nutzeraccount. Diese Option ist nicht verfügbar wenn der Account durch eine externe Authentifizierung verwaltet wird.


	Force password change on next login: Check this box if the user shall change his password when he next logs in. This field is not available when the account is managed by an external authentication method.


	Site staff: Check this box if the user shall be able to create controlled groups.


	Site administrator: Check this box if the user shall have full administrative rights.


	Email: Check this box to disable the sending of emails for this user. If email is disabled notifications and messages can only be viewed in the internal inbox. Depending on your setup, if emails are bounced back to the sender, then email may be automatically disabled.


	Accountablauf: Tragen Sie das Datum ein zu dem der Nutzeraccount automatisch deaktiviert wird. Die Voreinstellung ist, dass kein Datum gesetzt wird. Der Account ist damit unbegrenzt gültig.  Das aktuelle Datum ist grau hinterlegt dargestellt. Sie können ein Datum für den automatischen Ablauf für alle Nutzer/innen unter Accounteinstellungen der Site-Konfiguration festlegen.


	File quota (MB): Change the storage allowance for a user’s personal files area. The default value as set in the files configuration in the plugin administration.


	Authentifizierungsmethode: Wählen Sie die Authentifizierungsmethode mit der der Nutzer sich in Mahara einloggt. Die Authentifizierungsmethoden werden unter Institutionsadministration festgelegt. Je nach Authentifizierungsmethode ist ein externer Nutzername einzutragen, um das Login des Nutzers zu ermöglichen.


	Klicken Sie auf den Änderungen speichern-Button, wenn alle Änderungen vorgenommen sind.





Warnung

Wenn die E-Mail-Adresse deaktiviert ist, können Nutzer/innen ihr Passwort selber nicht zurücksetzen, da keine E-Mail versandt werden kann.






8.3.2.3. Institutionseinstellungen ändern

Sie können die Einstellungen zur Mitgliedschaft in Institutionen einsehen und ändern. Abhängig von den Siteeinstellungen für Institutionen kann ein Nutzer zu mehr als einer Institution hinzugefügt werden.


[image: Institution settings for a user]
Institution settings for a user




	Choose the institution from the drop-down menu to which you want to add this user.


	Click the Add User to Institution button to make him a member of this institution.


	Ablaufen der Mitgliedschaft: wenn Sie wollen kann die Mitgliedschaft zu einem festgelegten Datum automatisch ablaufen. Wenn Sie ‚nicht festgelegt‘ wählen, endet die Mitgliedschaft nicht automatisch.


	ID-Nummer: Tragen Sie einen optionalen Identifier für den Nutzer dieser Institution ein.  Das Feld ist für Nutzer/innen nicht bearbeitbar.


	Institution staff: Check this box if you want to give this user staff rights in this institution. This will allow him to create controlled groups.


	Institution admin: Check this box if you want to make this user an administrator of this institution. This will allow him to manage all users in this institution.


	Klicken Sie auf den Aktualisieren-Button, um die Änderungen zu speichern.


	Click the Remove user from this institution button to disassociate this user from this institution. The user will stay in any other institution that he may be in, and he will also keep his account no matter whether he is in an institution or not.







8.3.2.4. Benutzer sperren

Sperren Sie Benutzer, die die Nutzungsbedingungen  nicht einhalten oder die Site in unangemessener Weise verwenden. Gesperrte Benutzer können sich nicht weiter einloggen. Der gesamte Inhalt bleibt jedoch erhalten.


[image: Suspend a user]
Suspend a user




	Tragen Sie einen Grund für die Sperre ein. Dies ist besonders hilfreich wenn Sie nicht der/die einzige Administrator/in sind und/oder sich später an den Grund der Sperre erinnern wollen.


	Click the Suspend User button to disallow the user from logging in.




When a user has been suspended, the following suspension message appears on his account settings stating the reason for the suspension and giving the administrators the possibility to unsuspend the user by clicking on the Unsuspend User button.


[image: Suspension notice]
Suspension notice on the account settings page



When the user tries to log in, he will see the suspension message and the reason. He can then contact an administrator via the „Contact Us“ form for further action.


[image: Suspended user tries to log in]
Suspended user tries to log in and gets suspension message






8.3.2.5. Nutzer/in löschen

A user can delete his own account from Mahara on his account settings if he is allowed to by his institution. Site administrators can also delete user accounts at any time.


[image: Delete a user account]
Delete a user account



Click the Delete User button to delete this user account permanently. This action cannot be undone. As this is a permanent action, you see a confirmation pop-up window that you will have to acknowledge.


Warnung

When you delete a user account, all personal data is wiped from the system. This applies to everything that is in a user’s Content and Portfolio area. This action cannot be undone. His contributions in groups, e.g. forum messages, uploaded files and pages created in a group, are still available, but are made anonymous by changing the name the „Deleted user“ as author where an author is shown.




Bemerkung

If an account was deleted by accident - either by a user or by an administrator - swift action may result in recovery of (most of) the data from a backup file. This requires access to the server’s backups and the backend of Mahara. More information is available on the wiki [https://wiki.mahara.org/index.php/System_Administrator%27s_Guide/Restoring_a_deleted_user].








8.3.3. Suspended users

A list of all suspended users is available in the sub-menu Suspended users. Here you can unsuspend or delete them.


[image: List of all suspended users]
List of all suspended users




	Wählen Sie die Nutzer/innen, die Sie gemeinsam bearbeiten wollen.


	Click the Unsuspend Users button to reinstate the accounts for all selected users.


	Click the Delete Users button to delete all selected users in bulk. This account cannot be undone and all personal information of these users will be deleted (see delete user).







8.3.4. Staff users

Auf dieser Seite können Sie festlegen, welche Nutzer/innen Site-Mitarbeiterrechte erhalten sollen. Links sind alle potenziellen Nutzer/innen im System aufgelistet, denen Sie das Recht zuweisen können, rechts die derzeitigen Nutzer/innen mit Mitarbeiterberechtigungen.


[image: Site staff users]
Give site staff rights




	From the list under Potential Staff, select the users you wish to make site staff. You can also select multiple users at once using Ctrl and Shift click.


	If you have too many users on your site and you cannot see / find the user you want, you can search for him in the Search box.


	Add the potential staff members to the right-hand side - Current Staff - by clicking on the right-arrow button [image: right-arrow].


	If you want to remove an existing or accidentally added site staff member, you can remove him from the list on the right-hand side by clicking on him.


	Then click on the left-arrow button [image: left-arrow], and he is removed from the list.


	Wenn Sie alle Mitarbeiter/innen ausgewählt haben, klicken Sie auf den Bestätigen-Button.







8.3.5. Site-Administrator/innen

Site administrators have powerful rights on Mahara. They can make far-reaching changes and also log in as other users. Be careful whom you give these rights. One site administrator is needed for each site. The total number of site administrators should be kept small.


[image: Site admins]
Give site admin rights




	From the list under Potential Admins, select the users you wish to make site administrators. You can also select multiple users at once using Ctrl and Shift click.


	If you have too many users on your site and you cannot see / find the user you want, you can search for him in the Search box.


	Klicken Sie auf den Pfeil nach rechts-Button [image: right-arrow], um die markierten Nutzer zu Administrator/innen zu machen und in die rechte Tabelle einzufügen.


	If you want to remove an existing or accidentally added site admin, you can remove him from the list on the right-hand side by clicking on him.


	Then click on the left-arrow button [image: left-arrow], and he is removed from the list.


	Nachdem Sie alle Personen zugeordnet haben, klicken Sie auf den Bestätigen-Button.







8.3.6. Benachrichtigungen für Administrator/innen

The Admin Notifications page lists all users with institution and site admin access on your site. It shows their selected notification preferences for all admin notifications. There should be at least one administrator receiving each type of message generated. Admin notifications are:


	Kontaktaufnahme


	Anstößiger Inhalt


	Wiederholter Virenupload


	Virenkennung Freigabe





[image: Admin notifications]
Overview of the admin notification types






8.3.7. Nutzer/innen hinzufügen

Sie können Nutzer/innen zu Ihrer Site hinzufügen indem Sie sie manuell anlegen


[image: Add a user]
Add a user manually




	Klicken Sie auf den Nutzeraccount neu anlegen- Radiobutton, wenn Sie ein leeres Formular für einen neuen Nutzer anlegen möchten. Tragen Sie den Vor-, den Nachnamen und die E-Mailadresse ein.


	Click the Upload Leap2A File radio button if you want to import a user from another Mahara instance or a system that supports the Leap2A standard. Such a user could have exported his portfolio from another Mahara instance.


	Give the new user a username. The username may contain letters, numbers and most common symbols. It must be from 3 to 236 characters in length. Spaces are not allowed.


	Choose a password for the account. The password must be at least six characters long and contain at least one digit and two letters.


	Check this box if the new user should have site staff rights.


	Check this box if the new user should have site administrator rights.


	Review the allocated file quota. You may change it here for this user.


	Choose the institution of which the user should be a member.


	Check this box if the new user should have institution administrator rights in the chosen institution.


	Click the Create User account button.


	The user will receive an email with his account details.





Bemerkung

You can change the settings under Basic Details on the account settings page.






8.3.8. Add users by CSV

You can use this function to upload new users in bulk via a csv file (comma-separated file). The first row of your csv file should specify the format of your data. For example, it should look like this:

username,password,email,firstname,lastname,studentid

This row must include:


	Benutzername


	Passwort


	E-Mail


	Vorname


	Nachname




Die Datei muss zudem Felder für alle Pflichtfelder, die alle Nutzer/innen ausfüllen müssen, und für eine Institution gesperrte Felder wenn Sie Nutzer in diese importieren.

All other fields are optional. This is the full list of fields that you can add in addition to your csv file upload


	studentid - Die  StudentID wird im Profil angezeigt.


	preferredname - angezeigter Name


	introduction - die Einführung (Selbstbeschreibung) wird im Profil angezeigt


	officialwebsite - Berufliche Webseite


	personalwebsite - Private Webseite


	blogaddress - URL des eigenen Blogs


	address - Strasse


	town  - Stadt


	city - City


	country - Land


	homenumber- private Telefonnummer


	businessnumber - berufliche Telefonnummer


	mobilenumber - Mobilrufnummer


	faxnumber - Faxnummer


	icqnumber - ICQ-Nickname


	msnnumber - MSN-Nickname


	aimscreenname - AIM-Screenname


	yahoochat - Yahoo-Chat-Nutzername


	skypeusername - Skype-ID


	jabberusername - Jabber-ID


	occupation - Beruf (wird im Profil angezeigt)


	industry - Branche (wird im Profil angezeigt)


	maildisabled - Festlegung, die E-Mail-Adresse zu deaktivieren


	remoteuser - externer Nutzername für externe Authentifizierung




When you have created your csv file, you are ready to upload it.


[image: Add users by csv file]
Add users by csv file




	Institution: Choose the institution and the authentication method for the user accounts that you upload. You cannot change the authentication method later on in bulk, but only for each user individually.


	CVS file: You must upload a csv file by clicking on the Browse button and then selecting it from the files on your computer.


	Force password change? If you select this option, users need to change their password before they can log in for the first time.


	Email users about their account? If you select this option, users will receive an email with their account information. This is in particular good for internal accounts. For user accounts that are managed for example by SSO with Moodle or through LDAP, you do not have to select this option because the users should already know their login information.


	Click the Add Users by CSV button to upload the users.





Bemerkung

Abhängig von Ihren Servereinstellungen und oder der Größe Ihrer Installation können Sie nicht alle Nutzer/innen auf einmal hochladen. Versuchen Sie es mit kleineren Einheiten von bis zu hundert Nutzer/innen in einer CSV-Datei.









          

      

      

    

  

    
      
          
            
  
8.4. Gruppen

Im Gruppenmenü der Site-Administration können Sie:


	Administrator/innen zu Gruppen hinzufügen


	Gruppen löschen


	Gruppenkategorien verwalten





8.4.1. Überblick

The first page you see when you click on the Groups menu is the Administer Groups page.


	Suche nach Gruppennamen oder -kategorien.


	Group name. The table is sorted alphabetically according to the group names.


	Number of group members


	Number of group administrators


	Group type


	Group category


	Visibility


	Klicken Sie auf den Verwalten-Button [image: manage] um Gruppenadministrator/innen hinzuzufügen oder zu löschen.


	Klicken Sie auf den Löschen-Button, um eine Gruppe zu löschen.







8.4.2. Add / remove group administrators

You can add to or remove administrators from a group by clicking on the Manage button [image: manage] on the Administer Groups page.


[image: Add or remove group administrators]
Add or remove group administrators




	From the list under Potential Admins, select the group members you wish to make group administrators. You can also select multiple users at once using Ctrl and Shift click.


	If you have too many users on your site and you cannot see / find the user you want, you can search for him in the Search box.


	Add the potential administrator to the right-hand side - Current Admins - by clicking on the right-arrow button [image: right-arrow].


	If you want to remove an existing or accidentally added group administrator, you can remove him from the list on the right-hand side by clicking on him.


	Then click on the left-arrow button [image: left-arrow], and he is removed from the list.


	Nachdem Sie alle Nutzer/innen ausgewählt haben, die Gruppen-Administrator/innen werden sollen, klicken Sie auf den Speichern-Button.







8.4.3. Gruppenkategorien verwalten

Gruppenkategorien unterstützen Sie auf den Seiten Meine Gruppen und Gruppen suchen, Gruppen gezielt zu filtern.  Gruppen-Administrator/innen können die Gruppe einer Kategorie zuordenen wenn diese Funktion aktiviert wurde.

Site administrators can manage group categories on the Group Categories page under Groups in the Site Administration.


[image: Manage group categories]
Gruppenkategorien verwalten




	Enable group categories for the entire site by placing a checkmark into the check box and then click the Submit button.


	Die bestehenden Gruppenkategorien werden angezeigt.


	Erstellen Sie eine neue Gruppenkategorie durch Eingabe des Namens und bestätigen des Hinzufügen-Buttons.


	Sie können einen bestehenden Gruppen-Kategoriennamen ändern indem Sie den Bearbeiten-Button [image: edit] anklicken, den Namen anpassen und auf Aktualisieren klicken. Mit Abbrechen wird der Vorgang ohne Abspeichern beendet.


	Click on the Delete button [image: delete] to permanently delete a group.





Bemerkung

Group categories are not hierarchical and are available to everybody on the site. Any user who can create groups can assign a group category.









          

      

      

    

  

    
      
          
            
  
8.5. Institutionen

You can use Mahara as multi-tenanted instance. That means that several different institutions can share one Mahara installation. That allows users from these different institutions to:


	Portfolioansichten für andere freigeben


	Feedback zu Ansichten anderer geben


	in Gruppen über Institutionsgrenzen hinweg arbeiten




In the Site Administration you can set up as many institutions as you wish. Institution administrators can only administer their users but not make any changes to site settings.

You can also use the possibility to set up institutions if you wish different parts of your organisation to use different themes, have different default settings and / or authentication methods.


8.5.1. Überblick

On Site Administration -> Institutions -> Institutions you see an overview of all institutions that exist on this Mahara installation.


[image: Overview page for institutions]
Overview page for institutions




	Search for a particular institution by its name.


	Institutions are listed alphabetically


	Number of registered members in this institution


	Maximum allowed members in this institution


	Number of institution members with staff rights


	Number of institution members with institution administrator rights


	Klicken Sie auf den Bearbeiten-Button [image: edit], um Einstellungen der Institution zu ändern.


	Klicken Sie auf den Löschen-Button [image: delete], um eine Institution zu löschen. Institutionen können nur gelöscht werden wenn sie keine Mitglieder enthalten.


	Click the Add Institution button when you want to create a new institution.


	Click the Edit Members button when you want to add or remove members from an institution.


	Click the Edit Staff button when you want to add or revoke staff rights for an institution member.


	Click the Edit Admins button when you want to add or revoke institution administrator rights for an institution member.





Bemerkung

The institution „No Institution“ is the default „institution“. It cannot be deleted as it is the standard Mahara site.






8.5.2. Eine Institution hinzufügen

When you want to add an institution by clicking on the Add button on Site Administration -> Institutions -> Institutions, you need to fill in basic information. You can change all the settings except the institution name later on.


[image: Add a new institution]
Add a new institution




	Name der Institution: Dieses Feld ist unbedingt erforderlich. Es ist ein eindeutiger Identifier in der Datenbank. Es besteht aus einem Wort. Nummern und Symbole sind nicht zulässig.


	Anzeigename der Institution: Dieses Feld ist unbedingt erforderlich. Dies ist der Name, den jeder Nutzer sieht, um die Institution anzusteuern.


	Institution expiry date: Set the expiry date for this institution by selecting the year, month and day from the drop-down menus when taking the checkmark off the „Not specified“ check box. Institutions do not expire by default.


	If you specify an expiry date for this institution, two things will happen. Once the warning time for institution expiry has been reached, site and institution administrators will be emailed about this institution’s impending expiry.


	Wenn die automatische Schließung von abgelaufenen Institutionen aktiviert wurde, erfolgt zum vorgegebenen Datum automatisch die Schließung und Nutzer/innen können sich nicht mehr einloggen.


	The warning time for institution expiry and the auto-suspend expired institutions options can be found in the institution settings under Site Administration -> Configure Site -> Site options.






	Registration allowed? Check this box when you want to allow self-registration of new users. As institution administrators, you will be asked to confirm that users can join your institution. If you decline, their account will be associated with „No Institution“. When you do not allow registration, nobody can ask to join your institution or leave it without your permission.


	Default membership period: You can set how long users will remain associated with this institution per default. Choose an option from the drop-down menu and then specify the number of days, weeks, months or years. After this length of time, the users will be removed from the institution. Users will receive an email before this time reminding them that they will be removed soon. However, that does not mean that they will lose their account. They will still have that.


	Theme: Use the drop-down menu to choose the theme that you wish to use for this institution. All pages in that institution will receive that theme. When users from other institutions view portfolio pages that were created in this institution, they will see this institution’s theme on these pages. If Site Default is selected, when a site administrator changes the site default theme, the theme for the users of this institution will change, too. You can install more themes in the theme folder on the server. Check out the community-contributed themes [https://wiki.mahara.org/index.php/Themes/Contributed_themes].


	Höchstzahl der erlaubten Nutzeraccounts: Legen Sie eine Höchstzahl von Nutzeraccounts für diese Institution fest. Wenn Sie das Feld leer lassen, gibt es keine Begrenzung.


	Locked fields: Put a check mark into each check box for which users are not allowed to change the value. Disabled check boxes are for profile fields which are locked in the institution settings for „No Institution“. These profile fields are locked at the site level and cannot be unlocked for individual institutions.


	Klicken Sie auf den Einreichen-Button, um Ihre Eingaben zu speichern und die Institution anzulegen.


	Klicken Sie auf den Abbrechen-Button, um das Anlegen der Institution abzubrechen.





Bemerkung

Das Sperren der Felder Vorname, Nachname und angezeigter Name ist sinnvoll wenn die Institution verhindern möchte, dass die realen Namen ersetzt werden durch Nicknames.






8.5.3. Eine Institution bearbeiten

Once you have created your institution, you can edit its settings or also suspend the institution. You will have to choose at least one authentication method for this institution so that user accounts can be created.


Bemerkung

Only site administrators can add, edit and delete authentication methods for an institution and suspend it.



Sie können mehrere Authentifizierungsmethoden für Ihre Institution zulassen. Damit ergeben sich mehrere Zugangsmöglichkeiten für Mitglieder. Sie müssen mindestens eine aktivieren, da sonst kein Nutzer Zugriff auf die Institution erlangt.

Before you can use the IMAP, LDAP, SAML or XMLRPC authentication methods, you must install their extensions:


	internal: user accounts are created by Mahara and the passwords and logins are kept in an internal database.


	IMAP: Nutzeraccounts werden gegenüber einem IMAP server authentifiziert. Diese Option wird sehr selten genutzt.


	LDAP: user accounts are authenticated against an LDAP server.


	SAML: ein SAML 2.0 Identity Provider Service wird benötigt, der die Nutzeraccounts verwaltet.


	XMLRPC: This is the authentication method used for MNet to connect Mahara with Moodle or another Mahara.


	Keine: Jeder kann sich einloggen durch Eingabe eines beliebigen Nutzernamens und Passworts. Dies sollte nur für Testzwecke verwandt werden.





Warnung

Seien Sie mit der Keine-Funktion sehr vorsichtig. Sie ermöglicht es jedermann sich einzuloggen. Sie ist nur für Testzwecke vorgesehen.




8.5.3.1. IMAP-Authentifizierung

Nutzen Sie diese Authentifizerungsmethode, um die Login-Informationen von Ihrem IMAP-Server zu beziehen.


[image: Set up IMAP authentication]
Set up IMAP authentication




	Authentifizierungsname: Geben Sie einen beschreibenden Namen ein, um den Server zu benennen. Bevorzugt ist ein kurzer Name. Pflichtfeld.


	Host-Name oder -Adresse: Tragen Sie den Hostnamen als URL ein. Pflichtfeld.


	Port-Nummer: Tragen Sie den Port ein unter dem Ihr IMAP-Server erreicht werden kann. Standard ist 143. Pflichtfeld.


	Protocol: Selecte the IMAP protocol you are using by selecting it from the drop-down menu. This setting is required:


	IMAP


	IMAP/SSL


	IMAP/SSL (selbstsigniertes Zertifikat)


	IMAP/TLS






	URL zum Passwort ändern: Wenn Nutzer nur an einem zentralen Ort ihr Passwort ändern können, tragen Sie es hier ein.


	Klicken Sie auf den Bestätigen-Button, um Ihre Änderungen zu speichern.


	Klicken Sie auf den Abbrechen-Button, um Ihre Änderungen abzubrechen.







8.5.3.2. LDAP-Authentifizierung

Use this authentication method to authenticate again an LDAP server so that your users can log in with their usual login and password.


[image: Set up LDAP authentication]
Set up LDAP authentication




	Authentifizierungsname: Geben Sie einen beschreibenden Namen ein, um den Server zu benennen. Bevorzugt ist ein kurzer Name. Pflichtfeld.


	Host URL: geben Sie die Host URL in dieser Form ein, z.B. ldap://ldap.example.com. Trennen Sie mehrere Server durch ein  ; für eine  Ausfallsicherung. Pflichtfeld.


	Kontexte: Geben Sie Kontexte ein, in denen sich die Nutzer befinden. Mehrere Kontexte werden durch ; getrennt, z.B. ou=users,o=org;ou=other,o=org. Pflichtfeld.


	Benutzertyp: Wählen Sie aus dem Drop-down-Menü wie Nutzer im LDAP-Verzeichnis gespeichert werden. Pflichtfeld. Wählen Sie zwischen:


	Novell Edirectory


	posixAccount (rfc2307)


	posixAccount (rfc2307 bis)


	sambaSamAccount (v. 3.0.7)


	MS Active Directory


	Standard






	User atrribute: Enter the attribute used to search for users. It is often cn. This field is required.


	Durchsuchen von Subkontexten: Wählen Sie „Ja“ wenn Nutzer auch in Unterkontexten gesucht werden sollen. Einstellung ist erforderlich.


	**Eindeutiger Name*: Wenn Sie für die Nutzersuche bind-user verwenden wollen, legen Sie es hier fest. Der  Eintrag lautet häufig „cn=ldapuser,ou=public,o=org“. Leer lassen für anonymous bind.


	Passwort: Geben Sie das Passwort für den eindeutigen Namen ein.


	LDAP-Version: Wählen Sie die verwandte LDAP-Version aus dem Drop-down-Menü ein. Pflichteintrag.


	TLS-Verschlüsselung: Aktivieren Sie die Box, um diese Verschlüselung zu verwenden.


	Aktualisierung der Nutzerinfo beim Anmelden: Nach der Aktivierung werden bei jedem Login der Vornamen, Nachname und die E-Mail-Adresse der Nutzer aus dem LDAP-System heraus aktualisiert. Die Funktion kann bei einigen MS Active Directory-Systemen den Zugang der Nutzer verhindern.


	We auto-create users: Check this box to create user accounts on Mahara automatically when a user autheticates successfully but does not yet have an account.


	LDAP-Feld für Vorname: Geben Sie die Bezeichnung des LDAP-Feldes ein, das den Vornamen enthält.


	LDAP-Feld für Nachname: Geben Sie die Bezeichnung des LDAP-Feldes ein, das den Nachnamen enthält.


	LDAP-Feld für E-Mail: Geben Sie die Bezeichnung des LDAP-Feldes ein, das die E-Mail-Adresse enthält.


	Klicken Sie auf den Bestätigen-Button, um Ihre Änderungen zu speichern.


	Klicken Sie auf den Abbrechen-Button, um Ihre Änderungen abzubrechen.







8.5.3.3. SAML Authentifizierung

Wählen Sie diese Authentifizierungsmethode für Ihre Institution wenn Sie einen SAML 2.0 Identiy Provider Service  für Ihre Organisation verwenden, um sich mit einem Login bei mehreren Anwendungen einzuloggen.


[image: SAML 2.0 authentication]
SAML 2.0 authentication




	Institutions-Attribut (enthält „….“): Geben Sie das Attribut ein, welches Sie vom Identity Provider (IdP) erhalten haben, um die Institution zu bezeichnen, der sie zugeordnet sind. Dies stimmt meist mit den LDAP-Attributen (Signin Service des IdP) überein, z.B. eduPersonOrgDN. Pflichtfeld.


	Institution value to check against attribute: Enter the value that will be checked against the institution attribute value as passed from the IdP. If the institution regex checkbox is selected, this value can be a regular expression that will be used to check against the institution attribute value. This field is required.


	Teilweise Übereinstimmung mit Kurzbezeichnung der Institution: Aktivieren Sie diese Option, um den Wert in „Institutionswert zur Prüfung gegen Attribut“ wie einen Regular-Ausdruck zu verwenden.


	Nutzerattribut: Tragen Sie den Namen des Attributs für den Nutzernamen ein, den Sie vom IdP erhalten haben. Pflichtfeld.


	Match username attribute to remote username: Check this box if you want to match the user attribute value to the remote username field assigned to a given user (not the real Mahara username).


	Aktualisierung der Nutzerdetails beim Login: Bei jedem Login sollen Vorname, Nachname und E-Mail mit den korrespondierenden Werten der IdP-Werte abgeglichen und aktualisiert werden.


	We auto-create users: Check this box to create user accounts on Mahara automatically when a user autheticates successfully but does not yet have an account.


	SSO-Feld für Vorname: Tragen Sie den Namen des Attributs für den Vornamen ein, den Sie vom IdP erhalten haben.


	SSO-Feld für Nachname: Tragen Sie den Namen des Attributs für den Nachnamen ein, den Sie vom IdP erhalten haben.


	SSO-Feld für E-Mail: Tragen Sie den Namen des Attributs für die E-Mail ein, den Sie vom IdP erhalten haben.


	Klicken Sie auf den Bestätigen-Button, um Ihre Änderungen zu speichern.


	Klicken Sie auf den Abbrechen-Button, um Ihre Änderungen abzubrechen.





Warnung

This security issue only affects sites which make use of the SAML authentication plugin and have more than one SAML identity provider.

By default, SAML authentication instances have the „Match username attribute to Remote username“ setting unchecked. This means that a user logging in using single sign-on will log in as the local Mahara user whose Mahara username matches their SAML username attribute.

In this configuration, someone with control over any SAML identity provider could gain control over any user account on that Mahara site by setting the username attribute appropriately. In other words, administrators of one institution could control users in other institutions.

To fix this, site administrators of multi-institution sites with SAML authentication in use should ensure that the „Match username attribute to Remote username“ setting is enabled in each SAML-enabled institution, unless usernames are guaranteed to be unique across all SAML providers.






8.5.3.4. MNet / XMLRPC authentication

Use the XMLRPC authentication for connection a Mahara instance to a Moodle or other Mahara installation for sharing login information. With Moodle 2 that does not only mean that you can log in to Mahara via Moodle, but also that you can transfer certain activities into your Mahara portfolio from Moodle [http://docs.moodle.org/20/en/Portfolios].

A Moodle site can only be connected to Mahara once no matter how many institutions you have set up.


Bemerkung

Sie müssen Netzwerk aktivieren, um diese Authentifizierung zu verwenden.




[image: Set up MNet authentication]
Set up MNet authentication




	Authentifizierungsname: Geben Sie einen beschreibenden Namen ein, um den Server zu benennen. Bevorzugt ist ein kurzer Name. Pflichtfeld.


	WWW root: Tragen Sie die Webadresse des Roots der anderen Anwendung ein, z.B. „http://example.com“. Pflichtfeld.


	Site name: Enter the name to present to your users to identify the remote site. If you enable SSO, they may click on this name to start a session at the remote site. This fiel is required.


	Anwendung: Wählen Sie die Anwendung an anderen Ende. Sie können zwischen Moodle und Mahara wählen.


	Port number: Enter the port number that the remote application is listening at. You probably will not need to change this unless you are connecting to a https service or your remote application is running on a non-standard port. This field is required.


	Parent authority: If you set a parent authority from the already existing authentication methods, users will be able to log in using that authority as well as MNet. For example, you could set up LDAP authentication and have that be the parent of this MNet authority. That means that users will be able to log in via Mahara’s in-built login form using their LDAP credentials as well as via MNet from their Moodle. You do not have to set a parent authority. If you do not, users using MNet will only be able to access Mahara via MNet, i.e. log in to Moodle or the other Mahara first.


	Falsches Login-Mitteilung: Geben Sie eine Mitteilung ein, die dem Nutzer angezeigt wird wenn er sich über das Mahara-Login-Formular einloggen möchte, dies aber nicht darf, da Sie keine primäre Authentifizierungsmethode hinterlegt haben.


	SSO-Richtung: Wählen Sie aus dem Drop-down-Menü die Richtung in der SSO funktionieren soll.


	Die Gegenseite loggt sich via SSO ein: Aktivieren Sie diese Option wenn Nutzer von einer anderen Anwendung aus auf Mahara zugreifen sollen, ohne sich in Mahara erneut einloggen zu müssen.


	Wir benutzen SSO nach außen: Aktivieren Sie diese Option wenn in Mahara eingeloggte Nutzer sich ohne erneutes Login bei einer anderen Seite einloggen können sollen, ohne dort erneut die Zugangsdaten verwenden zu müssen.






	Nutzerdaten bei Login aktualisieren: Aktivieren Sie diese Option, wenn beim Login von der externen Anwendung die Änderungen an den Nutzerdaten an Mahara übertragen werden sollen.


	Vorname (wird immer übertragen)


	Nachname (wird immer übertragen)


	E-Mail-Adresse (wird immer übertragen)


	Profilbild


	Beschreibung (Einführung bei Mahara)


	Stadt


	Land


	Sprache


	HTML-Editoreinstellung






	We auto-create users: Check this box to create user accounts on Mahara automatically when a user autheticates successfully but does not yet have an account.


	Wir importieren Inhalte: Nicht alle über Netzwerk verbundenen Anwendungen unterstützen dies. Moodle 2 ermöglicht hiermit Nutzern, Inhalte nach Mahara zu übertragen. Abhängig ist dies von der Option „Die Gegenseite loggt sich via SSO ein“ aus „SSO-Richtung“. Zusätzlich muss das automatische Anlegen neuer Nutzer aktiviert sein.


	Klicken Sie auf den Bestätigen-Button, um Ihre Änderungen zu speichern.


	Klicken Sie auf den Abbrechen-Button, um Ihre Änderungen abzubrechen.





Siehe auch

Refer to the comprehensive guide about setting up Mahoodle [https://wiki.mahara.org/index.php/System_Administrator%27s_Guide/Moodle//Mahara_Integration], the combination of Mahara and Moodle, for step-by-step instructions on how to set everything up on the Moodle side and on Mahara. The guide explains the steps for both Moodle 1.9 and Moodle 2.x.






8.5.3.5. Reihenfolge der Authentifizierungsmethoden

If you have set up multiple authentication methods in one institution, you can decide on the order in which are checked.


[image: Order of authentication methods]
Reihenfolge der Authentifizierungsmethoden




	Verwenden Sie die Pfeil nach oben und Pfeil nach unten Icons zum Verschieben.


	Löschen einer einzelnen Authentifizierungsmethode durch Klicken auf den Löschen-Link [x].





Bemerkung

Sie können eine Authentifizierungsmethode nur löschen wenn keine Nutzer mit dieser Methode im System sind. Verschieben Sie die Nutzer zuvor in eine andere Authentifizierungsmethode.








8.5.4. Mitglieder

Under Institutions -> Members you can add and remove members from one institution in bulk. As site administrator, you can always add members to an institution. As institution administrator, you can only invite users to become members.

Sie können die Nutzer für Ihre Institution filtern, um die angezeigte Zahl zu verringern, um sie dann hinzuzufügen oder zu löschen:


	Personen, die eine Mitgliedschaft in der Institution beantragt haben


	Personen, die eine Mitgliedschaft in der Institution nicht beantragt haben


	Personen, die bereits Mitglied der Institution sind





8.5.4.1. Personen, die eine Mitgliedschaft in der Institution beantragt haben

Wenn Ihre Institution die Selbstregistrierung zulässt, können Nutzer, die an einer Mitgliedschaft interessiert sind, diese beantragen.


Siehe auch

You can check your settings on self-registration:


	when you are an institution admin: Institution administration -> Manage institutions -> Settings -> Registration allowed?


	when you are a site admin: Site administration -> Institutions -> click the Edit button [image: edit] next to the institution you want to check -> Registration allowed?




Nutzer/innen können auf der Institutions-Mitgliedschaftsseite um Mitgliedschaft nachfragen.



Institutionsadministrator/innen erhalten eine Benachrichtigung über Mitgliedschaftsanfragen. Site-Administrator/innen erhalten Benachrichtigungen nur bei Anträgen im Bereich ‚keine Institution‘.


[image: Accept or decline institution membership request]
Deal with an institution membership request




	Nutzer anzeigen: Wählen Sie Personen, die eine Mitgliedschaft in der Institution beantragt haben.


	Institution: Wählen Sie aus dem Drop-down-Menü die Institution aus, deren Mitglieder Sie verwalten wollen. Wenn dort nur eine Institution vorhanden ist, wird sie ohne Drop-down-Menü angezeigt.


	Nutzer/innen, die eine Mitgliedschaft beantragt haben: Wählen Sie die Nutzer/innen aus, die Sie der Institution hinzufügen wollen.


	Suchen: Sie können über die Such-Funktion gezielt Nutzer/innen suchen wenn die Anzahl zu groß ist.


	Fügen Sie die Nutzer/innen durch Klick auf den Pfeil nach rechts-Button [image: right-arrow] hinzu.


	Nutzer, die hinzugefügt oder abgewiesen werden sollen: Wenn Sie versehentlich Nutzer hinzugefügt oder abgewiesen haben, können Sie sie durch Anklicken des Namens wieder von der Liste entfernen.


	Klicken Sie auf den Pfeil nach rechts-Button [image: left-arrow], um sie von der Liste zu entfernen.


	Wenn Sie alle Mitglieder bearbeitet haben, klicken Sie auf den Mitglieder hinzufügen-Button.


	Wenn Sie die Mitgliedschaft ablehnen wollen, können Sie die Nutzer auswählen und ihnen mittels des Anfrage ablehnen-Buttons eine Benachrichtigung zusenden.







8.5.4.2. Personen, die bisher keine Mitgliedschaft beantragt haben

An admin can also take the initiative and invite users into an institution.


[image: Invite users to become institution members]
Invite users to become institution members




	Nutzer anzeigen: Wählen Sie Personen, die bisher keine Mitgliedschaft beantragt haben.


	Institution: Wählen Sie aus dem Drop-down-Menü in welche Institution Sie die Mitglieder einladen möchten. Wenn nur eine Institution verfügbar ist, wird diese an Stelle des Drop-down-Menüs angezeigt.


	Keine Mitglieder: Wählen Sie die Nutzer/innen, die Sie in die Institution einladen möchten.


	Suchen: Sie können über die Such-Funktion gezielt Nutzer/innen suchen wenn die Anzahl zu groß ist.


	Fügen Sie die Nutzer/innen in die Liste Eingeladene Nutzer/innen mit dem Pfeil nach rechts-Button [image: right-arrow] ein.


	Wenn Sie eine Person versehentlich in die Liste der eingeladenen Personen eingefügt haben, können Sie sie durch Anklicken des Namens wieder entfernen.


	Klicken Sie auf den Pfeil nach rechts-Button [image: left-arrow], um sie von der Liste zu entfernen.


	When you have all the members you wish to invite to the institution, click the Invite users button.


	The users receive a notification and can accept or decline the institution membership invitation.







8.5.4.3. Personen, die bereits Mitglied der Institution sind

Sie können Nutzer/innen aus einer Institution entfernen, z.B. wenn sie nicht mehr weiter Mitglied der Schule, Hochschule oder des Unternehmens sind oder zu einer anderen Institution wechseln. Sie behalten dabei Ihren Mahara-Nutzeraccount und können sich weiter einloggen.


[image: Remove users from an institution]
Remove users from an institution




	Nutzer/innen anzeigen: Wählen Sie Personen, die bereits Mitglieder in Institutionen sind:


	Institution: Wählen Sie aus dem Drop-down-Menü aus welcher Institution Sie Mitglieder auswählen möchten. Wenn nur eine Institution existiert, wird ihr Name an Stelle des Drop-down-Menüs angezeigt.


	Derzeitige Mitglieder: Wählen Sie die Nutzer/innen, die Sie aus dieser Institution entfernen möchten.


	Suchen: Sie können über die Such-Funktion gezielt Nutzer/innen suchen wenn die Anzahl zu groß ist.


	Fügen Sie die Nutzer zur Liste Nutzer/innen zum Entfernen durch Anklicken des Pfeil nach rechts-Buttons aus.


	Wenn Sie einen Nutzer versehentlich in die Liste aufgenommen haben, können Sie ihn durch Anklicken des Namens wieder entfernen.


	Klicken Sie auf den Pfeil nach rechts-Button [image: left-arrow], um sie von der Liste zu entfernen.


	Wenn Sie alle Nutzer/innen, die Sie entfernen wollen, ausgewählt haben, klicken Sie auf den Nutzer/innen entfernen-Button.









8.5.5. Mitarbeiter/innen der Institution

You can give users staff rights in an institution in which they are members. The staff role will allow them to create course groups. This page allows you to do that in bulk for many users at once.


Siehe auch

You can also give staff rights on the user account settings page.




[image: Give users institution staff rights]
Give users institution staff rights.




	Institution: Wählen Sie die Institution aus dem Drop-down-Menü in dem Sie Mitgliedern Mitarbeiter/innen-Rechte geben wollen.


	Institution Members: Select the institution members who shall get staff rights.


	Suchen: Sie können über die Such-Funktion gezielt Nutzer/innen suchen wenn die Anzahl zu groß ist.


	Fügen Sie diese Mitglieder der Liste Mitarbeiter/innen der Institution durch Klicken des Pfeil nach rechts-Buttons |right-arrow|hinzu.


	Wenn Sie ein Mitglied versehentlich hinzugefügt haben, machen Sie dies durch Anklicken des Namens wieder rückgängig.


	Klicken Sie auf den Pfeil nach rechts-Button [image: left-arrow], um sie von der Liste zu entfernen.


	Wenn Sie alle Mitglieder hinzugefügt haben, klicken Sie auf den Bestätigen-Button.







8.5.6. Administrator/innen der Institution

Sie können Nutzer/innen in einer Institution in der sie Mitglied sind Administrationsrechte geben. Die Administrationsrolle erlaubt Ihnen, Nutzer/innen innerhalb der eigenen Organisation zu verwalten. Auf dieser Seite können Sie dies für eine größere Anzahl von Nutzern auf einmal machen.


Siehe auch

You can also give admin rights on the user account settings page.




[image: Give users institution admin rights]
Give users institution admin rights.




	Institution: Wählen Sie die Institution aus dem Drop-down-Menü in der Sie Administrationsberechtigungen vergeben wollen.


	Institution Members: Select the institution members who shall get admin rights.


	Suchen: Sie können über die Such-Funktion gezielt Nutzer/innen suchen wenn die Anzahl zu groß ist.


	Add the users to the list Current Admins by clicking on the right-arrow button [image: right-arrow].


	Wenn Sie einen Nutzer versehentlich hinzugefügt haben oder einem Nutzer die Administrationsrechte aberkennen wollen, wählen Sie ihn durch Anklicken aus.


	Klicken Sie auf den Pfeil nach rechts-Button [image: left-arrow], um sie von der Liste zu entfernen.


	Wenn Sie alle Mitglieder ausgewählt haben, klicken Sie auf den Bestätigen-Button.







8.5.7. Institutionsansichten

Sie können Ansichten für Ihre gesamte Institution erstellen. Mit Ihrem Account können Sie Ansichten erstellen, die andere Nutzer/innen als Vorlage kopieren können.  Sie können auch festlegen, dass neue Nutzer/innen automatisch eine Kopie solcher Vorlage-Ansichten erhalten.


[image: Create institution pages]
Create institution pages




	When you are in Site administration -> Institutions -> Pages, click on the institution in the drop-down menu for which you want to create or edit institution pages.


	If you have a lot of institution pages, you can search for a particular one by searching for it. You can search in the title, description and tags or only in tags.


	Click on the Create Page button to start a new institution page.


	Click on the Copy Page button to start a new page from a copy of an already existing one. This does not have to be an institution page but can be any page that you are allowed to copy.


	Institutionsansicht anzeigen, die Sie bereits erstellt haben.


	Click on the Edit button [image: edit] to change an existing institution page.


	click on the Delete button [image: delete] to delete an institution page.





Bemerkung

Creating and editing an institution page is very similar to creating and editing a portfolio page. Not all blocks are available when editing an instituion page in the page editor though due to the different context. Please refer to the overview of blocks for a list of all the blocks that you can use in an institution page.






8.5.8. Ansichten der Institution teilen

You can see a list of all institution pages from an institution under Site administration -> Institutions -> Share.


[image: Share institution pages]
Ansichten der Institution teilen




	Select the institution from the drop-down menu for which you want to see the institution pages.


	Ansichten: Alle Ansichten der Institution sind hier aufgelistet.


	Zugriffsliste: Zeigt die Zugriffsberechtigungen für die Ansichten.


	Click on the Edit Access button [image: edit_access] to change the permissions of who can view and copy a page.


	Klicken Sie auf den Geheime URL-Button [image: edit], um eine ‚geheime URL‘ für eine Ansicht zu erstellen.




Sharing an instution page is very similar to sharing a portfolio page. The only difference is that you can allow new institution members to receive a copy of an institution page immediately upon joining the institution.


[image: Setting for copying an institution page for new institution members]
Setting for copying an institution page for new institution members




	When you clicked on the Edit Access button [image: edit_access] on the Share page for institution pages, click on the check box Allow copying under Advanced Options.


	Nachdem Sie die Checkbox aktiviert haben, erscheint die Zeile Kopie für neue Mitglieder der Institution und Sie können dies aktivieren, damit neue Mitglieder der Institution künftig automatisch eine Kopie dieser Ansicht erhalten.







8.5.9. Dateien

The files area in an institution holds all files that are uploaded by institution administrators as institution files. The uploading process works as the one in the personal files.







          

      

      

    

  

    
      
          
            
  
8.6. Erweiterungen

Extensions in Mahara serve to provide certain functionality in the system. Extensions can be installed at any point and also hidden.


8.6.1. Plugin-Verwaltung

The Plugin administration lists all the plugins that are currently installed on your Mahara and provides a link to the plugin configuration settings where available.

Plugins ins Mahara sind bereits installiert. Wenn Sie die URL kennen, erhalten Sie Zugriff auch wenn sie in einer Liste nicht angezeigt werden. Die Funktion wird durch verbergen oder sichtbar machen zur Verfügung gestellt. Wenn ein Artefakt-Typ unsichtbar gemacht wird, werden die damit verbundenen Blöcke ebenfalls nicht mehr angezeigt.

Um ein Plugin vollständig zu löschen, müssen der Code und die Datenbanktabellen gelöscht werden.


Bemerkung

Core-Funktionen von Mahara können für Nutzer abgeschaltet werden, indem sie verborgen werden. Dies kann sinnvoll sein, wenn Mahara mit einer anderen Anwendung verbunden ist, die eine ebensolche Funktion bereits zur Verfügung stellt (z.B. Foren). Eine andere Situation kann sein, dass Ihre Anwendungsituation bestimmte Arten von Aktivitäten nicht vorsieht. Solch eine Entscheidung führt dazu, dass die Zahl der auswählbaren Artefakttypen für Teilnehmer reduziert wird.



In the following, only the plugins that have additional settings are discuessed.


8.6.1.1. Blockytp: Datei /interne Medien

Configure which file types users can embed into the Embedded Media block. If you disable a file type that has already been used in a block, it will not be rendered any more.

Mahara comes with Flowplayer [http://flowplayer.org/], a media player that can play flv, mp4 (in H.264 format) and mp3 files. Videos are embedded and audio files played with the help of this player.

Andere Videodateitypen können ebenfalls verwendet werden. Dann ist es jedoch erforderlich, dass die Nutzer der Seite entsprechende Software auf dem eigenen Rechner installiert haben oder in ihrem Browser Plugins verfügbar haben.


[image: Configure the Embedded Media block]
Configure the Embedded Media block




	Wählen Sie die Dateitypen, die Nutzer in ihren Portfolio-Ansichten anzeigen können.


	Klicken Sie Speichern, um Ihre Änderungen zu speichern.





Bemerkung

Wenn Sie das Einbetten von Dateitypen zulassen, die der Flowplayer nicht darstellen kann, kann es sein, dass einige Nutzer diese nicht nutzen können wenn ihnen die dazu erforderliche Software auf dem Rechner fehlt.






8.6.1.2. Blocktyp: Pinnwand

Sie können an dieser Stelle die Länge von Beiträgen auf der Pinnwand festlegen. Der Wert wird als Länge in eingegebenen Zeichen angegeben. Bei einer nachträglichen Änderung hat dies auf bestehende Einträge keinen Einfluß.


[image: Configure wall settings]
Configure wall settings




	Legen Sie die Höchstzahl von Zeichen für Pinnwandeinträge fest.


	Klicken Sie Speichern, um Ihre Änderungen zu speichern.







8.6.1.3. Artefakttyp: Kommentare

Aktivieren Sie die Bewertungsoption für Kommentare in den Feedbackbereichen von Artefakten und Ansichten.  Sie können eine bis fünf Sterne vergeben.


Bemerkung

Zur Bewertung ist ein Kommentar oder Dateianhang erforderlich. Eigene Einträge können von Ihnen nicht selbst bewertet werden.




[image: Enable comment ratings]
Enable comment ratings




	Klicken Sie auf die Checkbox, um die Bewertung von Kommentaren zu aktivieren.


	Klicken Sie Speichern, um Ihre Änderungen zu speichern.







8.6.1.4. Artefakttyp: Datei


	Standardkontingent: Legen Sie den Speicherplatz fest, der neuen Nutzern per Voreinstellung zur Verfügung gestellt wird. Die Einstellungen für bestehende Nutzer werden dadurch nicht geändert.


	Maximales Kontingent: Definieren Sie den Höchstwert, den ein Administrator einem Nutzer zuweisen kann. Bestehende Nutzeraccounts werden durch Änderungen nicht beeinflusst.


	Upload agreement: Enable this option if you would like to force users to agree to certain terms before they can upload a file to the site. They must accept this agreement before tey are able to choose a file from their computer to upload to Mahara. A default agreement is provided, but you can also write your own and use that instead.


	Profile picture size: Choose the maximum size of the profile pictures for users. All images uploaded to the profile pictures area will be resized to these dimensions.


	Default comment permissions: The selected artefact types have comments enabled per default. Users can override these settings for individual artefacts in the files area. You can enable comments for:


	Datei


	Ordner


	Bild


	Profilbild


	Archive; z.B.: komprimierte Dateien (zip)






	Klicken Sie auf ‚Speichern‘, um die Änderungen zu sichern.







8.6.1.5. Artefakttyp: Profil

For profile information you can decide which fields a user must provide when a user account is created manually or via csv file. These fields are marked mandatory.

The profile fields marked public are available for all logged-in users to search upon within another user’s public profile area.


[image: Choose mandatory and public profile fields]
Choose mandatory and public profile fields




	Select the fields that you wish to make mandatory and / or public.


	Klicken Sie Speichern, um Ihre Änderungen zu speichern.







8.6.1.6. Authentifizierung: SAML

Wenn die SAML-Authentifizierung systemweit genutzt werden soll, tragen Sie den Pfad zur SAML php-Datei hier ein.


[image: Prepare your site for SAML authentication]
Prepare your site for SAML authentication




	SimpleSAMLphp Lib-Verzeichnis: Tragen Sie den vollständigen Pfad zum Lib-Directory für SimpleSAMLphp ein, z.B. wenn der Pfad zu bootstrap autoload.php /some_path_to/simplesamlphp_1_3/lib/_autoload.php lautet, sollte der Wert  /some_path_to/simplesamlphp_1_3/ verwendet werden.


	SimpleSAMLphp config-Verzeichnis: Tragen Sie den vollständigen Pfad zum Konfigurations-Verzeichnis für den Service Provider (SP) für SimpleSAMLphp, z.B. wenn der Pfad zur config.php /some_path_to/simplesamlphp_1_3/config/config.php lautet, sollte der Wert  /some_path_to/simplesamlphp_1_3/config/ verwendet werden.


	Klicken Sie Speichern, um Ihre Änderungen zu speichern.







8.6.1.7. Interaktion: Forum

The post delay setting determines the time (in minutes) that users have for editing their forum posts before they are mailed out. Once a forum post has been mailed and further edits are made, the date, time and editor are kept track of in the post.


[image: Set the edit time before the forum post is finalised]
Set the edit time before the forum post is finalised




	Legen Sie fest wie lange Nutzer Verändern
gen vornehmen können. Wenn später Änderungen vorgenommen werden, wird dies gekennzeichnet.


	Klicken Sie Speichern, um Ihre Änderungen zu speichern.









8.6.2. HTML-Filter

Mahara uses HTML Purifier [http://htmlpurifier.org/] to filter out malicious code that could threaten the security of the system. If you have code, e.g. iFrames or javascript that you wish to use and that otherwise gets filtered out, you will have to write a filter to circumvent that. Filters should always be specific to their purpose and not give ‚carte blanche‘ to ensure security as much as possible.

Mahara already comes with a number of installed filters. Others can uploaded and then be installed. If you have downloaded a new set of HTML filters, you can install them by unzipping the file into the folder /htdocs/lib/htmlpurifiercustom and then click the Install button.







          

      

      

    

  

    
      
          
            
  
8.7. Experimentelle Funktionen

As site administrator you have two experimental features available to you:


	Export mehrerer Leap2A-Dateien


	Import mehrerer Leap2A-Dateien




You cannot access these features from any navigation, but must type in the URL directly.


Warnung

Der Export oder Import von Portfolios erfordert viele Server-Ressourcen. Der gleichzeitige Prozess bei mehreren Portfolios erfordert entsprechend mehr Ressourcen. Testen Sie diese Funktionen zuerst in einer Testumgebung oder mit einer kleinen Nutzeranzahl und nicht direkt mit allen Nutzer/innen der Installation.




8.7.1. Export mehrerer Leap2A-Dateien

[Ihre normale Mahara URL]/admin/users/bulkexport.php

Wenn Sie Portfolios mehrerer Nutzer/innen auf einmal exportieren wollen, können Sie es von hier aus tun. Bitte bedenken Sie, dass dies zur Zeit  eine experimentelle Funktion ist.


[image: Experimental feature: Bulk export]
Experimental feature: Bulk export




	Institutionen: Wählen Sie die Institution aus dem Drop-down-Menü aus, von der Sie alle Nutzer/innen im Leap2A-Format exportieren wollen.


	Usernames to export: Alternatively, choose this option if you only wish to export some users‘ portfolios.


	Klicken Sie auf den Nutzer exportieren-Button zum Start des Export-Prozesses. Dieser Prozess kann längere Zeit beanspruchen.





Bemerkung

You can look up the usernames on the user search page.






8.7.2. Import mehrerer Leap2A-Dateien

[Ihre reguläre Mahara URL]/admin/users/bulkimport.php

Sie können die Portfolios mehrerer Nutzer/innen auf einmal über die Importseite importieren. Dies ist derzeit ein experimentelles Feature. Für den Import von Portfolios sind  Leap2A-Dateien erforderlich.  Ein Import von Portfolios aus HTML-Dateien ist nicht möglich.

Die einfachste Option zum Import von Nutzerportfolios aus einem anderen System ist der Import der dort erzeugten Exportdatei.  Sollte das nicht möglich sein, können Sie selber die Zip-Datei erzeugen.


8.7.2.1. Import mehrere Portfolios unter Verwendung einer Exportdatei.


[image: Experimental feature: Bulk import]
Experimental feature: Bulk import




	Idealerweise nehmen Sie also den Export mehrerer Nutzerportfolios in einem anderen Mahara-System vor. Diese Exportdatei enthält alle erforderlichen Dateien und Zuordnungen.


	Institution: Wählen Sie die Institution aus, in der die Nutzer/innen als Mitglied eingetragen werden sollen.


	Bulk- Exportdatei: Wählen Sie die Export-ZIP-Datei mit alle Nutzer/innen, die angelegt werden sollen.  Für jeden wird ein neuer Nutzeraccount angelegt.


	Sollen Nutzer/innen zur Information eine E-Mail erhalten?: Mit dieser Funktion werden Nutzer/innen nach dem Upload per E-Mail informiert.  Dies ist notwendig wenn die Nutzernamen geändert wurden oder wenn Sie darüber informiert werden müssen, dass der Account verändert wurde.


	Klicken Sie auf den Import-Button, um den Prozess zu starten. Haben Sie dabei Geduld, denn der Import braucht längere Zeit.





Bemerkung

Die Exportdatei enthält eine Datei usernames.csv. Vor dem erneuten Import können Sie in dieser Datei die Nutzernamen ändern.






8.7.2.2. Komplett neuer Import

Sie können mehrere Nutzer/innen auch dann in eine Institution mittels Leap2A-Dateien importieren wenn Sie diese nicht gemeinsam in einem Exportvorgang erstellt haben.


	Erstellen Sie einen Ordner, z.B. mahara_import.


	Erstellen Sie eine CSV-Datei mit dem Namen usernames.csv in diesem Ordner mahara_import.


	Erstellen Sie eine Zeile für jeden Nutzer mit dem Nutzernamen und dem Namen der Zip-Datei, die die zugehörige Leap2A-Datei enthält.


	Erstellen Sie einen Unterordner users. Wählen Sie keinen anderen Namen.


	Hinterlegen Sie alle Leap2A-Dateien, die Sie für eine Institution importieren wollen  in den users-Unterordner. Prüfen Sie noch einmal, dass es für jede Zip-Datei einen Eintrag in der Datei usernames.csv gibt.


	Wenn Sie alle Nutzer eingefügt haben, erzeugen Sie eine Zip-Datei aus dem Inhalt des Ordners mahara-bulk-import.


	Rufen Sie im Browser [Ihre Mahara URL]/admin/users/bulkimport.php auf.


	Institution: Wählen Sie die Institution aus, in der die Nutzer/innen als Mitglied eingetragen werden sollen.


	Bulk- Exportdatei: Wählen Sie die Export-ZIP-Datei mit alle Nutzer/innen, die angelegt werden sollen.  Für jeden wird ein neuer Nutzeraccount angelegt.


	Sollen Nutzer/innen zur Information eine E-Mail erhalten?: Mit dieser Funktion werden Nutzer/innen nach dem Upload per E-Mail informiert.  Dies ist notwendig wenn die Nutzernamen geändert wurden oder wenn Sie darüber informiert werden müssen, dass der Account verändert wurde.


	Klicken Sie auf den Import-Button, um den Prozess zu starten. Haben Sie dabei Geduld, denn der Import braucht längere Zeit.





Bemerkung

Die CSV-Datei usernames.csv sollte so  wie die hier gezeigte aussehen und keine Header-Zeile enthalten.


"petra","mahara-export-leap-user4-1334451885.zip"

"polly","mahara-export-leap-user5-1334451888.zip"













          

      

      

    

  

    
      
          
            
  
9. Administration für Institutionen

Administrator/innen von Institutionen können Nutzer/innen und Ansichten verwalten. Sie haben jedoch keinen Zugriff auf die Siteeinstellungen. Sie können:


	ausgewählte Einstellungen für Institutionen  ändern


	nach Nutzer/innen innerhalb der Institution(en) suchen


	Nutzer/innen innerhalb der Institution(en) blocken


	add users one by one or per csv file


	invite users to their institution


	remove users from their institution


	Mitgliedern der Institution Rechte als Mitarbeiter/in oder Administrator/in geben


	Ansichten der Institution erstellen und teilen


	Dateien der Institution hochladen




Die meisten Funktionen sind sehr ähnlich dem, was Siteadministrator/innen mit Nutzer/innen und in Institutionen tun können.





          

      

      

    

  

    
      
          
            
  
10. Mahara auf mobilen Endgeräten

Sie können Mahara in einem gewissen Umfang auch mit mobilen Endgeräten wie Smartphones oder Tablet-PCs mit Browsern nutzen. Je nach Endgerät (System) können unterschiedliche Funktionen zur Verfügung stehen. Leider können derzeit nicht alle Funktionen auf allen Endgeräten genutzt werden.

Mit einen Android-Smartphone oder iPad können Sie Dateien direkt vom Endgerät nach Mahara hochladen.


10.1. MaharaDroid

The open source software MaharaDroid [http://code.google.com/p/maharadroid/] enables Android devices to share / upload content to a Mahara instance. This can basically be any content that you can share on your Android mobile phone ot tablet.

Sie haben noch keine Software zur Nutzung von Mahara für diese Funktionalität installiert. Folgen Sie der Installationsanleitung auf der MaharaDroid-Webseite für weitere Informationen zur Installation der Anwendung und verknüpfen Sie es mit Ihrem Mahara-System.




10.2. PortfolioUp

PortfolioUp [http://www.brightcookie.com/our-services/consulting-additional-services/portfolioup/] ist ein Bilduploader für Mahara, der vom iPhone genutzt werden kann. Zur  Nutzung muss auch auf Ihrem Mahara-System ein Zusatz installiert werden.







          

      

      

    

  

    
      
          
            
  
1. Offene Punkte





          

      

      

    

  

    
      
          
            
  
2. Informationen für Dokumentationsschreiber

Dies ist eine fortlaufend während der Arbeit an der Dokumentation entstandene Liste von Kristina Höppner. Sie enthält die Beschreibung einiger Konventionen und Vorgehensweisen. Sie sollen zentral abgelegt werden, damit andere darauf zugreifen können und die Liste weiter gepflegt werden kann. Maßgeblich ist die englische Version dieses Kapitels.

Die Reihenfolge der Einträge in dieser Liste ist zufällig.


	Screenshots are placed as figures and always include alt text and a figure description. The latter will receive numbering in the PDF export.


	Es werden folgende Warnhinweise verwandt:



	Notiz: für alles, was etwas mehr Aufmerksamkeit erfahren soll


	Warnung: für alle Dinge, die mit besonderer Vorsicht behandelt werden sollen


	Siehe auch: als Querverweis auf andere Dokumente, die besonders empfohlen oder benötigt werden. Verweise auf andere Dokumente können auch im fortlaufenden Text verlinkt werden.


	Todo: alles, was auf eine fortlaufende Erledigungsliste gehört.









	Buttons wie Speichern oder Kopieren und die Portfolioauswahl wie Inhalt, Portfolio usw, werden im Text hervorgehoben mit Hilfe eines einzelnen ‚Sternchen‘ (‚*‘)


	Little buttons can be included in the text.


	Screenshots of Mahara sections are not made inline, but receive the „figure“ directive. They always have an alt tag and also a brief description which will show up below the image and is numbered in LaTeX PDF.


	Screenshots should have as little instructions as possible about the steps that are to be taken in them. Preferably, only the step numbers so that they can be exchanged more easily and the text of the steps is translatable because it is text and not part of the image. That could also mean that translators can translate the steps but don’t immediately have to change the screenshot.


	Inline images that are refered to in the textsuch as [image: edit] should be included as shortcuts with the reference at the bottom of the page.


	Ein Index-Eintrag sollte für jeden Abschnitt erzeugt werden.


	Lange Abschnitte sollten auf mehrere Seiten aufgeteilt werden, um das Bearbeiten zu vereinfachen


	reStructuredText hat keine vordefinierte hierarchische Überschriftenstruktur. Sie werden in jeder Datei neu definiert. Um ein einheitliches Gestaltungsbild zu erzielen, werden folgende Vorgaben definiert:



	Überschrift 1, z.B. 1.: ===============


	Überschrift 2, z.B. 1.1.: —————


	Überschrift 3, z.B. 1.1.1.: ~~~~~~~~~~~~~~~


	Überschrift 4, z.B. 1.1.1.1.: ^^^^^^^^^^^^^^^









	Weitere Überschriftenebenen nach h4 sollten unbedingt vermieden werden, da sie nicht mehr der Übersichtlichkeit dienen.


	I create screenshots with Shutter in Ubuntu. It is easy to add the callouts which indicate the steps to take. However, any other screenshot software can be used. Preferably, the callouts look similarly. The color is #4C711D.


	The callouts in the screenshots refer to the steps that need to be taken.


	Screenshots should only show the necessary area and not the entire screen or URL address bars etc. where not necessary.
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